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Preface

This section describes the purpose and organization of this guide: Getting Started 
with the Oracle Diagnostics Pack.  Specifically, it covers the following topics:

■ Purpose of This Guide

■ Audience

■ How This Guide Is Organized

■ How to Use This Guide

■ Oracle Enterprise Manager Pack Information

■ Related Publications

■ How to Find Oracle Documentation Online

■ Documentation Accessibility

■ Oracle Support

Purpose of This Guide
This guide provides an overview of the Oracle Performance Manager, Oracle 
Capacity Planner, Oracle E-business Management tools, Oracle Trace Data Viewer, 
and Oracle TopSessions charts and their features. As the guide describes how to use 
these applications provided with the Oracle Diagnostics Pack, it also introduces you 
to key concepts and terminology.
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Audience
This guide is written for those who wish to use Oracle Performance Manager, 
Oracle Capacity Planner, Oracle TopSessions charts, Oracle E-business Tools, Oracle 
and Trace Data Viewer included in the Oracle Diagnostics Pack.

This guide assumes that you are familiar with the Oracle Enterprise Manager 
console and base applications.  If you are not, please read the Oracle Enterprise Manager 
Concepts Guide and the Oracle Enterprise Manager Administrator’s Guide.

How This Guide Is Organized
This guide is organized as follows:

Chapter 1, "Overview"

Provides an overview of the Oracle Diagnostics Pack and its features.

Chapter 2, "Post-Installation Configuration"

Provides lists of steps to consider after the installation of the Oracle Diagnostics 
Pack has taken place.

Chapter 3, "Introduction to Oracle Performance Manager"

Provides an overview of the Oracle Performance Manager application and its 
features.

Chapter 4, "Introduction to Oracle Capacity Planner"

Provides an overview of the Oracle Capacity Planner application and its features.

Chapter 5, "Oracle e-Business Management Tools"

Provides an overview of the Oracle e-Business Management Tools, a set of 
applications that enable centralized management of the complete e-Business 
infrastructure.

Chapter 6, "Using Oracle TopSessions"

Provides an overview of the Oracle TopSessions chart and its features.

Chapter 7, "Using Oracle Trace Data Viewer"

Provides and overview of the Data Viewer application and its features.

Appendix A, "Using Advanced Event Tests Effectively"
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Provides several case studies demonstrating how the Oracle Event Tests provided 
with the Oracle Diagnostics Pack can help database administrators simplify daily 
administration tasks.

How to Use This Guide
This guide should be read in its entirety to provide you with an overview of Oracle 
Performance Manager, Oracle Capacity Planner, Oracle TopSessions charts, and the 
Trace Data Viewer included in the Oracle Diagnostics Pack, so that you are familiar 
with the tasks that the applications can perform.  The online help provides more 
information about the applications in the Oracle Diagnostics Pack.

Oracle Enterprise Manager Pack Information
The Oracle Enterprise Manager product family includes six packs: Oracle Change 
Management Pack, Oracle Diagnostics Pack, Oracle Tuning Pack, Oracle Standard 
Management Pack, Oracle Management Pack for SAP R/3, and Oracle Management 
Pack for Oracle Applications. Each pack is fully integrated into the Oracle 
Enterprise Manager Console framework.

Oracle Change Management Pack

■ Includes Baseline Viewer, Change Manager, DB Alter, Create Baseline, 
Compare Database Objects, DB Propagate, DB Quick Change, Find Database 
Objects, and Plan Editor. 

■ Tracks metadata changes in databases.

■ Eliminates errors and loss of data when upgrading databases to support new 
applications.

■ Analyzes the impact and complex dependencies associated with application 
change and automatically performs database upgrades.

■ Allows you to find the database objects that match a set of search criteria that 
you specify.

■ Initiates change with easy-to-use wizards that teach systematic steps necessary 
to upgrade databases.

Oracle Diagnostics Pack

■ Includes Oracle Performance Manager, Oracle Capacity Planner, Oracle Trace 
Data Viewer, Oracle E-business Tools, and Oracle TopSessions charts.
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■ Monitors, diagnoses, and maintains the stability of databases, operating 
systems, and applications. Both historical and real-time analyses are used to 
automatically avoid problems before they occur.

■ Provides powerful capacity planning features that enable users to easily plan 
and track future system resource requirements.

Oracle Tuning Pack

■ Includes Oracle SQL Analyze, Oracle Expert, Oracle Index Tuning Wizard, 
Reorg Wizard, and the Tablespace Map.

■ Optimizes system performance by identifying and tuning major database and 
application bottlenecks such as inefficient SQL, poor data structures, and 
improper use of system resources.

■ Discovers tuning opportunities and automatically generates the analysis and 
required changes to tune the system. Inherent in the product are powerful 
teaching tools that help DBAs learn to tune the system as they work.

■ Helps increase developers and DBAs productivity.

Oracle Standard Management Pack

■ Includes Baseline Viewer, Change Manager, Create Baseline, Compare Database 
Objects, Oracle Index Tuning Wizard, Oracle Performance Manager, and Oracle 
TopSessions charts.

■ Monitors and diagnoses problems, tunes high impact indexes, and tracks and 
compares changes in your Oracle environment.

Oracle Management Pack for SAP R/3

■ Includes Oracle Performance Manager, Oracle Capacity Planner, and Oracle 
Event Tests that are specific to monitoring your SAP R/3 environment.

■ Monitors, diagnoses, and maintains the health of a SAP R/3 system. Both 
historical and real-time analysis are used to automatically avoid problems 
before they occur.

■ Provides powerful capacity planning features that enable users to easily plan 
and track future system resource requirements.

Oracle Management Pack for Oracle Applications

■ Includes Oracle Performance Manager, Oracle Capacity Planner, Concurrent 
Processing Tuning Assistant, and Oracle Applications Event Tests.
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■ Enables you to monitor all aspects of your system, including databases and 
concurrent managers.

■ Enables the monitoring, diagnosing, and capacity planning of the Oracle 
Applications environment.

Related Publications
For further details about the information provided in this manual, see the following 
manuals in the Oracle Server documentation set:

■ Oracle9i Database New Features

■ Oracle9i Database Concepts

■ Oracle9i Database Administrator’s Guide

■ Oracle9i Database Performance Guide and Reference

■ Oracle9i Database Performance Methods

Oracle Enterprise Manager Documentation
Getting Started with the Oracle Diagnostics Pack is one of several Oracle Enterprise 
Manager documents.

Oracle Enterprise Manager Base Documentation

■ Oracle Enterprise Manager Readme provides important notes regarding the online 
documentation, updates to the software, and other late-breaking information.

■ Oracle Enterprise Manager Administrator’s Guide explains how to use Oracle 
Enterprise Manager, the Oracle systems management console, common 
services, and integrated platform tool.

■ Oracle Enterprise Manager Concepts Guide provides an overview of Oracle Enterprise 
Manager.

■ Oracle Enterprise Manager Configuration Guide explains how to configure Oracle 
Enterprise Manager.

■ Oracle Enterprise Manager Messages Manual describes Oracle Enterprise Manager 
error messages and methods for diagnosing the errors.

■ Oracle Intelligent Agent User’s Guide provides configuration information and 
answers to crucial troubleshooting questions pertaining to the Oracle Intelligent 
Agent.
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■ The Oracle Enterprise Manager Event Test Reference Manual describes Oracle Event 
Tests which allow you to implement automatic problem detection and 
correction on concurrent managers, databases, listeners, nodes, and SAP R/3 
systems.

Oracle Management Pack Installation Documentation

■ The Oracle 9i Installation Guide Release 9.0.1 for UNIX Systems provides important 
information for installing the Oracle Enterprise Manager console and the 
management packs. This manual also contains information such as hardware 
and software requirements, installable components, and deinstallation 
procedures. The Oracle 9i Installation Guide Release 9.0.1 for UNIX Systems is 
located on the Oracle9i Online Generic Documentation CD-ROM, Release 1 
(9.0.1) or you can get a free download from the Oracle Documentation Center at 
docs.oracle.com. 

Oracle Change Management Pack Documentation

■ Getting Started with Oracle Change Management Pack provides an overview of the 
concepts and features of Oracle Change Management Pack applications.

Oracle Diagnostics Pack Documentation

■ The Getting Started with the Oracle Diagnostics Pack provides an overview of the 
concepts and features of Oracle Performance Manager, Oracle Capacity 
Planner, Oracle Data Viewer, and the Oracle TopSessions charts.

■ You can access online information about the Database Cartridge classes, charts, 
and data items by viewing an HTML version of this information. The start page 
for this help system can be found on your system in 
Oracle_Home/doc/em/dbcart_webhelp/dba.htm. 
You can access the start page by choosing 
Start->Programs->Oracle-oem22->Diagnostics Pack->Database Charts - Help.

Oracle Tuning Pack Documentation

■ Database Tuning with the Oracle Tuning Pack provides an overview of the concepts 
and features of each of the applications included in the Oracle Tuning Pack. The 
applications include Oracle SQL Analyze, Oracle Expert, Oracle Index Tuning 
Wizard, Reorg Wizard, Tablespace Map, Outline Management, and the Outline 
Editor. A description of how these applications can work together to tune an 
Oracle database is also provided.

Oracle Standard Management Pack Documentation

■ The Getting Started with the Oracle Standard Management Pack manual provides an 
overview of the concepts and features of Baseline Viewer, Change Manager, 
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Create Baseline, Compare Database Objects, Oracle Data Viewer, Oracle Index 
Tuning Wizard, Oracle Performance Manager, and Oracle TopSessions charts.

Oracle Management Pack for SAP/R3 Documentation

■ Oracle Management Pack for SAP R/3 Readme provides important notes regarding 
Oracle Management Pack for SAP R/3 online documentation, updates to the 
software, and other late-breaking information.

■ Getting Started with Oracle Management Pack for SAP R/3 provides an overview of 
the concepts and features of Oracle Performance Manager and Oracle Capacity 
Planner. It also describes Oracle Event Tests that are provided with the Oracle 
Management Pack for SAP/R3.

■ The Oracle Management Pack for SAP R/3 Installation Guide provides important 
information for installing the Oracle Management Pack for SAP R/3. This 
manual also contains information such as hardware and software requirements, 
installable components, and deinstallation procedures.

Oracle Management Pack for Oracle Applications Documentation

■ Getting Started with Oracle Management Pack for Oracle Applications provides an 
overview of the concepts and features of Oracle Performance Manager, Oracle 
Capacity Planner, and Concurrent Processing Tuning Assistant. It also describes 
Oracle Applications Event Tests and Jobs that are specific to monitoring your 
Oracle Applications environment.

How to Find Oracle Documentation Online
To download free release notes or installation documentation, please visit the 
Oracle Documentation Center at:

http://docs.oracle.com/
Printed documentation is available for sale in the Oracle Store at:

http://oraclestore.oracle.com/

Documentation Accessibility
Oracle’s goal is to make our products, services, and supporting documentation 
accessible to the disabled community with good usability. To that end, our 
documentation includes features that make information available to users of 
assistive technology. This documentation is available in HTML format, and contains 
markup to facilitate access by the disabled community. Standards will continue to 
evolve over time, and Oracle is actively engaged with other market-leading 



xx

technology vendors to address technical obstacles so that our documentation can be 
accessible to all of our customers. For additional information, visit the Oracle 
Accessibility Program web site at http://www.oracle.com/accessibility/. 

Oracle Support
The Oracle MetaLink site (www.Oracle.com/MetaLink/Support) provides 
access to information that will aid you in using Oracle products such as: hot topics, 
product reference, installation assistance materials, white papers, problem/solution 
articles, and more . To use this site you must be a licensed Oracle user with an active 
support service contract.

Contact your Oracle sales representative for more information.
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1
Overview

The Oracle Diagnostics Pack extends Oracle Enterprise Manager to enable the 
monitoring, diagnosing, and capacity planning of the multitiered Oracle server 
environment. The Diagnostics Pack takes advantage of the following Enterprise 
Manager system management features:

■ Discovery and graphical representation of targets, such as databases or nodes, 
to be monitored

■ Starting tools from the console in the context of a specific target

■ Automated collection of performance and resource usage data

■ Central monitoring and administration of remote systems using intelligent 
agents

The Diagnostics Pack provides the following components:

■ Oracle Advanced Event Tests

A set of predefined event tests built on the Oracle Event Management System 
offering "lights out" performance monitoring and problem solving for 
distributed systems.

■ Oracle Performance Manager

A real-time performance monitor, providing graphical views of an array of 
performance metrics for the targets you are monitoring. Performance Manager 
provides the ability to drill down to detailed data of performance diagnostics 
data to identify problems such as lock contention and excessive file I/O.

■ Oracle Capacity Planner

A tool for collecting, storing, and analyzing historical performance data for the 
targets you are monitoring. Capacity Planner allows you to use historical 
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information to diagnose problems today and to anticipate resource needs to 
avoid problems in the future.

■ Oracle Trace Data Viewer

A comprehensive tracing mechanism for the Oracle Server. Oracle Trace 
captures SQL, transaction, and application-based workload and performance 
data.

■ Oracle TopSessions charts

A diagnostics tool that pinpoints problematic database sessions and displays 
detailed performance and resource consumption data.

This chapter provides a brief overview of each of these components and gives a 
brief example of how to best use these components to solve database performance 
problems. 

What’s New in Version 9i
As part of Oracle Diagnostics Pack release 9i, Oracle offers the following list of new 
features:

■ A single performance monitoring solution that combines automated 
agent-based monitoring with real-time graphical charts and historical trend 
analysis, providing logical step-by-step methodology for discovering and 
investigating performance problems. This is accomplished by integrating the 
Advanced Events with the Performance Manager charts and Capacity Planner ’s 
historical data.

■ Events and real-time performance charts share common performance 
thresholds that are enabled from either Performance Manager or the 
Enterprise Manager console.

■ Event notifications can be investigated by launching real-time charts, 
historical data and diagnostic advice directly from the event viewer.

■ Real-time diagnostic charts incorporate event notification through chart 
threshold state indicators.

■ Significantly expanded coverage of Agent-based database monitoring. Through 
the integration of the Agent event system with the data collection mechanism 
used by Performance Manager and Capacity Planner, the Advanced Events 
support lights out monitoring of many of the Oracle database metrics currently 
only available through real time charts or historical data analysis.
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■ An enhanced real-time diagnostics interface that builds on the new 
performance data organization and drilldowns introduced in the previous 
version of the Diagnostics Pack.

■ New organization of the Database Health overview diagnostics charts for 
easier performance assessment.

■ Integration of host operating system diagnostics data in the Database 
Health overview, providing a single monitoring point for databases and 
operating systems.

■ Chart threshold state indicators that provide immediate visual notification 
of performance status.

■ Drilldowns to diagnostics advice.

■ Automated generation and Web publication of Performance Manager charts 
and Capacity Planner analysis reports. This allows administrators to set up 
status and performance reports that are periodically updated for access from a 
web server by other database administrators and system managers. This 
supports all targets covered by Performance Manager and Capacity Planner.

■ New top activity diagnostics charts for finding and troubleshooting high impact 
sessions and SQL.

■ New filtering capabilities providing complete flexibility in searching for 
high impact activity, such as high cost SQL by object or type.

■ New top details provide graphical performance data to help diagnose a 
problem session or SQL statement

■ Browser-based implementation of some Performance Manager functionality.

■ Direct Connect Performance Manager that allows database monitoring with  the 
Agent or OMS.

Oracle Advanced Event Tests
In addition to the basic UpDown event tests provided for all targets administered in 
the Enterprise Manager console, the Diagnostics Pack provides a library of 
advanced event tests to automatically detect excessive resource use, performance 
degradation, and other problem situations.

See the Oracle Enterprise Manager Event Test Reference Manual for a complete list of 
these advanced event tests.
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The key to a smooth running system is to resolve problems before they turn into 
crises. These advanced event tests allow you to focus on the causes of a problem 
before the symptoms become serious. In addition, with the paging and E-mail 
support provided by Enterprise Manager, you can be notified of any problems with 
the system wherever you happen to be.

Oracle Performance Manager
Performance Manager displays performance data in real-time graphical views that 
can be automatically refreshed at user-defined intervals. Multiple charts and tables 
can be displayed simultaneously, affording you a multifaceted view of system 
performance. For example, an Oracle server administrator can monitor resources 
consumed by the database, the underlying operating system, and other processes 
running on the node. Some of the predefined overview charts are:

■ Free space available on selected disks

■ Memory usage on selected nodes

■ Cache utilization

■ Throughput

Users can further drill down on these charts to see greater detail, and in some cases, 
drill down to problematic sessions and terminate them. Many other subsystem 
specific charts are available, giving you a rich set of data to analyze your system 
from multiple viewpoints.

See Chapter 3, "Introduction to Oracle Performance Manager" for more information 
about Oracle Performance Manager.

Oracle Capacity Planner
The same data collection mechanism used by Performance Manager to sample 
real-time data is also used to collect historical performance and resource 
consumption data. The Diagnostics Pack uses Capacity Planner to analyze 
performance data to help you diagnose problems using historical information and 
project your future capacity needs.

In Performance Manager, historical data can be gathered for the targets you 
monitor. The collection can be customized, allowing you to select any subset of 
statistics to collect and the interval at which these statistics should be sampled. The 
data collection mechanism provides roll up capabilities, where data is automatically 
aggregated at the end of each hour, day, week, or month. This data collection 
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mechanism also allows you to set up data expiration policies so you can fully 
control the amount of storage needed for the historical data.

Once the data is gathered, you can use Capacity Planner to chart the historical data 
for the purposes of identifying trends and predicting future hardware requirements 
for the system. You can also extrapolate to a particular point in time or work back 
from a particular target value and find when a specific level of usage is expected to 
occur. These charts can be customized, allowing you to get the data you need and to 
view data from multiple sources (for example, CPU and disk) on a single, unified 
chart.

See Chapter 4, "Introduction to Oracle Capacity Planner" for more information 
about Capacity Planner.

Oracle Trace Data Viewer
Trace is a general-purpose tracing mechanism that collects data for any software 
product enabled with Trace Application Programming Interface (API) calls, such as 
the Oracle server. You can use Trace to collect a wide variety of data, such as 
performance statistics, diagnostic data, system resource usage, and business 
transaction details.

The major components of Trace are the Trace Manager and Trace Data Viewer. Trace 
Manager is an application used to create, schedule and administer Trace collections 
for products containing Trace API calls. Trace Manager automatically discovers 
Trace preconfigured products that are installed on all nodes that are known to the 
Oracle Management Server. By default Trace discovers any Oracle Server release 
7.3.3 and higher. For more information about Oracle Trace, see the Oracle9i Database 
Performance Guide and Reference

Data Viewer allows you to view formatted data collected by Trace. Data Viewer 
handles the complex task of extracting data and aggregating key server 
performance metrics on a large Trace collection. Once you select a Trace collection, 
you can have Data Viewer compute SQL or Wait statistics or both.

See Chapter 7, "Using Oracle Trace Data Viewer" for more information about using 
Data Viewer.

Oracle TopSessions Charts
TopSessions is a chart that monitors how connected sessions use database instance 
resources in real time. You can obtain an overview of session activity, by displaying 
the top "n" sessions sorted by a statistic of your choosing. For any given session, you 
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can then drill down for more detail. You can further customize the information you 
display by specifying manual or automatic data refresh, the rate of automatic 
refresh, and the number of sessions to display.

In addition to these useful monitoring capabilities, TopSessions provides a 
methodology for identifying and correcting certain database performance problems. 
For example, when sudden file I/O load is detected, you can first identify the 
sessions contributing most to the problem, and then isolate the executing SQL 
statements in user applications for those sessions. You can then analyze the SQL 
explain plans for those SQL statements to determine how best to resolve the 
problem.

For more information about using the Top Sessions chart, see Chapter 6, "Using 
Oracle TopSessions".

Typical Scenario for Using the Diagnostics Pack
Monitoring, problem diagnosis, and correction can be broken down into three 
stages:

■ Detecting a problem

■ Diagnosing the cause of the problem

■ Correcting the problem and preventing the problem from occurring again

The following sections provide an example of how you can use the Diagnostics 
Pack to solve performance problems.

System Monitoring and Problem Detection
Problems can come to your attention in a number of ways:

■ You are alerted by your users that there is a problem, for example, the system is 
very slow

■ You notice something yourself

■ You get an alarm, page, or E-mail that the system is not working correctly or 
that a potential problem may exist

Ideally an administrator would like to be alerted to a problem before his or her 
users are aware of the problem. The Advanced Event Tests included in the 
Diagnostics Pack allow you to proactively identify potential problems before they 
become serious and adversely affect users.
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Diagnosing the Cause of the Problem
You can diagnose the cause of the problem by:

■ Examining the current state of the system

■ Investigating resource usage

■ Identifying problem sessions

■ Identifying high impact SQL 

■ Analyzing past (historical) information

Examining the Current State of the System
Using Performance Manager, you can take a quick look at the system resources by 
accessing the Overview chart. This chart provides the following information:

■ Processor, user, and privileged times across all processors

■ Bytes available on each disk

■ Current processor queue length

■ Available and committed memory

■ Counts of various objects on the system

■ System I/O operations

Investigating Resource Usage
Using Performance Manager you can identify the processes using the most 
resources. The Process Info Chart found under the Nodes branch of the navigator 
tree, lists the Percent Memory Used. The Memory Statistics Chart found under the 
Databases  branch of the navigator tree, lists memory statistics, for example, Shared 
Pool Size, Buffer Cache Size, and SGA Size.

Identifying Problem Sessions
Using Oracle TopSessions you can identify the top n sessions using the most CPU, 
memory, and I/O. You can also drill down into sessions statistics, for example, V$: 
sesstat, open_cursor, locks, and sqlarea.

You can also sort data based on a selected statistics filter. For example, you can sort 
the top 10 sessions for the Redo activity by redo blocks written, redo size, and redo 
entry volume.
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Finally, you can view open cursors, explain plans, and sessions holding locks that 
other sessions are waiting for.

Identifying High Impact SQL
Using SQL Analyze, an application available in the Oracle Tuning Pack, you can 
select and sort the top n cached SQL statements based on the SQL volume metrics 
and SQL efficiency metrics. The SQL volume metrics include: number of executions, 
disk reads, and sorts. The SQL efficiency metrics include: buffer gets per executions, 
buffer gets per rows processed, and parse calls per executions.

Also using SQL Analyze, you can drag and drop SQL statements to the SQL 
Analyze workbench for tuning.

Analyzing Past Information
If a collection was set using Capacity Planner, you can determine what led up to the 
problem. For example, you can collect data to determine space usage and answer 
the following questions:

■ What led up to the space problem? Was the space consumed gradually or all at 
once?

■ Does the space problem still exist? 

■ Is the space problem getting any better?

By using the trend analysis feature of Capacity Planner, you can determine when 
the disk will be full.

Correcting the Problem
Once you have diagnosed the problem, there are various actions you can take to 
resolve the problem. Some examples include:

■ Starting fixit jobs in the Enterprise Manager console

Define an event to automatically run a fixit job when the event is triggered.

■ Identifying and correcting resource-intensive sessions

Either kill or block a session if the session is consuming too many resources.

■ Identifying problematic SQL statements

Use Performance Manager to drill down to a SQL chart and launch SQL 
Analyze to tune the problematic SQL statement.
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■ Analyzing space usage

Add a datafile in a tablespace storage folder. You can also change the 
MAXEXTENTS of a table.

■ Improving memory usage

Analyze the buffer size DB_BLOCK_BUFFER parameter. You can also change 
the initialization parameters using the Instance Manager application.

■ Tuning the database by using the Oracle Tuning Pack

■ Reorganizing tablespaces using the Oracle Tuning Pack

Microsoft SQL Server Support
The Oracle Diagnostics Pack can monitor the performance of hosts, Oracle servers, 
Microsoft SQL Server, and other targets. In Performance Manager you can view 
real-time charts displaying performance and resource use of the Microsoft SQL 
Servers. In Capacity Planner you can collect and view historical data about your 
Microsoft SQL Servers.  The Advanced Events contain an Up/Down test for 
Microsoft SQL Server.  These capabilities are included as part of the Oracle 
Diagnostics Pack; no additional licenses are required. 

This SQL Server monitoring support is provided as a plug-in to the Intelligent 
Agent on NT. Once you have installed this plug-in to the Intelligent Agent, you can 
discover SQL Servers as part of the normal Enterprise Manager discovery process. 
You will then be able to select SQL Servers from the navigator and view their 
performance. The metrics shown are contained in the NT performance registry as 
exposed by SQL Server.

To monitor SQL Server:

■ Install the Diag Pack SQL Server component on the target (it must be selected at 
install time) 

■ Be sure you have 8.0.6 or higher NT Agent/DG running on the SQL*Server 
node

■ Drop and rediscover, or refresh the node

■ SQL Server targets will show up in the Console navigator and in Capacity 
Planner and Performance Manager
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2
Post-Installation Configuration

After you have installed the Diagnostics Pack, configure the components listed in 
the following table:

Setting Up Advanced Events
Before you use Oracle Advanced Events, do the following:

■ Create additional tables, views, and public synonyms required for Advanced 
Events. 

Refer to "Obtaining Trace Data for Use in Trace Data Viewer" on page 2-6 for 
information on what scripts to run.

■ If you plan to use the Chained/Migrated Row advanced event, the CHAINED_
ROWS table must exist in the database. To create the CHAINED_ROWS table:

1. Log into the database as SYS.

2. Run the utlchain.sql script. This script is located in the $ORACLE_
HOME/RDBMS/ADMIN directory.

Components Where to Find the Information

Advanced Events "Setting Up Advanced Events" on page 2-1

Capacity Planner "Setting Up Capacity Planner and Performance Manager" on 
page 2-2

Performance Manager "Setting Up Capacity Planner and Performance Manager" on 
page 2-2
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Setting Up Capacity Planner and Performance Manager
The following setup tasks are required before you use Oracle Capacity Planner or 
Oracle Performance Manager:

■ Configure Pre-9i Databases to Use Performance Reporting In Capacity Planner

■ Configure the Oracle Intelligent Agent to collect data

■ Optionally, enable disk statistics collection on Windows NT

The following setup tasks are required before you use Performance Manager:

■ Convert any user-defined charts you created with earlier versions of 
Performance Manager

■ If you plan to use Performance Manager in a Parallel Server environment, you 
may need to set up your server using Oracle-supplied SQL scripts.

The following sections describe each of these setup tasks in more detail.

Configuring Pre-9i Databases to Use Performance Reporting in Capacity Planner
Before you can use the Performance Reporting capability in Capacity Planner on 
pre-Oracle 9i databases, you must first run a SQL script that defines the 
OEM_MONITOR role which contains all the privileges required to use the 
Diagnostics Pack products.  Granting the OEM_MONITOR role is the best way to 
ensure that a user has the correct privileges to use Capacity Planner. The 
OEM_MONITOR role has been granted more privileges in the 9i version that helps 
to provide better functionality and performance. The script also creates views and 
public synonyms used in Performance Reporting and Oracle Recommended 
collection settings. 

For 9i databases, the SQL script, catsnmp.sql, is run by default as part of the 9i 
database creation process. For all versions of the database prior to 9i, you must 
manually run a SQL script to define the OEM_MONITOR role and create the 
necessary views.

For versions 8.1.5, 8.1.6, and 8.1.7 of the database, you must run the script 
catsnmp_8i.sql. For versions 8.0.5 and 8.0.6 of the database, you must run the script 
catsnmp_80.sql. For version 7.3.4 of the database, you must run script 
catsnmp_734.sql. The selected script must be executed by a user with SYS 
privileges.

The sql files are located in the Oracle home of the Oracle Enterprise Manager 
installation, $ORACLE_HOME/SYSMAN/ADMIN. You must run the appropriate 
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version of the SQL script manually on all pre-9i databases in order to use 
Performance Reporting in Capacity Planner.

The OEM_MONITOR role must be granted to any user wishing to use the Oracle 
Diagnostics Pack. Performance Manager does not require any of these new views in 
order to run, but if you attach to a database that does not have the views, or your 
process does not have the required privileges, or the OEM_MONITOR role  does 
not exist, then an informational message displays.

Configuring Oracle Intelligent Agent to Collect Data
Performance Manager and Capacity Planner require the use of the Intelligent Agent 
data gathering service.  For monitoring operating system data, the Oracle Intelligent 
Agent must be installed on the same node as the operating system you are 
monitoring.  For monitoring other target types, such as databases, the Oracle 
Intelligent Agent can run on the same node as the target you are monitoring, or it 
can run on a different node, depending upon your configuration.

Refer to the Oracle Intelligent Agent User’s Guide for information on how to configure 
and start the Oracle Intelligent Agent.

Enabling Disk Statistics Collection on Windows NT
To collect disk statistics on Windows NT, enable them by typing: 

diskperf  -Y 

Disk statistics are enabled the next time the system is restarted. For more 
information about the DISKPERF tool, refer to the Microsoft Windows NT 
documentation.

Converting User-Defined Charts From Previous Releases of Performance Manager
If you created user-defined charts using Performance Manager release 1.5.0 or 
earlier and want to use them with the current Performance Manager release,  you 
must first convert them to release 1.6.0.

Note: Enabling disk statistics is not required.  You can still 
monitor other operating system statistics with Performance 
Manager or Capacity Planner even if disk statistics are not enabled.
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Performance Manager Release 1.6.0 user-defined charts are converted to the current 
release when you migrate your existing performance data to the Enterprise 
Manager Release 2.1 repository.

For more information, refer to the following sections.

Converting Performance Manager Release 1.5.0 User-Defined Charts 
To convert user-defined charts created using Performance Manager Release 1.5.0 or 
earlier:

1. Run vmmmig.exe. This executable creates a text file named vtmusr.txt in the 
$ORACLE_HOME\SYSMAN\ADMIN directory. This text file contains data 
about the user-defined charts created using Performance Manager release 1.5.0 
or earlier. When you run vmmmig.exe, specify the user name, password, and 
service for the Enterprise Manager repository that contains the user-defined 
charts that you want to convert, for example:

vmmmig joseph/password@my_rep

Note that my_rep in the previous command line is the service name for the 
Enterprise Manager repository.

2. Run vmm2vtm.exe. This executable uses the data in the vtmusr.txt file to create 
user-defined charts in the repository that can be used with Performance 
Manager release 1.6.0. When you run vmm2vtm.exe, supply a user name, 
password, and target for the Enterprise Manager V2.x repository and the name 
of the target under which you want the user-defined charts stored for 
Performance Manager release 1.6.0, for example:

vmm2vtm.exe joseph/password@my_rep my_db

Note that my_rep in the previous command line is the target name of the 
Enterprise Manager V2.x repository and my_db is the name of the target service 
under which you want the user-defined charts stored. In other words, after the 
previous command is run, all the user-defined charts are converted and stored 
under the my_db service in the Performance Manager release 1.6.0 tree view.

If any error messages are generated when you run vmm2vtm.exe, edit the  
vtmusr.txt file based on the error messages. For example, the error messages 
may state that there is a problem with a chart or that a chart does not exist. 

Note: Release 1.5.5 of Performance Manager did not include the 
functionality of user-defined charts.
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Since the vtmusr.txt file contains a list of the charts, edit the file to remove any 
problematic charts.

Then, run vmm2vtm.exe again.

Converting Performance Manager Release 1.6.0 User-Defined Charts
If you created user-defined charts with Performance Manager Release 1.6.0, you can 
convert those charts for use with the current release of Performance Manager.  
User-defined charts created with Performance Manager 1.6.0 are converted when 
you create a new Enterprise Manager repository and migrate your existing 
performance data to the new repository.

For more information about creating a new Oracle Enterprise Manager repository 
and migrating your existing data, see the Oracle Enterprise Manager Configuration Guide.

Using Performance Manager in a Parallel Server Environment
To use Performance Manager in a Parallel Server environment, two database 
instances must be started, otherwise Performance Manager does not treat the server 
as a Parallel Server.

There are two scenarios for using Performance Manager in an Oracle Parallel Server 
environment, and different configuration steps are required for each scenario.

The two scenarios and their configuration steps are:

1. If you are using Performance Manager to monitor an Oracle7 Parallel Server 
environment, do the following:

a. Ensure all instances are running.

b. Run the ops_gdl.sql script. This generates an appropriate ops_dbl.sql file. 
The ops_dbl.sql file shipped with the product is only an example. The 
actual contents of ops_dbl.sql depend on your database name, instance 
names, and the number of instances which exist.

c. Run the ops_mon.sql script, which runs ops_ctab.sql, ops_dbl.sql, ops_
pack.sql to create Performance Manager tables and views to fetch and 
display Oracle7 Parallel Server data in charts.

Oracle7 does not have global V$ (GV$) tables; these files install a set of 
PL/SQL procedures, database links, and O$ tables that are used by 
Performance Manager in the absence of GV$ tables.

2. If you are using Performance Manager to monitor an Oracle8 Parallel Server 
environment, you do not need to run any of the Parallel Server scripts. For 
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example, if you use any release of Oracle that has GV$ tables (namely Oracle 
release 8.0 and later), you do not need to run these scripts.

Obtaining Trace Data for Use in Trace Data Viewer
To obtain data to view, see the chapter, "Using Oracle Trace" in the Oracle9i Database 
Performance Guide and Reference for information about collecting Oracle Trace Data via 
the command line interface.
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3
Introduction to Oracle Performance

Manager

Oracle Performance Manager is an Oracle Enterprise Manager application that 
allows you to monitor the performance of the database and its related applications 
and operating systems in real time. It allows system and database administrators to 
monitor performance statistics for Oracle database servers, web servers, Oracle 
concurrent managers, operating systems, and other managed targets. Performance 
Manager also allows you to record statistics and play them back at a later time.

You can display these statistics in a number of formats including horizontal and 
vertical tables, strip charts, horizontal and vertical bar charts, and pie charts. You 
can also drill down for more detail on some predefined charts.

Since Performance Manager is integrated with Oracle Capacity Planner, you can 
also drill down to an historical view of the displayed data. The drilldown to 
historical data allows you to quickly compare the current real time value with the 
historical average to provide you with a better understanding of the meaning of the 
current value. For more information about Capacity Planner, see Chapter 4, 
"Introduction to Oracle Capacity Planner".

For most targets, Performance Manager integrates Event system thresholds with 
charts so that events and charts share common performance thresholds you can set 
from either monitoring point. This provides consistent monitoring of thresholds 
across Enterprise Manager and allows access to graphical and historical diagnostics 
information from the Event system. You can investigate event notifications by 
launching charts, historical data and diagnostic advice directly from the Event 
Viewer. Performance Manager charts incorporate event notification through chart 
threshold state indicators. Performance Manager threshold and event features are 
available for node and database data.
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You can use activity diagnostic charts such as TopSessions for finding and 
troubleshooting high impact sessions. These charts provide graphical performance 
data to help you diagnose a problem session or SQL statement.

Oracle Performance Manager uses the Intelligent Agent (Agent) to collect 
performance data. To monitor some types of data, you must install the Agent on the 
system (or systems) where you want to monitor data. See the Oracle Intelligent Agent 
User’s Guide for information on managing the Agent on a system.

If you are using Oracle Performance Manager to monitor database performance, the 
Agent can be installed on another system. See "Accessing Performance Data 
Through an Intermediate Host" on page 3-3 for more information on accessing data 
through an Agent on another system.

The types of performance data that Oracle Performance Manager can monitor on a 
system depends on the products that are installed. Table 3–1 shows the types of 
data (or targets) that Oracle Performance Manager can monitor when various 
Oracle products are installed. 

Note: In releases prior to 9i, the Agent data gathering service (also 
known as the Oracle Data Gatherer) was used to collect data for 
presentation in real-time performance monitoring utilities and 
historical data. The Intelligent Agent and the data gathering service 
were separate services that were started and stopped 
independently of each other.

With 9i, the data collection capabilities are integrated into the 9i 
Intelligent Agent. Therefore, there is no separate service that needs 
to be started. Furthermore, when you stop the 9i Intelligent Agent, 
the data gathering capabilities are disabled and not available.

Table 3–1 Data that Performance Manager Can Monitor when Various Oracle Products 
Are Installed 

Oracle 
Product

Oracle 
Concurrent 
Manager Data

Oracle 
Server 
Data

Operating 
System Data

SAP R/3 
System 
Data

Microsoft 
SQL 
Server 
Data

Diagnostics 
Pack

No Yes Yes No Yes
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If additional products from Oracle or other vendors are installed, Oracle 
Performance Manager may be able to monitor additional types of data not shown in 
Table 3–1.

Accessing Performance Data Through an Intermediate Host
Oracle Performance Manager relies on the Agent to monitor a target (such as a 
node, a database, or a concurrent manager). Usually, the collection of the data is 
done on the system where the target is located. However, for some types of targets 
Oracle Performance Manager can also monitor data on a system by using the Agent 
on another system (an intermediate host).

This intermediate host could be the client system where the Oracle Performance 
Manager is running, or any other system on the network on which the Agent is 
available.

There are three ways to set the location of the Agent.  The method you use depends 
on how you connect to the target.  Consider the following three scenarios:

■ You connect to a target that has been discovered using the Enterprise Manager 
console and you are running Oracle Performance Manager while connected to 
the Oracle Management Server.

Management 
Pack for 
Oracle 
Applications

Yes No Yes No No

Management 
Pack for SAP 
R/3

No No Yes Yes No

Standard 
Management 
Pack (Oracle 
Standard 
Edition only)

No Yes Yes No Yes

Table 3–1 Data that Performance Manager Can Monitor when Various Oracle Products 
Are Installed (Cont.)

Oracle 
Product

Oracle 
Concurrent 
Manager Data

Oracle 
Server 
Data

Operating 
System Data

SAP R/3 
System 
Data

Microsoft 
SQL 
Server 
Data
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Performance Manager attempts to connect to the Agent on the host where the 
target is located. If this connection fails or cannot be attempted because no 
preferred credentials have been set for the target, you can use the Connection 
Details dialog box to specify logon credentials for the target. This dialog box 
also contains a field to specify the location of the Agent that will be used to 
collect performance data.

■ You click the Add Service button in the toolbar panel and manually add the 
target to the navigator.

Performance Manager displays a Logon dialog box.  You can use the 
Connection Details dialog box to specify the location of the Agent that will be 
used to collect performance data.

■ You select a target in the Performance Manager navigator tree and choose Set 
Connection Details from the File menu.

Performance Manager displays the Logon dialog box for the selected target. Use 
the Connection Details dialog box to specify the location of the Agent that will 
be used to collect performance data.

Usage Scenarios for Oracle Performance Manager
Using Oracle Performance Manager, you can:

■ Monitor one or more targets concurrently.

■ View the monitored data in various chart formats, including strip (line), pie, 
bar, table, and hierarchical.

■ Set the refresh rate for a chart’s data.

■ View multiple charts concurrently for each monitored target.

■ View multiple charts in a single window.

■ Drill down from one chart to another related chart. Drill down to diagnostic 
advice.

■ Drill down from real-time chart data to historical chart data.

■ Choose the collected data and data sources to display in a chart.

■ View threshold state indicators that provide immediate visual notification of 
performance status for specific targets. 

■ Print a chart.
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■ Generate and publish an HTML report for a chart.

■ Display context-sensitive help for a chart, if help is available for the chart.

■ Play a recording of a chart, with fast-forward and pause features.

■ Create and modify user-defined charts.

Starting Oracle Performance Manager
You can start Oracle Performance Manager from the Oracle Enterprise Manager 
console, from the UNIX command line, or from the Windows Start menu. 

Starting Oracle Performance Manager from the Console
You can start Oracle Performance Manager from the Oracle Enterprise Manager 
console in any of the following ways:

■ On the Oracle Enterprise Manager console, point to the Diagnostics Pack 
drawer, then click Performance Manager.

■ On the Tools menu of the Oracle Enterprise Manager console, point to 
Diagnostics Pack, then click Performance Manager.

■ Click the right mouse button on the target for which you want to start 
Performance Manager and then choose Performance Manager from the Related 
Tools menu item on the context menu.

Starting Oracle Performance Manager from the UNIX Command Line
To start Performance Manager from the UNIX command line, set default to the 
ORACLE_HOME/bin directory, then type the following command:

./oemapp pm

Note: When you start Oracle Performance Manager from the 
Oracle Enterprise Manager console, Oracle Performance Manager 
connects to the Oracle Management Server using the same 
credentials used to start the Oracle Enterprise Manager console.
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When you start Performance Manager from the UNIX command line, you are given 
a choice of logging in to the Oracle Management Server and running Performance 
Manager in Enterprise mode or Standalone mode.

See "Running Performance Manager in Enterprise Mode" on page 3-6 and "Running 
Performance Manager in Standalone Mode" on page 3-7 for more information about 
running Performance Manager in Enterprise mode and Standalone mode.

Starting Oracle Performance Manager from the Start Menu in Windows NT
On the Start menu of Windows NT, follow the path: Start=>Programs=>ORACLE_
HOME=>Diagnostics Pack=>Performance Manager.

When you start Performance Manager from the Start menu, you are given a choice 
of logging in to the Oracle Management Server and running Performance Manager 
in Enterprise mode or Standalone mode.

Running Performance Manager in Enterprise Mode
To run Oracle Performance Manager in Enterprise mode:

1. Click Login to the Oracle Management Server.

2. Enter the appropriate connection information for your Oracle Management 
Server.

To select an alternate Management Server, click the Management Server button 
next to the Management Server drop-down list.  In the resulting dialog box, 
you can add another node that is running Oracle Management Server software. 
The Oracle Management Server and its associated repository must already 
exist.

For information on the fields in the Management Servers dialog box, click Help.

3. Click OK.

Note: ORACLE_HOME represents the home directory in which 
the Diagnostics Pack is installed.

Note: ORACLE_HOME represents the home directory in which 
the Diagnostics Pack is installed.
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When Performance Manager is running in Enterprise mode and the navigator is 
first displayed with a target type folder expanded, the targets of that type that were 
discovered in the Enterprise Manager console are displayed. When you expand a 
target, Performance Manager attempts to connect to the target. When the target is a 
database and preferred credentials for the database have been saved in the Oracle 
Enterprise repository, Performance Manager attempts to connect to the database 
using those credentials. Otherwise, the Oracle Database Logon dialog box prompts 
you for the logon information.

Running Performance Manager in Standalone Mode
To run Oracle Performance Manager in standalone mode (not connected to the 
Oracle Enterprise Manager repository), click Standalone, no repository connection, 
then click OK.

When Performance Manager is running in Standalone mode Performance Manager 
displays any targets that were added to the console in Standalone mode. You can 
add nodes or databases to the collection view for the current standalone mode 
session only. Click on the Add Service toolbar button after selecting the folder for 
the desired target type.

Using the Oracle Performance Manager Main Window
The primary component of the Oracle Performance Manager user interface is the 
main window (see Figure 3–1), which contains two panels. The navigator or tree 
panel appears on the left side of the main window and the property sheet panel 
appears on the right side. When you select an item in the navigator panel, the 
property sheet panel displays the properties of the selected item.

Note: If the repository was created using Enterprise Manager  
Release 2.1 or earlier, you must upgrade the repository or create a 
new repository.  For more information, see the Oracle Enterprise 
Manager Configuration Guide.

Note: Your recordings and user-defined charts will not be saved 
in Standalone mode. If you exit Performance Manager, you will not 
be able to play back any recordings or access these user-defined 
charts in future sessions. You will also not be able to save any chart 
settings or custom charts.
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When you first start Oracle Performance Manager, the navigator panel displays the 
target type folders and the property sheet panel displays the Performance Manager 
welcome screen.

A vertical toolbar appears on the left side of the window and a menu bar appears 
across the top of the window.  For more information about the buttons in the 
toolbar and the commands available from the Performance Manager menus, choose 
Window from the Performance Manager Help menu.

In the navigator panel, the Network folder contains a folder for each target type. 
For example, when you have the Diagnostics Pack installed, the target types are 
Nodes, Databases, Forms Servers, Concurrent Managers, SAP R/3 Systems, HTTP 
Servers, and SQL Servers.  Not all target types may be available on all systems.

In addition to the Network folders, the Recordings folder contains any recordings 
of chart data that exist. For more information about the Recordings folder, see 
"Recording Chart Data"  on page 3-23.



Using the Oracle Performance Manager Main Window

Introduction to Oracle Performance Manager 3-9

Figure 3–1 Oracle Performance Manager Main Window

Connecting to a Discovered Target in Enterprise Mode
Expand a target type folder to view the corresponding targets previously 
discovered through the Oracle Enterprise Manager console.

To connect to a discovered target, select the target in the navigator tree and click 
Connect to service in the Performance Manager toolbar, or click the plus sign (+) 
next to the target in the navigator. You can also connect to the target by double 
clicking on it in the navigator tree . You may be prompted with a Logon dialog box 
if credentials are required to connect to the target. For information on the fields in 
the Logon dialog box, click Help.

Manually Connecting to a Target
You can manually add additional targets that have not been discovered using the 
Enterprise Manager console.
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To add and connect to a target manually:

1. Select the folder for the target type you are adding.

2. Click Add Service in the Performance Manager toolbar panel.

Performance Manager displays a Logon dialog box.

3. Fill in the fields in the Logon dialog box and click OK.  

For information on the fields in the Logon dialog box, click Help.

After you connect to a target, Performance Manager displays the classes of 
performance information you can monitor for the selected target. Expand a class to 
see the individual performance data charts available for the selected class.

Viewing Performance Manager Charts
You can display a chart using one of the following methods:

■ Select the chart in the navigator, and click the Show Chart button on the 
toolbar.

■ Select the chart in the navigator, and choose Show Chart from the Chart menu.

■ Select the chart in the navigator, which displays the chart’s property sheet. To 
start the chart with the selected property sheet options, click Show Chart on the 
property sheet.

■ Select a chart class, then select the chart in the Predefined Displays list and 
click Show Chart.

■ Select the chart in the navigator and click the right mouse button.  From the 
context menu, click Show Chart.

Performance Manager displays each chart or chart group in its own window, which 
is separate from the main window. This window is called the Chart Display 
window.  For more information, see "Using the Chart Display Window"  on 
page 3-13.

Note: When you add a target manually to the navigator tree using 
the Add Service button, you are adding that target for the current 
session of Performance Manager only.  You can begin collecting 
data for the target, but if you exit and restart Performance Manager, 
you will have to add the target again.
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Monitoring Multiple Targets Concurrently
You can view charts from multiple targets concurrently by connecting to the targets 
from the navigator tree and displaying charts.

Viewing Chart Groups
Some types of data include a chart group, which is two or more charts that are 
displayed within a single Chart Display window. You display a chart group the 
same way as you view any other chart (see "Viewing Performance Manager Charts" 
on page 3-10).

You can display a special chart group that contains the Overview Charts for a 
selected target:

1. Select a target in the Performance Manager navigator.

2. Click the Show Overview Charts button in the toolbar panel.

Performance Manager displays a chart group containing some key statistics 
most likely of interest to database administrators monitoring the selected target. 

Charts in a chart group are displayed within a single window. You perform actions, 
such as setting options and displaying drilldown charts, on one chart at a time 
within a chart group. The currently selected chart within a chart group window is 
identified by a highlighted title or a black box. For example, the Memory Faults 
chart is the currently selected chart in Figure 3–2.
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Figure 3–2 Identifying the Selected Chart In a Chart Group

Besides viewing the Overview Charts for a selected target, you can also view a chart 
group provided with a data class.  For example, you can select the Memory data 
class for a Windows NT node and display the Memory at a Glance chart group. Not 
all data classes provide chart groups, however.

Selecting Collected Data and Data Sources
For some charts, the chart’s property sheet allows you to select the collected data to 
display and the data sources for which the collected data should be displayed.

The collected data are the statistics that can be monitored and displayed in the 
chart. The data sources are the items from which Oracle Performance Manager is 
able to collect the data. For example, the data source of disk statistics may be disk1 
or disk2, and the data source of file statistics may be file1 or file2.

By clicking in the column next to the name of the collected data or the name of the 
data source in the chart property sheet, you can specify whether or not to monitor 
that collected data or data source and display it in the chart. 

When a green check mark appears in the column, Oracle Performance Manager will 
display that collected data or data source in the chart. If you click in the column 
again, the check mark goes away, which indicates that Oracle Performance Manager 
will not display that collected data or data source. You can toggle back and forth 
between monitoring and not monitoring all the collected data or data sources by 
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clicking in the column head. If the check mark is gray, it means Oracle Performance 
Manager will display the collected data or data source, and you are unable to 
change the selection of this data.

If the chart definition contains default data source or collected data attributes, then 
those items are preselected in the chart’s property sheet.

Using the Chart Display Window
When you display a chart, Oracle Performance Manager opens the Chart Display 
window.  The window contains its own toolbar and menu bar. For information 
about the Chart Display window, choose Window from the Chart Display window 
Help menu.

Selecting a Chart Format
To change the format of the chart, click on the Chart Format button in the Chart 
Display window toolbar and select the format in which you want to display the 
chart from the list that displays. 

For example, suppose a chart initially displays as a bar chart.  To see the data as a 
pie chart, choose Pie Chart from the list that displays when you click on the Chart 
Format button in the toolbar.  You can also display a chart in one of the additional 
formats:

■ Bar (vertical or horizontal orientation)

■ Strip (or line chart)

■ Table (vertical or horizontal orientation)

■ Hierarchical

You can also choose a chart format from the View menu in the Chart display 
window or right mouse click on a chart and select a chart type from the context 
menu. For more information about the buttons on the Chart Display window 
toolbar, see the Oracle Performance Manager online help.

Note: Depending upon the type of chart you are displaying, one 
or more of the chart formats may not be available.
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Setting the Chart Refresh Rate
By default, most charts are set to refresh every fifteen seconds but vary based on the 
chart.  That means that Performance Manager collects the data every fifteen seconds 
and then immediately refreshes (or redisplays) the chart using the new data.

To change the refresh rate for the current chart:

1. Click the Refresh Rate button in the Chart Display window toolbar.

Performance Manager displays the Refresh Rate dialog box.

2. Use the fields on the dialog box to set a new refresh rate for the current chart.

3. Click OK to close the dialog box and display the chart using the new refresh 
rate.

You can also choose Refresh Rate from the Collection menu to change the refresh 
rate.

Pausing and Restarting a Chart
By default, Performance Manager continues to collect performance data and update 
the current chart using the current refresh rate. 

To pause a chart so it stops redisplaying based on the refresh rate, click the Pause 
Chart button in the Chart Display toolbar.

To restart the chart, click the Resume Chart button in the Chart Display toolbar.

Selecting Chart Options
After you display a chart in the Chart Display window, you can still modify the 
collected data and data sources for the chart.  For more information about selecting 
the collected data and data sources before you display a chart, see "Selecting 
Collected Data and Data Sources" on page 3-12.

To set the chart options:

1. Click the Options button in the Chart Display toolbar.

Performance Manager displays the Options dialog box.

2. Use the Options dialog box to add or remove data items from the chart.

For more information on selecting data sources and selecting collected data, 
click Help.
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You can also access the Options dialog box by choosing Options from the Collection 
menu. 

Oracle Performance Manager also allows you to select filters to limit the data 
collected for a chart. However, not all charts provide filters. For charts that allow 
you to filter the chart data, you can select a limit to the number of data sources that 
are displayed. For example, if the data sources are the processes on an operating 
system, you can modify the chart to display only 10 processes, rather than all the 
processes. 

For example, to select a limit to the number of data sources that are displayed for 
the Pagefaults Per Session chart, do the following:

1. Highlight the Pagefaults Per Session chart in the navigator tree of the 
Performance Manager main window.

You can locate the chart by traversing the tree as follows: 
Network=>Nodes=><Name of Node>=>Process=>Pagefaults Per Process.

2. Click the Options tab in the Property Sheet panel.

3. Enter 10 in the Maximum Number of Data Sources to Display field.

The 10 data sources will be sorted by Page Faults per second, as shown in the 
Sort the data by drop-down list.

4. Click Show Chart.

Performance Manager displays the chart, but includes a maximum of 10 data 
sources.

Note: The Pagefaults Per Session chart in the Process class is 
available only when you are monitoring a Windows NT node. For a 
UNIX node, select the Process Info chart in the Process Data class 
as an example of a chart you can filter.

Note: The number of options available on the Options tab will 
vary, depending upon the chart you are modifying. Some charts 
offer more or fewer options than the Pagefaults Per Process chart 
discussed here.
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You can later change this setting after the chart is displayed:

1. In the Chart Display window for the Pagefaults Per Process chart, click the 
Options button in the toolbar.

2. In the Options tab, set the Maximum Number of Data Sources to Display back 
to 7.

3. Click OK.

These options can be useful for finding the top resource users. In the case where 
processes are the data sources and the data collected is memory usage and CPU 
usage, you can ask the Agent to limit the number of data sources to 10, and to sort 
by memory usage. Your chart would then show the 10 processes using the most 
memory. If you were to sort by CPU usage, you would get the 10 processes using 
the most CPU instead.

Some charts can also give different views of the data. If that feature is available, you 
will also be able to select a view of the data. An example of a data view may be the 
current rate per second or current rate per transaction for each piece of data 
collected in the chart.

Chart-Specific Commands
Some types of charts have their own unique commands. For example, you can select 
the Kill Session command when you are viewing the Lock Manager charts for 
Oracle database targets, or Turn SQL Trace On if you are viewing a Top Sessions 
chart. 

To see if a chart-specific command is available for a chart:

■ Click the right mouse button on an item name in the chart legend or a data item 
in the chart and click Drilldown on the context menu.

■ Click the Drilldown menu on the Chart Display window menu bar.

Drilling Down from One Chart to Another
Some charts have drill-down charts associated with them. To see if any drill-down 
charts are available for the current chart, do one of the following:

■ Click the right mouse button on an item name in the chart legend or a data item 
in the chart and click Drilldown on the context menu.

■ Click the Drilldown menu on the Chart Display window menu bar.

■ Click on the Chart Status button.
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In all cases, Performance Manager displays any drill-down charts associated with 
that chart item as menu options on the Drilldown menu. If a list of drill-down chart 
names is not displayed, no drill-down charts are associated with that item.

Using the Chart Status Button
You can use the Chart Status button located in the upper right corner of a chart to 
perform one of several tasks. When you click on the button, menu items appear 
based on the context of the chart as seen in Figure 3–3.

Figure 3–3 Chart Status Button

■ View the threshold status of chart metric(s)

The Chart Status button displays the current status of thresholds for metrics in 
the chart. If an indicator flag is present, at least one of the metrics on the chart 
has thresholds defined. The most severe threshold displays on the button. A 
green flag indicates that no metrics have crossed a threshold, a yellow flag 
indicates that at least one metric has crossed a warning threshold, and a red flag 
indicates that at least one metric has crossed a critical threshold. When you 
press the Chart Status button, you can view the status of individual metrics 
within the chart. If several metrics have crossed warning or critical thresholds, 

Note: If you have trouble selecting a particular data item when 
you try to drill down for related data, pause the chart or reduce the 
refresh rate. For more information, see "Pausing and Restarting a 
Chart" on page 3-14.
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the menu items are sorted according to the severity, with the indicators for the 
most severe items on top and the less severe on the bottom.

■ Display advice on a data item

When you choose Advice from the Chart Status button, Performance Manager 
displays an information window that provides information about the currently 
selected data item along with guidelines for solving existing problems, or 
suggestions about other charts to view for further diagnosis, as seen in 
Figure 3–4.

Figure 3–4 Viewing Advice from the Chart Status Button
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■ Drill down to a chart

After you select a data item, you can choose to drill down to one of the charts 
displayed in the list or invoke tools like SQL Analyze.

■ Set or reset thresholds for a chart or an event

You can set chart-only thresholds for a data item or you can reset the chart-only 
threshold to its default value. You can choose to set or edit the threshold for the 
value in the chart only, or you can edit or register an event threshold for the 
data item. For more information, see "Registering Events in Performance 
Manager" on page 3-33.

■ Edit a threshold association

You can edit a threshold association for a metric by selecting Edit Threshold 
Association from the Chart Status button and choosing an event from the dialog 
box that appears. For more information, see "Editing Threshold Associations" 
on page 3-37.

■ Refresh thresholds

To view Event System changes made while a Performance Manager chart is 
visible, choose Refresh Thresholds from the Chart Status button menu on the 
Performance Manager chart. For more information, see "Refreshing Thresholds" 
on page 3-37.

Drilling Down to an Historical Chart
From a Performance Manager real-time chart, you can drill down to see an 
historical view of the same data collected over a longer period of time, for example, 
days, months, and years. This view of historical data, provided by the Oracle 
Capacity Planner software, allows you to analyze long-term trends in the data.

Historical data collection must be enabled to view the historical data for a chart. If 
you drill down to a historical chart for which historical data collection has not been 
enabled, Performance Manager allows you to start historical data collection. You 

Note: In addition to accessing help topics for individual metrics 
and events through the Advice function, you can view the full 
documentation set for all types of metrics and events 
independently through your web browser. For more information 
see "Viewing Metric and Event Documentation Through a Browser"  
on page 3-40.
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can also start historical data collection by starting Oracle Capacity Planner.  From 
the Capacity Planner window, you can also control other aspects of your historical 
data collection, such as how often data is collected and loaded into the historical 
database.

To drill down to historical data:

1. Display a chart in the Chart Display window.

2. Click the right mouse button on a data item in the chart.

3. From the context menu, click Drilldown.

4. From the Drilldown submenu, click Historical Data.

What happens next depends on whether or not you have begun collecting historical 
data. Consider three possible scenarios:

■ If Performance Manager finds historical data related to the chart, Performance 
Manager displays the Analysis Chart window.

Note that if you previously set up your historical database using an alternate 
database location, Performance Manager displays a database logon box before it 
displays the Analysis Chart window.

The Analysis Chart window shows you the historical information about the 
collected data. From here, you can modify the format of the chart or perform a 
trend analysis on the historical data. For more information, select an option 
from the Help menu in the Analysis Chart window or see the chapter about 
Capacity Planner in this manual.

■ If Performance Manager cannot find historical data related to the chart, the 
following message appears:

The historical chart cannot be displayed because there is no history 
available for the data sources or data items.

Would you like to begin collecting the history of these data sources and 
data items now so that you can view the chart in the future?

Click Yes to begin collecting historical data automatically or click Help to learn 
how to collect historical data using the Oracle Capacity Planner software.

Note: User-Defined charts do not support drill-down to historical 
data.
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When you click Yes, Performance Manager displays another message 
explaining that historical data is now being gathered, but is not yet available.  
Click Continue to return to the Display Chart window.

■ If no historical data has ever been saved to the historical database, Performance 
Manager displays a message box that includes the following errors:

Error connecting to the historical database.
The specified schema is not a Capacity Planner database.

Click Continue. Performance Manager displays the message described in the 
previous bullet item. 

Click Yes to begin collecting historical data or click Help for more information 
about how historical data is collected. When you click Yes, Performance 
Manager displays another message explaining that historical data is now being 
gathered, but is not yet available.  

Click Continue to return to the Display Chart window.

Displaying Alternate Chart Orientations
You can display bar charts and tables with either a horizontal or vertical orientation.

To change the orientation of the bar chart or table, click the button associated with 
the orientation that you want.

Sorting Data in a Table Chart
When a chart is displaying data in table format, the sort order of the column data 
can be changed by clicking the column headers in the table. The first click on a 
column header sorts the data in ascending order, and a second click sorts the data in 
descending order.

Changing the sort order in the chart table does not affect the data’s sort order on the 
server. To change the sort order of the data on the server, use the Options page. For 
more information, see "Selecting Chart Options" on page 3-14.

Saving Your Changes to a Chart
If you are working in repository mode and you make modifications to a chart (for 
example, if you change the format, orientation, or sorting order of a chart), you can 
save your changes in one of two ways:

■ Click Save on the Chart Display File menu.
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Performance Manager saves your changes using the same name as the original 
chart. When you display the chart again, your changes will appear in the Chart 
Display window.

To later remove your changes and display the predefined chart using its 
original settings, click Remove Chart on the Chart menu.

■ Click Save As on the Chart Display File menu.

Performance Manager displays the Save Custom Chart dialog box. Use this 
dialog box to enter a name for the custom chart and to indicate whether you 
want to create a similar chart for other targets of the same type.  For 
information about the fields on the Save Custom Chart dialog box, click Help.

Click OK in the Save Custom Chart dialog box to save the custom chart using 
the name you provided.  Performance Manager saves the chart in the Custom 
Charts folder for the selected target.

To delete a custom chart from the Custom Charts folder, select the chart and 
click Remove Chart on the Chart menu.

Obtaining Help for a Class, Chart, or Data Item
To get help on a class or chart:

1. Select the class or chart in the main window navigator.

2. From the Help menu,  choose Selected Item.

If help is available for the selected chart, Performance Manager displays a 
message box or a help topic window describing the chart data.

To get help on a data item:

1. Select a chart.

Note: You can remove the changes you saved to a predefined 
chart, but you cannot delete the original predefined chart.

Note: You can delete custom charts, but you cannot delete 
predefined charts.
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2. In the Property Sheet panel, select a data item and choose Selected Item from 
the Help menu.

Printing a Chart
To print a chart, click the Print Screen button on the Display Chart window toolbar.

The size of the chart on the screen determines the size of the chart in the chart 
printout. For example, when you print a chart that is 5 inches high and 7 inches 
wide on your screen, the chart will be 5 inches high and 7 inches wide in the 
printout.

Generating a Report for a Chart
To generate an HTML report for a chart:

1. Click the Report Chart button while the chart is displayed.

Performance Manager displays a dialog box that tells you the name of the 
HTML file used to display the report and where the file will be saved. 

2. Make a note of the file name and location.

3. Click Yes to preview the chart in your Web browser, or click No if you do not 
want to preview the report.

You can view the report later using a Web browser, or—if you have experience with 
Web publishing tools and techniques—you can share the report with your 
co-workers by publishing the HTML file and its associated graphic files on a Web 
server. 

Recording Chart Data
Oracle Performance Manager allows you to record the data being monitored in a 
chart. After a recording is complete, you can play it back. During playback, you can 
pause and fast forward the recording, if you wish.

Chart recordings are saved under the Recordings folder and on the Recordings tab 
of the right pane of the Performance Manager main window when a recorded chart 
is selected. The Recordings tab is added to a chart’s property sheet after you record 
the chart.

Note: Help is not available for all objects.
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You can manage chart recordings in the Recordings folder without connecting to 
the target from which a chart was recorded. If you are already connected to a target, 
you can see a chart’s recordings by selecting the Recordings tab in that chart’s 
Detail property sheet.

Starting a Recording
You start a recording by performing one of the following steps:

■ With a chart highlighted in the navigator tree of the Performance Manager main 
window, click Record Chart on the chart’s property sheet.

■ With a chart displayed in the Chart Display window, click Start Recording in 
the Chart Display window toolbar.

■ With a chart displayed in the Chart Display window, click 
File=>Recording=>Start Recording.

Oracle Performance Manager displays the Recording Parameters dialog box.  For 
more information on the fields in the Recording Parameters dialog box, click Help.

Stopping a Recording
To stop recording a chart, do one of the following:

■ To stop recording the current chart, click the Stop Recording button in the 
Chart Display window toolbar.

■ To stop all recordings at one time, choose Stop All Recordings from the 
Performance Manager main window Recordings menu.

■ To stop a recording from the Recordings folder, expand the Recordings folder 
in the Performance Manager main window and navigate to the chart.  Select the 
chart and click Stop Recording on the chart’s property sheet.

■ With a chart displayed in the Chart Display window, click 
File=>Recording=>Stop Recording.

Playing a Recording

Note: Before you can play a recording, you must stop the 
recording.  For more information, see "Stopping a Recording" on 
page 3-24.
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To play a recording, do the following in the Performance Manager main window:

1. Navigate to the Recordings folder.

2. Select the chart you want to play in the navigator tree.

3. In the corresponding property sheet, select the recording from the list of 
recordings for the selected chart, and click Play Recording (or on the 
Recordings menu click Play Recording).

4. In the Chart Display window toolbar, click Start Playback.

The Stop Playback, Pause Playback, and Fast Forward buttons become 
available in the playback window (Figure 3–5).  When the playback is complete, 
the Reset Playback button becomes available.

Figure 3–5 Chart Playback Buttons in the Chart Display Window

Removing a Recording
To remove a recording:

1. Navigate to the Recordings folder or the Recordings tab on the chart’s Detail 
page.

2. Select the recording you want to remove.

3. From the Recordings menu, click Remove Recording.

Creating a User-Defined Chart
In addition to predefined charts, you can define your own charts for database 
targets based on user-defined scripts. By defining your own charts, you can take a 
snapshot of data at any given interval. After successful evaluation of the script, you 
can define the operations to be performed on the data.

Note: The Performance Manager online help includes an example 
of creating a user-defined chart. Search for Example in the online 
help index.
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To define a new chart:

1. Expand the Databases folder in the navigator tree.

2. Expand the database for which you want to define a user-defined chart.

3. Select the User-Defined Charts folder.

4. Click Create User-Defined Chart in the toolbar.

The resulting New Chart property sheet includes the SQL Script Command 
page and the Data Items page.

5. On the SQL Script Command page, enter a SQL script that will be used to 
gather statistics for the chart you are defining.

6. Click Evaluate.

Performance Manager evaluates the SQL script. If the script is valid, 
Performance Manager displays the Data Items page.

7. Use the Data Items page to customize how the resulting data from the script 
entered on the SQL Script Command page will be displayed in chart form. 

You can remove columns and change the names of the columns. You can also 
define new columns with data calculated from existing columns. For more 
information, see "Modifying the Data Items for a User-Defined Chart" on 
page 3-27.

Modifying an Existing User-Defined Chart
To modify an existing chart you perform the same steps as outlined in "Creating a 
User-Defined Chart" on page 3-25. The only exception is that the chart label is 
already defined.

To modify an existing chart:

1. Expand the Databases folder in the navigator tree.

2. Expand the database for which you want to modify a user-defined chart.

3. Select the User-Defined Charts folder.

4. Click the name of the chart you want to modify.

Note: To add or modify data items to user-defined charts, you 
must use the Agent release 8.1.6. or later.
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On the SQL Script Command page, you can modify the script used to gather 
statistics for the chart. On the Data Items page, you can remove, add, or modify 
the data items associated with the chart. For more information, see "Modifying 
the Data Items for a User-Defined Chart" on page 3-27.

Modifying the Data Items for a User-Defined Chart
When you select a user-defined chart and then display the Data Items page, you can 
modify the data items for the chart as follows:

■ Select a data item and click Set Data Source.

A key icon appears next to the data item you designate as the data source.  The 
data source is the object about which Performance Manager is able to collect the 
data. You must designate one of the data items as the source for the 
user-defined chart. To designate a data item as the data source, highlight the 
data item you want as the data source and click this button. By default, the first 
data item is set as the data source.

■ Select a data item and click Remove.

Performance Manager removes the data item from the Data Items page.

■ Select a data item and click Modify or click Add to add a new data item to the 
user-defined chart.

Performance Manager displays the Add/Modify Chart Columns dialog box. For 
more information about this dialog, click Help. The Oracle Performance Manager 
Help provides details on the functions and operations available. The Help also 
provides an example of creating a user-defined chart.

Copying a User-Defined Chart
You can copy user-defined charts from one target to another or within the same 
serve by using the Create Like option. To copy a user-defined chart: 

1. In the navigator tree, select the user-defined chart you want to copy.   

2. From the Charts menu, click User-Defined Charts=>Create Like. 

Note: To add or modify data items to user-defined charts, you 
must use the Agent release 8.1.6 or later.
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Performance Manager displays the Create Like User-Defined Chart dialog box. 

3. Type a label for the new chart in the Chart Label field. 

Note that chart labels must be unique within a target. 

4. In the Service drop-down list, select the target service for the new chart. 

5. Click OK. 

In the Create Like User-Defined Chart dialog box, you can choose the SQL Script 
Command or Data Items page to view the attributes of the chart you are copying. 
However, you cannot change the values of the attributes. Once the chart has been 
copied, you can select the new chart in the navigator tree and make any desired 
adjustments.

Converting Old Performance Manager User-Defined Charts
If you created user-defined charts using Oracle Performance release 1.5.0 or earlier 
(the Windows versions of Oracle Performance Manager), you can convert these 
user-defined charts so that they can be used with Oracle Performance Manager 
release 2.1. See "Converting User-Defined Charts From Previous Releases of 
Performance Manager" on page 2-3 for information on how to perform the 
conversion.

Chart Display Window Menu Shortcut Keys
Table 3–2 lists the Chart Display Window menu and submenu items along with 
their corresponding shortcut keys.

Table 3–2 Chart Display Window Shortcut Keys

Task Shortcut Key

Print Screen . . . Control+P

Report Chart. . . Control+R

Start Recording Control+K

Stop Recording Control+J

Start Playback Control+Q

Stop Playback Control+Y

Pause Playback Control+W



Working With Events and Thresholds in Performance Manager

Introduction to Oracle Performance Manager 3-29

Working With Events and Thresholds in Performance Manager
You can create and edit threshold values from both the Oracle Enterprise Manager 
console and Performance Manager.

From Performance Manager, you can create and edit a Chart-only threshold, create 
and register an event, reset a Chart-only threshold, or edit a registered event. From 
the Enterprise Manager console, you can create, edit or deregister an Enterprise 
Manager event but you cannot edit or view Chart-only thresholds.

You can set thresholds on data items by using event tests or by setting a threshold 
for a data item in a chart (Chart-only threshold) using the Set Chart-only Threshold 
dialog box seen in Figure 3–6. When you monitor a chart that contains a data item 

Fast Forward Control+F

Reset Playback Control+B

Save Control+S

Save As Control+A

Close Alt+F4

Pause/Resume Chart Control+Q

Refresh Rate . . . Control+E

Options Control+O

Historical Data Control+D

Using Help Control+Shift+U

Help on Item Control+Shift+H

Contents Control+H

Search . . . Control+Shift+S

Window F1

Note: The Performance Manager threshold and event features 
described in this section are available only for node and database 
data.

Table 3–2 Chart Display Window Shortcut Keys

Task Shortcut Key
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that supports a threshold established for an event, you can edit the parameters for 
that event by choosing Set Threshold from the Chart Status button.

When you create events from Performance Manager, the event is initialized with 
the context defined by the Performance Manager chart. You can only modify the 
event tests in an event if the event was registered using the Oracle 9i Agent.

If a data item supports the concept of an event, the chart displays a visible indicator 
(a flag) based on thresholds stored in the repository for that data item. If the data 
item does not support the concept of an event, you cannot establish a chart-only 
threshold for the data item. Every metric-based event test can have a warning and a 
critical threshold value. The flag indicators on a chart specify whether a threshold 
value has crossed a warning or critical threshold. The flag that appears on the Chart 
Status button in a chart displays the most serious state of any contained metric 
thresholds, and the metrics that appear when you click on the Chart Status button 
are sorted with the most serious indicators displayed first in the list.

Figure 3–6 Set Chart-only Threshold dialog box

Threshold values may be derived from one of three sources:

■ A default value for some metrics that is added to the repository at the time of 
product installation.
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■ Chart-only thresholds, which are warning and critical threshold values for a 
specific metric, target, target type and instance.

■ An event test derived threshold, which can be shared among administrators 
depending on the access rights of the user and the event containing the event 
test. When you set a threshold on a data item associated with an existing event, 
the thresholds displayed in that chart correspond to the thresholds set for the 
event test.

The threshold types listed above apply to metrics in a specific order of precedence:

■ If you have Event System access and access to an event containing a metric, the 
threshold values for the metric are defined by the Event Test and override any 
Chart-only or default threshold values.

■ If you have established a Chart-only threshold for a metric, the threshold values 
you establish are valid and supersede any default values that may exist.

■ If neither of the previous two scenarios exist and a default threshold is defined 
in the repository for the metric, the default value defines the warning and 
critical thresholds for this metric, regardless of target or data source.

Threshold values are stored in the Oracle Management Server respository and are 
updated whenever the user sets or edits a Chart-only threshold or when Event 
registration changes occur. Chart-only thresholds are removed from the repository 
when you invoke Reset Threshold or when the Administrator is removed from the 
system. If you create a Chart-only threshold that is later overridden by the 
registration of an event, the Chart-only threshold remains in the repository. If the 
association between the metric and the event is later broken, the Chart-only 
threshold is restored.

To set or edit thresholds in Performance Manger:

1. Click the Chart Status button in the upper right corner of the chart below the 
menu bar.

2. Select the data item for which you want to set a threshold and then choose Set 
Thresholds from the context menu.

If there is more than one data source displayed in a chart when you select Set 
Thresholds, Performance Manager displays the Select Data Source dialog box 
where you must choose a single data source for which to set a threshold. When 
you create or edit a chart-only threshold or create a new event, you must choose 
a single data source before setting thresholds.

3. To set or modify a Chart-Only threshold, select Set Chart-Only Threshold at 
the bottom of the window. To register an event, select Register Event.
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4. To set or modify a Chart-Only threshold, add or modify the values in the 
Warning Threshold and Critical Threshold fields. If default warning or critical 
threshold values are defined for the metric, the input fields will contain these 
values.

To register or modify an event, select Register Event and then complete the 
fields in the General, Test, Parameters, Schedule, Access and Fixit Jobs pages of 
the event property sheet. If you are using a pre-9i Agent and you modify an 
event that has been registered, those changes are not used by the registered 
event.

Triggered Events and Thresholds
Events and thresholds often poll at different intervals. For example, events may be 
polled at intervals of minutes or even hours, while thresholds may be sampled in 
seconds. The result is that you could see a metric cross a threshold in a chart but not 
be notified of an event simultaneously. If the problem were caused by a spike, the 
threshold may be crossed in the chart with a sampling occurrence measured in 
seconds, but not trigger an event because the metric is sampled in minutes or hours, 
meaning the event is never triggered at all.

Additionally, events can include the concept of occurrences. Occurrences prevent 
notification for erratic or one-time instances of a threshold being crossed. If an event 
has a number of occurrences associated with a test, you may see the threshold 
crossed in a chart but never see the corresponding event triggered.

Events Registered for Multiple Targets
If you attempt to modify a threshold that has an associated event test registered for 
multiple targets, a warning displays indicating that the change you make will affect 
the event test for multiple targets and that if you want to use different thresholds 
for each target, you must create separate events. If you continue with the change, 
the existing event is deregistered for all targets and re-registered for all targets with 
the new threshold.

Note: If you do  not have permission to access the Enterprise 
Manager Event System, the option of registering an event from the 
dialog box is not present.
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Metrics with Multiple Events and Different Thresholds
When you display a chart for a data item for which there are multiple event tests, a 
message is displayed indicating that there are multiple tests for the same metric. To 
show a threshold for the chart, you must select which event test to associate with 
the metric. If you then modify the associated event test or the metric in the chart, 
the thresholds are synchronized. Other tests of the metric are not affected by 
changes to the threshold in a chart.

If another user de-registers the associated event test and then you display a chart 
with that metric, a warning displays indicating that the previously associated event 
test no longer exists. If only a single event test remains for the metric, the message 
indicates that the remaining event is now associated with the metric. If more than 
one event remains, the message indicates that you must select a new event to 
associate with the metric.

If you add a new event test for a metric where a single chart-only threshold already 
exists, the thresholds associated with the previous test will not be used during 
monitoring.

Event Permissions
If you display a chart for which you have read-only permission for the 
corresponding event, you cannot modify the thresholds for that chart. You receive a 
read-only view of the event indicating that if you wish to change the thresholds 
associated with the data item, you must be granted appropriate access to the event 
system.

Registering Events in Performance Manager
You can register events from within Performance Manager through the Chart Status 
button on a chart containing the data item for which you want to register an event. 

Registering events through Performance Manager is procedurally identical to 
registering events through the Enterprise Manager console.

To create or edit events in Performance Manager:

1. Click on the Chart Status button in the upper right corner of the chart.

Note: Super-users  who set up permissions on an event should 
consider the effect on non-privileged administrators who will be 
unable to modify the thresholds.
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2. Select the data item and then choose Set Threshold from the context menu.

If there is more than one data source displayed in a chart when you select Set 
Threshold, Performance Manager displays the Select Data Source dialog box 
where you must choose a single data source for which to set a threshold. When 
you create or edit a Chart-only threshold or create a new event, you must 
choose a single data source before setting thresholds.

3. Select Register Event at the bottom of the dialog box.

4. Complete or modify the fields in the General, Test, Parameters, and Permissions 
pages of the property sheet to create a new event. If you are using a pre-9i 
Agent and you modify an event that has been registered, those changes are not 
used by the registered event.

When you use a pre-9i Agent, the property sheet for creating a new event is similar 
to the property sheet for modifying an event. Some fields are editable while others 
are not. If you are using a 9i Agent, you can modify many more fields.

You can use several predefined event tests that have been installed with Oracle 
Enterprise Manager. See the Oracle Enterprise Manager Event Test Reference Manual 
for more information on these event tests.

About Oracle 9i and Pre-9i Agents
If you attempt to register a 9i event with a pre-9i Agent, you will receive an error 
message indicating that you cannot register the event. You can use only a 9i Agent 
to register 9i events. 

If there exists both a 9i and pre-9i version of the same event, then the Oracle 
Management Server will determine which to use depending on the Agent version. 
For example, if there is a 9i Agent, the Agent will request registration using the 9i 
version of the event. If the Agent is pre-9i, then it will use the pre-9i version.

If you have migrated from a pre-9i Agent, then an existing event will not 
automatically use the 9i counterpart. To use the 9i test and access thresholds in the 
repository, you must deregister the pre-9i event and register the 9i event using the 
9i Agent.

Viewing Thresholds
If a Performance Manager chart is displaying metrics that have multiple data 
sources, you can display the View Thresholds dialog box to view all threshold 
indicators. The View Thresholds dialog box is accessible from the Chart Status 
button.
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The View Thresholds dialog box displays the current threshold status of each data 
item and its corresponding data source. You can view the status for each 
metric/data source pair using flags to indicate whether the value of the data item 
has passed its warning or critical threshold. If a data item has no threshold set, the 
column containing that data item is left blank.

When you display the View Thresholds dialog box, the current data item and 
threshold values are captured in a dataset and the status of each threshold is 
displayed in the table. A timestamp of the dataset appears in the bottom left corner 
of the View Thresholds dialog box.

If you change a threshold value for a data item while the View Thresholds dialog 
box remains open, the new threshold value is compared against the dataset created 
at the time you displayed the dialog box, not against the current value of the data 
item in real time. To refresh the statuses in the View Threshold dialog box, close and 
redisplay it.

You can add or change threshold values by clicking the Chart Status button on the 
View Thresholds dialog box and choosing Set Threshold from the context menu.

To view thresholds:

1. Click the Chart Status button for the chart containing the data item for which 
you want information and select View thresholds from the context menu.

The View Thresholds dialog box appears, displaying the status of any 
thresholds set for each of the data items and data sources in the chart. The 
status for a threshold is indicated by the flag that appears in the column for the 
data item and data source.

■ A green flag indicates the value for the data item has not crossed a  
threshold.

■ A yellow flag indicates the value for the data item is at or has passed the 
warning threshold.

■ A red flag indicates the value for the data item is at or has passed the 
critical threshold.

If no threshold is set for a data item, the status for that metric is left blank.

The threshold statuses that appear in the View Thresholds dialog box are 
derived from dataset values gathered at the time you display the View 
Thresholds dialog box. The date and time of the dataset appears at the bottom 
of the dialog box. The View Thresholds dialog box is not updated when the 
Performance Manager chart is refreshed.
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From the View Thresholds dialog box, you can set thresholds or reset and edit 
associations for a specific cell if thresholds are set.

You can set or edit a threshold for a metric from the View Thresholds dialog box by 
clicking the Chart Status button and selecting Set Thresholds from the context 
menu. For more information about setting thresholds, see "Working With Events 
and Thresholds in Performance Manager" on page 3-29.

Resetting Thresholds
You can reset Chart-only thresholds through the Chart Status button on a chart. If 
you reset a Chart-only threshold for a data item, the current threshold is deleted 
and is reset to its default value. If the data item has no default value, the threshold 
is simply deleted and no value is assigned as a threshold.

If you select Reset Threshold for a data item with an assigned event, a message box 
displays stating that you must deregister or edit the event from within the 
Enterprise Manager console.

To reset a threshold:

1. From the chart, click on the Chart Status button and select the metric and data 
source for which you want to reset a threshold.

2. From the context menu, choose Reset Threshold. When you select Reset 
Threshold, the current data item is reset to its default value. If the data item has 
no default threshold value, the threshold is eliminated.

A confirmation dialog box appears, verifying that you are about to reset the 
threshold for the current metric. Click the OK button to confirm.

If no threshold exists for the metric, an error dialog box displays informing you 
that the threshold cannot be reset because no threshold exists for the metric.

If you attempt to reset a threshold associated with a registered event, an error 
message dialog box displays. You cannot deregister an event from within 
Performance Manager because the event associated with a metric may have several 

Note: If you add or change the value of a threshold for a data 
item, the status flag for the data item on the currently displayed 
View Thresholds dialog box is updated based on the values stored 
in the dataset at the time the View Thresholds dialog box was 
displayed. To update all the status flags in the current chart, close 
the View Thresholds dialog box and redisplay it.
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other targets and tests. You can instead edit the event from within Performance 
Manager by choosing Set Threshold (for 9i targets) to remove or modify the event.

Refreshing Thresholds
A chart may not reflect an event that is registered while the related chart is open 
because the information for the metric in the chart related to the event has not been 
read from the repository. A chart does not automatically reflect the effect of event 
system changes. When you select Refresh Thresholds from the Chart Status button, 
Performance Manager updates the chart with the new data from the threshold 
repository and updates the chart threshold indicators.

When Event Registration or Permission changes effect the threshold respository, 
Performance Manager users are notified of these changes in a dialog box when the 
threshold data for the metric is next read from the repository. The following actions 
are conveyed to the Performance Manager user when a chart is opened, thresholds 
are refreshed for a chart, or thresholds are edited:

■ An event test associated with a metric has been deregistered.

■ A Chart-only threshold is overridden by the registration of an event test by 
another user.

■ An event test associated with a metric has failed registration.

■ Access to an event containing an event test associated with a metric has been 
removed.

■ An event test associated with an event has been removed from the event or the 
instance has been modified.

■ An event test associated with a metric has failed event modification.

To refresh thresholds, choose Refresh Thresholds from the Chart Status button on 
the Performance Manager chart.

Editing Threshold Associations
There may be circumstances when a user has permission to view several events that 
contain the same event test. When viewing a chart, you must decide which event 
will be associated with the metric in the chart. You can invoke Edit Threshold 
Association to change this association.

The Edit Threshold Association menu item has no application for data items with 
less than two events assigned to it. If you select Edit Threshold Association in such 
a case, a message box appears informing you that the threshold association cannot 
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be changed because a threshold association for the metric does not exist or there is 
only one registered event test.

You cannot change the association for Chart-only thresholds because each user has 
his own pool of Chart-only thresholds and duplicates are not supported.

To edit threshold associations:

1. Click the Chart Status button in the current chart and select the metric for which 
you want to edit the threshold association, and then choose Edit Threshold 
Association from the context menu.

2. When applicable, select the data source from the Select Data Source dialog box 
and click OK.

3. Select the event threshold you want to assign to the data item in the list that 
appears in the Associate Metric with Event Test dialog box.

4. Click the OK button at the bottom of the Associate Metric with Event Test 
dialog box.

To edit threshold associations:

1. Click the Chart Status button in the current chart and select the metric for 
which you want to edit the threshold association and then choose Edit 
Threshold Association from the context menu.

2. When applicable, select the data source from the Select Data Source dialog box 
and click OK.

3. Select the event threshold you want to assign to the data item in the list that 
appears in the Associate Metric with Event Test dialog box.

4. Click on the OK button at the bottom of the Associate Metric with Event Test 
dialog box.

Note: If you attempt to set a threshold association when the 
metric is not associated with an event test or you only have 
permission to view one registered event test for the specified target 
and data source, an error dialog box appears informing you that the 
association cannot be changed.
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Running Performance Manager in a Browser
You can run Oracle Performance Manager in a browser and use a significant subset 
of the features of the full product, including basic monitoring features and event 
integration. Browser support includes basic monitoring features and event 
integration if you are using a version 9i Agent (or later).

The following features are available when running Performance Manager in a 
browser:

■ Show database chart

■ Show node chart

■ Drilldowns

■ Help

■ Quick Tour

■ Print Screen from charts

■ Report Chart from charts

■ Pause/Resume charts

■ Set Refresh Rate

■ Set Options

■ Setting Chart-only thresholds    

■ Event Registration  

The following features are not available while running Performance Manager in a 
browser:

■ Recordings

■ Historical collection drilldowns

■ Custom Charts

■ Saved chart attributes

■ User-defined charts

■ Direct Connect

■ Standalone mode

■ SQL Analyze
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■ Threshold status

Viewing Metric and Event Documentation Through a Browser
You can view specific information about metrics, events, charts and classes in 
Performance Manager through the Advice function on the Chart Status button and 
through other contextual functions within the Oracle Enterprise Manager 
application. However, you can view the full set of documentation for all the 
following types of metrics and events independently through your web browser 
without having to access the Oracle Enterprise Manager application. The 
documentation available through your browser provides a comprehensive Table of 
Contents, an index keyword search, and a full text search function.

■ Oracle Database

■ Windows NT

■ IBM AIX

■ Sun Solaris

■ HP-UX

■ Compaq Tru64

■ SAP R/3 System

■ Oracle Applications system

For each of these types of metrics and events, the following information is 
provided.

For Metrics:

■ Classes

■ Charts

■ Data Items

■ Description

■ Source

■ User Action

■ Event Tests

■ Description
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■ Source

■ Parameters

■ Output

■ Frequency

■ User Action

To access each documentation set, open the appropriate file below in a web 
browser:

■ Oracle Database -- ORACLE_HOME/doc/EM/Webhelp/dba/dba.htm

■ Windows NT -- ORACLE_HOME/doc/EM/Webhelp/nt_os/NT_OS.htm

■ IBM AIX -- ORACLE_HOME/doc/EM/Webhelp/aix/AIX.htm

■ Sun Solaris -- ORACLE_HOME/doc/EM/Webhelp/sol/SOL.htm

■ HP-UX -- ORACLE_HOME/doc/EM/Webhelp/hpux/HPUX.htm

■ Compaq Tru64 -- ORACLE_HOME/doc/EM/Webhelp/dec/DEC.htm

■ SAP R/3 -- ORACLE_HOME/doc/EM/Webhelp/sap/sap.htm

■ Oracle Applications System -- ORACLE_
HOME/doc/EM/Webhelp/oafnd/OAFND.htm
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4
Introduction to Oracle Capacity Planner

Oracle Capacity Planner is an Oracle Enterprise Manager application that allows 
you to collect different types of performance statistics and record that data in an 
historical database.  You can then use Oracle Capacity Planner to analyze the 
historical data to plan future capacity.

Oracle Capacity Planner uses the Intelligent Agent (Agent) to collect its historical 
data. To collect most types of data, you must install the Agent on the system (or 
systems) where you want to collect data. See the Oracle Intelligent Agent User’s Guide 
for information on managing the Agent.

If you are using Oracle Capacity Planner to collect database data, the Agent can be 
installed on another system.  See "Accessing Historical Data Through an 
Intermediate Host" on page 4-3 for more information on accessing data through an 
Agent on another system.

Note: In releases prior to 9i, the Agent data gathering service (also 
known as the Oracle Data Gatherer) was used to collect data for 
presentation in real-time performance monitoring utilities and 
historical data. The Intelligent Agent and the data gathering service 
were separate services that were started and stopped 
independently of each other.

With 9i, the data collection capabilities are integrated into the 9i 
Intelligent Agent. Therefore, there is no separate service that needs 
to be started. Furthermore, when you stop the 9i Intelligent Agent, 
the data gathering capabilities are disabled and not available.
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The types of performance data that Oracle Capacity Planner can collect on a system 
depend on the products that are installed. Table 4–1 shows the types of data that 
Oracle Capacity Planner can collect when various Oracle products are installed. 

If additional products from Oracle or other vendors are installed, Oracle Capacity 
Planner may be able to collect additional types of data not shown in Table 4–1.

How Capacity Planner Collects and Stores Performance Data
The following list identifies how Capacity Planner uses the Agent to collect 
performance data:

■ The Agent collects the data at an interval you specify from within Capacity 
Planner.

The Agent stores the data in an efficient binary form.

■ At a specified loader interval, the data is read from this binary file and stored in 
a readable form in the Oracle Capacity Planner historical database.  

The Agent also aggregates the data by time, creating summary statistics for the 
data that is collected at different time intervals (hour, day, week, and so on). 

■ Over time, the Agent purges the data in the historical database, keeping only as 
much data as you specify.  

Table 4–1 Data That Capacity Planner Can Collect When Various Oracle Products are 
Installed 

Oracle 
Product

Oracle 
Concurrent 
Manager 
Data

Oracle 
Database 
Data

Node 
(Operating 
System) 
Data

SAP R/3 
System 
Data

Microsoft 
SQL 
Server 
Data

Diagnostics 
Pack

No Yes Yes No Yes

Management 
Pack for 
Oracle 
Applications

Yes No Yes No No

Management 
Pack for SAP 
R/3

No No Yes Yes No
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Purging the historical data allows you to have access to a current view of recent 
performance data for your environment and to manage the amount of stored 
data to avoid wasting disk space.

Accessing Historical Data Through an Intermediate Host
Oracle Performance Manager relies on the Agent to monitor a target (such as a 
node, a database, or a concurrent manager). Usually, the collection of the data is 
done on the system where the target is located. However, for some types of targets 
Oracle Performance Manager can also monitor data on a system by using the Agent 
on another system (an intermediate host).

This intermediate host could be the client system where the Oracle Performance 
Manager is running, or any other system on the network on which the Agent is 
available.

There are three ways to set the location of the Agent. The method you use depends 
on how you connect to the target.  Consider the following scenarios:

■ You connect to a database that has been discovered using the Enterprise 
Manager console and you are running Oracle Capacity Planner while connected 
to the Oracle Management Server.

Capacity Planner attempts to connect to the Agent on the host where the target 
is located. If this connection fails or cannot be attempted because no preferred 
credentials have been set for the database, you will be prompted with a dialog 
box containing logon credentials for the database. You can use the Connection 
Details dialog box to specify the location of the Agent that will be used to 
collect performance data.

■ You click the Add Service button in the toolbar panel and manually add the 
target to the navigator.

Capacity Planner displays a Logon dialog box.  This dialog box also contains a 
field to specify the location of the Agent that will be used to collect performance 
data.

■ You select a target in the Capacity Planner navigator tree and choose Set 
Connection Details from the File menu.

Capacity Planner displays the Database Logon dialog box for the selected 
target. This dialog box also contains a field to specify the location of the Agent 
that will be used to collect performance data.
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Usage Scenarios for Oracle Capacity Planner
Oracle Capacity Planner can perform tasks such as the following:

■ Track the increase in the amount of used space on a disk over time and estimate 
when 95 percent of the space on the disk will be consumed

■ Track the increase in the total I/O rate for a host over time, then estimate what 
the total I/O rate for the host will be at some future point in time

■ Determine thresholds to set in Performance Manager by evaluating historical 
data gathered in Capacity Planner

■ Provide a predefined set of data that measures performance (Oracle 
Recommended Collection)

■ Publish historical data to a website where administrators and system 
administrators can view data that is periodically updated

Starting Oracle Capacity Planner
You can start Oracle Capacity Planner in any of the following ways:

■ On the Oracle Enterprise Manager console, click the Diagnostics Pack drawer, 
then click the Capacity Planner icon.

■ On the Oracle Enterprise Manager console, select a Database target, click the 
right mouse button, point at Related Tools in the context menu, then click 
Capacity Planner.

■ On the Tools menu of the Oracle Enterprise Manager console, point to 
Diagnostics Pack, then click Oracle Capacity Planner.

■ From the UNIX command line, change directory to the ORACLE_HOME/bin 
directory (where  ORACLE_HOME represents the home directory in which the 
Diagnostics Pack is installed), then type the following command:

./oemapp cp

■ From the Start menu, point to Programs, then to the Oracle Home where Oracle 
Enterprise Manager is installed, then to Diagnostics Pack, then click Capacity 
Planner, which displays the Capacity Planner Login dialog box.

Enter the appropriate connect information for your Oracle Enterprise Manager 
repository, then click OK.
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Using Help
When you are using Oracle Capacity Planner, you can display context-sensitive 
help topics. You can also display conceptual topics and task topics.

To obtain context-sensitive help for an Oracle Capacity Planner panel, window, 
dialog box, or property page, select an item in the panel, window, dialog box, or 
property page, then on the Help menu, choose Window.

To obtain context-sensitive help for a class, chart, or data item on a property page, 
select the class, chart, or data item on the property page, then take one of the 
following actions:

■ Press F1.

■ Click the Help icon on the toolbar.

■ On the Help menu, choose Selected Item.

If a help topic is not available for a class, chart, or data item, a No Help Available 
message is displayed when you request help.

To view the Contents page for the Oracle Capacity Planner help, on the Help menu, 
choose Contents. On the Contents page, you can:

■ View a list of the conceptual help topics by double-clicking the Conceptual 
Topics book on the help system’s Contents page.

Conceptual topics provide conceptual or overview information of which you 
should be aware before performing a particular Oracle Capacity Planner task. 
Conceptual topics do not contain step-by-step information for performing a 
task.

■ View a list of the task help topics by double-clicking the Task Topics book on 
the help system’s Contents page.

Task topics provide step-by-step instructions for accomplishing an Oracle 
Capacity Planner task. They do not provide conceptual information that you 
should be aware of before performing the task.

You can access a glossary of Oracle Capacity Planner terms by double-clicking the 
Oracle Capacity Planner Glossary book on the Contents page.
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Using Oracle Capacity Planner
You may find it helpful to think of using Oracle Capacity Planner as a two-step 
process:

1. Setting up the collection of historical data

See "Setting Up a Collection" on page 4-6 for a detailed description of how to 
collect historical data.

2. Analyzing the collected data

See "Analyzing Collected Data" on page 4-35 for a detailed description of how 
to analyze collected data.

Setting Up a Collection
To set up a historical data collection with Oracle Capacity Planner, you:

1. Select (and connect to) the targets for which you want to collect historical data.

2. Define the frequency of collection samples.

3. Define the location of the historical database and the frequency at which 
collected data should be loaded in the historical database.

4. Define the amount of data to be kept in the Oracle Capacity Planner database at 
each time interval.

5. Select the classes of data to collect, based on what is available in the Oracle 
Capacity Planner navigator.

Figure 4–1 shows the steps to follow when setting up a collection.  For more 
information on each step, see the following sections.
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Figure 4–1 Steps for Setting Up a Collection

Selecting Targets
You can select one or more targets from which you want to collect historical 
performance statistics. For example, when you have the Oracle Diagnostics Pack 
installed, the target types are usually Nodes and Databases. 

The procedure for selecting a target depends upon whether or not the server resides 
on a node that is known to the Enterprise Manager main console.  A node is known 
to the console when it has been discovered with the Enterprise Manager console 
Discover Nodes command.

Selecting Targets on Discovered Nodes
To select a target on a node that has been discovered by the Enterprise Manager 
console:

1. Click the Collection tab of the Oracle Capacity Planner navigator panel, which 
displays the Oracle Capacity Planner collection view. 

2. Double-click one of the target type folders.

The Oracle Capacity Planner navigator tree displays the targets of the selected 
type that are known to the Oracle Enterprise Manager main console.

3. Select the target from which you want to collect performance data and click the 
Connect button in the Capacity Planner toolbar, or click the plus sign (+) next to 
the target in the navigator.

Define the collection frequency

Define the frequency of loading class data

Define the amount of data to keep 
for a time interval

Select a service to collect data from

Specify the classes to collect

NU-3695A-AI
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When you connect to a target in the Oracle Capacity Planner navigator panel, 
you may be prompted for credentials if they are required to connect to that 
target. If a logon dialog box appears, click Help for information on the 
individual fields on the dialog box. 

After you connect to a target, the available collection classes for that target 
appear in the navigator and Oracle Capacity Planner displays the Target 
property sheet for the selected target.  For example, Figure 4–2 shows the 
classes that appear when you connect to a Windows NT node target.

Figure 4–2 Selecting a Target in the Oracle Capacity Planner Window

Selecting Targets on Undiscovered Nodes 
If you double-click a target type and the target you are looking for does not appear 
in the target type folder, you can do one of the following:

■ Use the Enterprise Manager console to discover the node where the target 
resides.

This is the preferred method for adding a target to the Capacity Planner 
navigator panel.  When you discover a node with the Enterprise Manager 
console, Capacity Planner saves key information about the target, such as the 
preferred credentials, location of the Agent, and historical database 
information.
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■ Add the target manually to the Capacity Planner navigator panel.

When you add a target manually, the target is added for the current session of 
Capacity Planner only. You can start gathering data for the target, but the next 
time you start Capacity Planner, the target will not appear in the navigator 
panel. To modify collection settings or analyze data collected for the target, you 
will have to add the target again the next time you start Capacity Planner.

To add a target manually:

1. Select the target type for the target you want to add.

2. Click the Add Service button in the Capacity Planner toolbar.

Capacity Planner displays a message to remind you that targets you add 
manually will be available for the current session of Capacity Planner only.

3. Click Yes.

Capacity Planner displays a logon dialog box for the target. Click Help if you 
need information about any of the specific fields on the dialog box.

4. After you fill in the logon credentials, click OK to connect to the target.

After you connect to a target, the available collection classes for that target 
appear in the navigator and Oracle Capacity Planner displays the Target 
property sheet for the selected target (Figure 4–2). 

About the Target Property Sheet
When you connect to a target, Oracle Capacity Planner displays the Target property 
sheet, which contains the following property pages:

■ Collection Options page

■ Storage Options page

■ Purge Options page

The collection, load, and purge settings you select on these pages apply to all the 
classes in the selected target.  You cannot change these settings for a selected class; 
you can change them only for a selected target.

Defining the Frequency of Collection Samples
When you first connect to a target, Capacity Planner displays the Collection 
Options property page.  The values you select on this page determine how often the 
Agent will collect information about the selected target and save it to disk.   On the 
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Collection Options property page, you can set the frequency of collection samples 
using either of these two methods:

■ By selecting the number of data samples to collect for a specified time interval

For example, to collect information 3 times every hour, select Samples per Time 
Interval, enter 3 in the text field, and choose Hours from the drop-down list.

■ By specifying the length of time between collection samples

For example, to collect information every 20 minutes,  select Time Between 
Samples, enter 20 in the text field, and choose Minutes from the drop-down 
list.

Defining the Location of the Historical Database
After you set the frequency of collection samples, use the Storage Options tab to 
specify the location of the Oracle Capacity Planner historical database. This setting 
defines where Capacity Planner will save information collected for the selected 
target. When data is saved in the historical database, you can later analyze the data 
or use it to generate trend analyses.

Note: To configure the settings for collecting data, the Agent that 
will collect data for a target must be running.  Normally, the Agent 
is located on the host where the target is located.

To collect data for a database, the Agent can be located on a host 
other than the host where the database is located. See "Accessing 
Historical Data Through an Intermediate Host" on page 4-3 for 
more information. 
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By default, collected data is saved in your Oracle Enterprise Manager repository. 
However, you can specify an alternate database for the historical data if you do not 
want to store historical data for the selected target in the repository.

To save the data collected for a target in a location other than the Oracle Enterprise 
Manager repository:

1. From the Storage Options tab, select Store historical data in alternate location.

2. Enter the credentials for the database that will store the collection data for the 
target.

Enter the appropriate user name, password, and target for the Oracle Capacity 
Planner historical database.  This connection information is used by the Agent 
when it loads the collected data at the specified loader interval.  Therefore, the 
target specified for the Oracle Capacity Planner historical database must be 
known and accessible from the host where the Agent is running.  

For example, if you specify MY_DB.WORLD as the historical database and your 
Agent is running on host MYNODE, then database MY_DB.WORLD must be 
reachable via Net8 or SQL*Net from host MYNODE (MY_DB.WORLD must 
exist in the TNSNAMES.ORA file for host MYNODE, for example).

Defining the Frequency of Loading Collection Data
After you define how often data will be collected and where the data will be stored, 
you can define how often the data will be loaded into the historical database.

You can determine how frequently the Oracle Capacity Planner loader program 
loads collection data for the target using either of these two methods:

■ Using the Per Time Interval field to specify the number of loader passes for a 
specified time interval

■ Using the Time Between field to specify the length of time between loader 
passes

Note: Although data can be collected at short time intervals (such 
as 5, 10, or 15 minutes), collected data is not available to you for 
analysis until it has been loaded into the Oracle Capacity Planner 
historical database. Therefore, the load interval you specify controls 
when the most recently collected data will be visible to you.
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The collection frequency you set determines the lowest time interval for which 
Oracle Capacity Planner can analyze data.  For example, if you want to be able to 
analyze data from hourly intervals, you need to set a collection frequency of at least 
once an hour. 

After you define the frequency of loading collection data, you can set a time for the 
next loader pass by using the Next Transfer Occurs at field:

1. Click the value that you want to change in the date and time box.

2. Click the up or down arrow to select a higher or lower value.

If the current time is later than the time displayed for the Next Transfer Occurs 
at setting, click Refresh View to update the display to show the actual time of 
the next loader pass.

Note that the values that you select on the Storage Options property page apply to 
all classes of data collected on the selected target.

Understanding When the Loader Runs
The loader runs at the regular time interval specified on the Storage Options 
property page.  The time specified in the Next Transfer Occurs at field controls 
when the loader runs.  For example, if you want the loader to run once a day at 2:00 
a.m., then set the transfer interval to once per day, and set the next transfer time to 
the next day at 2:00 a.m.  The loader will run for the first time at 2:00 a.m. the next 
day, and then will run once a day, each day at 2:00 a.m.

You can use the Next Transfer Occurs at field to force the loader to run 
immediately—or as soon as possible. Simply set the next transfer time to a time 
earlier than the current time.

Understanding How Data Aggregation Works
As it loads data into the database, Oracle Capacity Planner automatically 
aggregates the data. During aggregation, Oracle Capacity Planner examines the 
collection samples for a given time interval, calculates an average value for that 
interval, then uses that average value for calculations at the next larger time 
interval.
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On each loader pass, Oracle Capacity Planner examines the time stamps of all 
collected data to determine whether or not the threshold for a set interval (hour, 
day, week, month, or year) has been crossed since the previous loader pass.  If so, 
Oracle Capacity Planner performs an aggregation of collected data from the next 
smaller interval to the interval threshold just passed.  Table 4–2 shows the larger 
time interval to which data at each time interval is aggregated.

An example may help clarify how Oracle Capacity Planner aggregates collection 
data.  Suppose Oracle Capacity Planner is collecting a data sample every 10 minutes 
to capture the percentage of used space on a particular disk, and the loader runs 
once an hour.   When the Oracle Capacity Planner loader runs and transfers data 
into the Oracle Capacity Planner database every hour, it examines the values for the 
percentage of used disk space in the samples collected during the previous hour, 
then it computes an average percentage for the samples.  That average percentage is 
then used as the average value for the hour. 

At the first loader pass after midnight, Oracle Capacity Planner uses the hourly 
averages since midnight the previous day to compute the day’s percentage of used 
disk space.  

At the first loader pass after midnight on Saturday, Oracle Capacity Planner 
examines the daily averages of used disk space since midnight the previous 
Saturday and computes an average percentage for the week.  

At the first loader pass after midnight on the last calendar day of the month, Oracle 
Capacity Planner examines the weekly averages since midnight on the last calendar 
day of the previous month and computes an average percentage for the month.  

Finally, at the first loader pass after midnight on December 31, Oracle Capacity 
Planner examines the last 12 monthly averages to compute a yearly average.

Table 4–2 Aggregation of Data from Smaller to Larger Time Intervals 

Data at This Interval Aggregates to This Interval

Minutes Hours

Hours Days

Days Weeks

Weeks Months

Months Years
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Defining the Amount of Data to Keep
The final step in setting up a target for historical data collection is defining the 
amount of data to keep.

When you select a target, you can click the Purge Options tab to display the Purge 
Options property page.  On this page, you specify the amount of data you want to 
store in the Oracle Capacity Planner historical database for each type of data (for 
example, hour data, day data, and week data).  You can accept the default Purge 
Options property page values or choose different values.

The values set on the Purge Options property page apply to all classes of data 
collected on the selected target.

The values you specify in the data retention table (the Enter the amount of data  
you want to keep table on the Purge Options page) determine how far back in time 
you can go to analyze data for the different types of data.

Suppose, for example, you always want to be able to view hour data for the 
previous six weeks.  In this case, for the Hours Data Type row in the data retention 
table, you would enter 6 in the Timespan column and Weeks in the To Keep 
column. This tells Oracle Capacity Planner that you want to keep hour data for a 
6-week period. Oracle Capacity Planner calculates 6 weeks from the current time, 
and the Purge Data Older Than column shows the time span for which hour data is 
available.  Table 4–3 shows the Hours row in the data retention table with this data 
entered.

For each row in the data retention table, you can choose the time span to keep data 
samples for that type of data by entering the desired value in the Timespan to Keep 
column.

Applying and Reverting the Collection Settings for a Target
When you finish setting all the options on the Target property sheet, do the 
following to apply your collection settings:

1. Click Apply.

Table 4–3 Specifying How Much Data to Keep for a Data Type

Data Type Timespan To Keep Purge Data Older Than

Hours 6 Weeks (current date minus 6 weeks)
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If you changed the location of the historical database on the Storage Options 
page, Capacity Planner displays a message box reminding you that any 
information stored in the previous location will not be available for analysis.

If you don’t want to be reminded about this implication the next time you 
change the database location, select Don’t show this message again.

2. Click OK.

Capacity Planner displays a message stating that the options were set 
successfully.

3. Click Continue to close the message box and return to the Capacity Planner 
main window.

When you apply your collection settings, Capacity Planner sends the settings to the 
Agent for the selected target.  Note that you cannot select data to be collected until 
these settings have been applied.  

At any time during the process of modifying the settings on the Target property 
sheet, you may revert the settings to their last saved (applied) state by clicking 
Revert.  However, after you apply the settings, they cannot be reverted to their 
previous settings using the Revert button; they must be modified manually.

Selecting the Classes of Data to Collect
After you set the collection and loading options for a target, you can then select the 
classes of performance data that you want to collect for that target:

1. In collection view, select and connect to the target.

For more information, see "Selecting Targets"  on page 4-7. 

2. Click the plus sign (+) next to the target to show the classes of data you can 
collect.

3. Select one of the classes for the target.

Figure 4–3 shows a typical collection class for a node target on Windows NT and 
the data sources and data items available for the class.
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Figure 4–3 Selecting Data Sources and Data Items for a Collection Class

The following list explains classes, data items, and data sources in more detail:

■ Classes

A class is a container for a particular category of data. For example, a node (or 
operating system) target might include the following classes:

– System

– Processor

– Memory

When you select a target in the navigator, Capacity Planner displays the names 
of the classes below the target in the tree view.

You can collect data from none, some, or all displayed classes for a target.  A 
class may also be a container for other classes, to provide logical groupings of 
the performance data at higher levels.  For example, an I/O class may be a 
container for other more specific I/O classes.
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■ Data items

In a class, each of the related statistics is referred to as a data item.  For example, 
a LogicalDisk class might include the following data items:

– Percent Free Space

– Free Megabytes

– Current Disk Queue Length

– Disk Writes per Second

A class can contain one or more data items.  When you select a class in the 
navigator, the names of the data items and data sources associated with the 
data items are displayed on the Collection Details property page.  Select the 
data items that you are interested in collecting.  

A green check mark appears next to the name of each data item that is selected 
for collection.  You can toggle the state of all data items between collected and 
not collected by clicking the Data Items column header that contains the check 
mark.

■ Data sources

A data source is a description of where Oracle Capacity Planner can collect the 
data items for a class.  A class can contain one or more data sources.  When you 
select a class in the navigator, the names of the data items and data sources 
associated with the class are displayed on the Collection Details property page.

The type of data in the class determines the data sources for the class.  For 
example, in a LogicalDisk class, the data sources might be the individual disks 
for the operating system (for example, disk1, disk2, and so on).  In a CPU 
Utilization class, the sources are the individual CPUs for the host (for example, 
cpu1, cpu2, and so on). You can collect data items from one or more data 
sources.  

When you select a data source, a green check mark appears next to the name of 
the data source on the Collection Details property page. You can toggle the state 
of all data sources between collected and not collected by clicking the Data 
Sources column header that contains the check mark.

Starting Data Collection
After you select the data items that you want to collect from the available data 
sources on the Collection Details property page, click Apply to confirm your 
selections, or click Revert to cancel the selections.
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When you click Apply for a class of data, Capacity Planner marks the icon for the 
selected class and the selected target with a green dot in the Collection view of the 
navigator panel.  A green dot on a collection class icon indicates that one or more 
data sources are selected for the class. A green dot on a target icon indicates that 
Capacity Planner is collecting data for one or more classes in the target.

For example, in Figure 4–4, Capacity Planner is actively collecting data for the 
Processor, Memory, and Cache classes for node ANG-PC.  Capacity Planner is not 
collecting data for the System collection class.

Figure 4–4 Green Dots on a Target or Class Indicate Capacity Planner is Collecting 
Data

Stopping Data Collection
To stop collecting data for one or more data items or data sources for a collection 
class, follow these steps:

1. Select the collection class in the navigator.

2. On the Collection Details page, click on the green check marks for those data 
items or data sources from which you no longer want data collected, which 
causes the check marks to disappear.

3. Click Apply.

To stop collecting data for all data items and data sources for a collection class, 
follow these steps:

1. Select the collection class in the navigator.

2. On the Collection Details page, click Stop Collection.

Capacity Planner displays a message box stating that collections for the class 
have stopped.
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3. Click OK to close the message box and return to the Capacity Planner main 
window.

When no data sources are selected for collection for a class of data, the icon for 
that class in the navigator does not display a green dot.

To stop collecting data for all classes in a target:

1. In collection view, select and connect to the target.

For more information, see "Selecting Targets"  on page 4-7. 

2. Click Stop Collection on the Target property sheet.

Capacity Planner displays a confirmation box.

3. Click Yes to stop collecting data for all classes in the target; click No to cancel 
the operation.

Generating a Collection Report
A collection report provides a summary of the collection settings for one or more 
targets. Capacity Planner displays the collection settings in your Web browser. In 
the browser, you can easily review the settings currently applied to the target or 
targets you selected.

To display a collection report for one or more targets:

1. In collection view, on the File menu, choose Collection Report.

Capacity Planner displays the first screen of the Collection Report Wizard.

2. Use the Collection Report Wizard to specify the target or targets whose 
collection settings you want to include in the report and to generate and view 
the report.

At any time while using the wizard, click Help for more information.

When you click Finish on the last screen of the Collection Report Wizard, Capacity 
Planner saves the report to an HTML file and displays the report in your Web 
browser.

Copying Collection Settings
After you set up collection settings for one service, you can quickly copy those 
settings to another similar target.
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To copy the collections settings from one target to another:

1. In collection view, select a target whose collection settings you want to copy.

2. On the File menu, choose Copy Collection Settings or right mouse click on the 
Collection Settings from the context menu.

Capacity Planner displays the first screen of the Copy Collections Wizard.

3. Use the Copy Collection Settings Wizard to specify the destination targets to 
which you would like to copy the collection settings for the selected target.

From the wizard, you can also view the progress of the copy operation. At any 
time while you are using the Copy Collection Settings Wizard, click Help for 
more information.

Creating a User-Defined Class
You can create a user-defined class for any database target. As with other classes, 
you can collect data from a user-defined class and then analyze that collected data.

To create a user-defined class:

1. In collection view, select and connect to a database target.

For more information, see "Selecting Targets"  on page 4-7. 

2. Select the User-Defined Classes folder for the database.

3. In the Capacity Planner toolbar, click the Add User-Defined Class button.

4. On the SQL Script Command page, specify a name for the user-defined class 
and a SQL statement that returns the columns of data that you want to include 
in your user-defined class.

5. Click Evaluate.

Oracle Capacity Planner performs a validation check on the SQL statement. 
When the validation check succeeds, the Collection Details page becomes 
available.

Note: Any destination target you select must be running an Agent 
of the same type and version as the target from which you are 
copying your settings.
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6. On the Collection Details page, designate a data source for the user-defined 
class by selecting the data item that contains the column that you want to 
designate as the data source, then click Set Data Source. 

A key icon appears in the Data Item column next to the data item that is  
designated as the data source. For more information, see "Designating a Data 
Item as the Data Source for a User-Defined Class" on page 4-21.

7. Make any changes that you want to make to the data items by clicking either 
Remove, Modify, or Add. 

For more information, see "Removing, Modifying, and Adding Data Items in a 
User-Defined Class" on page 4-22.

8. After you finish defining the user-defined class, click  Start Collection to start 
collecting data for the class.

Designating a Data Item as the Data Source for a User-Defined Class
On the Collection Details page for a user-defined class, you must designate one of 
the data items as the data source for the class. Each row in the Class Data Items 
table displays information about a data column that will be returned when the 
statement on the SQL Script Command page runs. The Data Item column displays 
the name that Oracle Capacity Planner will use for the data item in the user-defined 
class. The Derived From column displays the source or derivation of the Data Item 
name.

When the Oracle Capacity Planner loader runs and determines that the collected 
data for the user-defined class needs to be aggregated, the values of the data items 
are aggregated by the values in the data source, then stored with the data source in 
the historical database.

For example, the sample user-defined class described in the Capacity Planner online 
help creates a user-defined class that gathers rollback segment data. In that 
example, the logical choice for the data source is the rollback segment number.  The 
other data items in the example provide data about each rollback segment.   At 
regular intervals, Capacity Planner aggregates the data items associated with each 
of the rollback segments (or each rollback segment number) to come up with 
averages over time.

Note: The Oracle Capacity Planner online help includes an 
example of creating a user-defined class. Search for Example in the 
Capacity Planner online help index.
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Removing, Modifying, and Adding Data Items in a User-Defined Class
The Class Data Items table on the Collection Details page displays the data items in 
the user-defined class. Use the Class Data Items table to remove, modify, and add 
data items in a user-defined class.

■ To remove a data item:

Select the data item that you want to remove from the class, then click Remove. 
This removes the data item from the Class Data Items table and the 
user-defined class.

■ To modify a data item:

Select the data item that you want to modify, then click Modify, which displays 
the Add/Modify Collection Details page. 

On the Add/Modify Collection Details page, you can change the label of the 
data item. You can also specify how the data item is derived. After you finish 
modifying a data item on the Add/Modify Collection Details page, the 
information for the data item is updated in the Class Data Items table.

■ To add a data item:

Click Add, which displays the Add/Modify Collection Details page. On the 
Add/Modify Collection Details page, you can specify a label for the data item. 
You can also specify how the data item is derived. After you finish defining the 
data item on the Add/Modify Collection Details page, a row for the data item is 
added to the Class Data Items table.

The Add/Modify Collection Details page allows you to define new data items 
derived from the definitions of existing data items. You can specify functions to be 
used on retrieved data items from the script. These functions can be performed on 
numeric data only.

The online help for Oracle Capacity Planner provides details on the functions and 
operations available.

Note: To modify or add data items in a user-defined class, you 
must be running the Agent provided with Oracle Server 8.1.6 or 
later.
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Modifying User-Defined Classes

To modify a user-defined class before you start collecting data for the class, follow 
these steps:

1. In collection view, select and connect to a database target.

For more information, see "Selecting Targets"  on page 4-7. 

2. Select and expand the User-Defined Classes folder for the database.

3. Select the user-defined class that you want to modify.

Capacity Planner displays the SQL Command Script page and the Collection 
Details page for the class.

4. If you want to modify the name of the class, modify the name in the Class 
Label field on the SQL Script Command page.

5. If you want to change the SQL statement that defines the user-defined class, 
modify the statement on the SQL Script Command page. 

After you change a SQL statement, click Evaluate so that Oracle Capacity 
Planner can perform a validation check on the statement. When the validation 
check succeeds, click the Collection Details tab.

6. On the Collection Details page, you can remove, modify, or add rows in the 
Class Data Items table. 

Note: You can modify a user-defined class before you start 
collecting data for the class, but you cannot modify the class after 
you start collecting data for the class. 

If you want to make changes to a user-defined class after starting 
data collection for the class, create a new user-defined class like the 
class you want to modify, then modify the new user-defined class. 
For more information, see "Creating a User-Defined Class Like an 
Existing User-Defined Class"  on page 4-24.

After you make the desired changes to the new user-defined class, 
you can collect data for the new class and stop data collection for 
the user-defined class that was created earlier.
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For example, you can click Remove to remove a data item, and Modify or Add 
to modify or add a data item, respectively.

When you modify or add a data item, you can also specify that functions or 
operations be performed on data items that have numeric data types.  For more 
information, see the Capacity Planner online help.

Creating a User-Defined Class Like an Existing User-Defined Class
To create a user-defined class like an existing user-defined class, follow these steps:

1. In collection view, select and connect to a database target.

For more information, see "Selecting Targets"  on page 4-7. 

2. Select and expand the User-Defined Classes folder for the database.

3. Select the user-defined class that is similar to the user-defined class that you 
want to create.

4. On the Classes menu, choose Create Like User-Defined Class.

Capacity Planner displays the Create Like User-Defined Class dialog box. 

5. Enter a name for the new user-defined class in the Class Label field.

6. Select a database target from the Service drop-down list.

Note that you cannot make any other changes to the user-defined class until 
after you create the new class.

7. Click OK.

Capacity Planner creates the new user-defined class in the User-Defined Classes 
folder of the target you selected.

You can now modify the new user-defined class using the procedure in 
"Modifying User-Defined Classes"  on page 4-23.

Note: To modify or add data items in a user-defined class, you 
must be running the Agent provided with Oracle Server 8.1.6 or 
later.
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Starting Data Collection for a User-Defined Class
After you create a new user-defined class, you can start collecting data for the class:

1. In collection view, select and connect to a database target.

For more information, see "Selecting Targets"  on page 4-7. 

2. Select and expand the User-Defined Classes folder for the database.

3. Select the user-defined class for which you want to data.

4. Click Start Collection.

A green dot appears next to user-defined classes when you start collecting data 
for the class.

Deleting a User-Defined Class
To delete a user-defined class, follow these steps:

1. In collection view, select and connect to a database target.

For more information, see "Selecting Targets"  on page 4-7. 

2. Select and expand the User-Defined Classes folder for the database.

3. Select the user-defined class that you want to delete.

4. In the detail panel, click  Stop Collection.

5. On the Classes menu, choose Remove User-Defined Class.

Troubleshooting Collection and Load Problems
During the collection and load processes, errors may be encountered by the Agent.  
You can determine if data is not being collected or loaded by using either of these 
methods:

■ Browsing the analysis data in the Oracle Capacity Planner navigator.  See 
"Browsing the Collected Data" on page 4-37 for more information.

■ Accessing the historical database using SQL.  See "Understanding the Oracle 
Capacity Planner Historical Database" on page 4-51 for more information.

If data is not being collected or loaded, you should check the status of the Agent on 
the host from which data is being collected.  If the Agent is running, check the log 
file ($ORACLE_HOME/network/log/dbsnmp.log) for errors related to the 
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collection or loading of data. See the Oracle Intelligent Agent User’s Guide for 
additional details on the configuration of the Agent.

Collecting Data for Diagnostic Reporting
Capacity Planner allows you to collect and report on historical data for a database 
in the context of  diagnostic reporting. Collection for diagnostics reporting involves 
collecting a fixed set of metrics over time. This predefined set of data, the Oracle 
Recommended Collection, collects all performance metrics required to perform 
comprehensive diagnostics and reporting and allows for trending of historical data. 
Data is loaded to the OEM repository or an alternate location on the frequency you 
specify.

To perform diagnostics using historical data, a complete set of data must be 
available for analysis. Capacity Planner gives you the option to enable collection of 
this dataset as a unit. You can initiate collection of diagnostics data for a specific 
database from within the Capacity Planner collection setup tab using one of two 
options:

■ Oracle Recommended Collection

To support diagnostics reporting, it is important that the complete set of data be 
available for analysis. Choosing Oracle Recommended Collection enables you 
to collect all performance data necessary for performing diagnostics, reporting, 
and trending based on a non-editable template of collection metrics defined by 
Oracle. When you choose Oracle Recommended Collection, you do not have the 
option of selecting specific metrics or classes of metrics or adding metrics to the 
predefined list, and all of your current collections are dismissed.

■ User Specified Collection

Choosing User Specified Collection allows you to select specific sets of metrics 
but limits the use of that data to trending of historical data since it results in an 
incomplete data set.

If you select Oracle Recommended Collection and begin collecting data, then 
instead choose User Specified Collection, you can add or modify other metrics 
for collection without disabling the collection of other metrics.

To collect performance reporting data, follow these steps:

Note: Use of the Oracle Recommended Collection is only 
provided when data collection is performed via an Oracle 9i Agent.
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1. Click on the target for which you want to collect performance data in the 
navigator panel of Capacity Planner.

2. Select the Collection Options tab on the property page for the target.

3. Click on the Oracle Recommended Collection to enable collection of 
performance metrics required for generating diagnostics and reports.

Scope of the Oracle Recommended Collection
When you select Oracle Recommended Collection as your collection option, 
Capacity Planner designates a predefined list of metrics for collection. If you have 
previously specified other metrics for collection, those metrics are disabled and only 
those metrics that are part of the Oracle specified template are selected.

Table 4–4 lists the charts and metrics that are enabled for collection when you 
choose Oracle Recommended Collection.

Table 4–4 Oracle Recommended Collection Metrics

Chart Metric

Instance Response Time % Wait Time

% CPU Time

Response Time per Trans

Transaction Count

Commit Count

Rollback Count

Response Time Per Execute

Execute Count

Instance Wait Events Wait Time

Count

Number Timeouts

Sessions Waiting on Events Count
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Instance Efficiency 
Statistics

Cursor Cache Hits

Buffer Cache Hit %

User Call %

Soft Parse %

% Parse CPU Time

% Recursive CPU Time

% Other CPU Time

Library Cache Hit %

Memory Sort %

Rows/Sort

Maximum Sort Allocation

Redo No Wait %

Latch %

Hard Parse/Execute %

Total Table Scans/Sec

% Shared Pool Free

Executes without Parses %

Commit %

Initialization Parameters DB_BLOCK_BUFFERS

BUFFER_POOL_KEEP

DB_BLOCK_LRU_LATCHES

BUFFER_POOL_RECYCLE

LOG_BUFFER

CURSOR_SPACE_FOR_TIME

SESSION_CACHED_CURSORS

OPEN_CURSORS

TIMED_STATISTICS

SORT_AREA_SIZE

SORT_AREA_RETAINED_SIZE

Table 4–4 Oracle Recommended Collection Metrics

Chart Metric



Collecting Data for Diagnostic Reporting

Introduction to Oracle Capacity Planner 4-29

File Statistics Physical Reads/Sec

Physical Writes/Sec

Physical Block Reads/Sec

Physical Block Writes/Sec

Read Time

Write Time

Average time/Read

Average time/Write

Physical Blocks/Reads

Physical Blocks/Writes

Instance I/O Statistics 
Data

Physical Reads/Sec

Physical Writes/Sec

Logical Reads/Sec

Blocks per Table Scan

Avg Free Buffers Scanned

Full Table Scan Rows ratio

Table Scans(Long)/Sec

Table Scans(Short)/Sec

Rows Fetched by RowID %

Table Scan Rows/Sec

Network Bytes/Sec

Summed Dirty Queue Length

Phys Reads Direct/Trans

Avg Dirty Queue Length

Dirty Buffers per Free Req

Block Changes/Sec

Cons. Changes/Sec

Physical  Reads/Trans

Physical Writes/Trans

Physical Writes/Trans

Table 4–4 Oracle Recommended Collection Metrics

Chart Metric
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Instance I/O Statistics 
Data (cont.)

Logical Reads/Trans

Table Scans(Long)/Trans

Table Scans(Short)/Trans

Table Scan Rows/Trans

Block Changes/Trans

Cons. Changes/Trans

Network Bytes/Trans

Phys Reads Direct/Sec

Phy Reads Direct/Trans

Redo Size/Sec

Redo Size/Trans

Phys Writes Direct/Txn

Redo Writes/Trans

Fast Full Index Scans/Sec

Fast Full Index Scans/Sec

Fast Full Index Scans/Trans

Instance Statistics Per Sec. Free Buff Inspected/Sec

Free Buff Requested/Sec

Dirty Buff Inspected/Sec

Parses/Sec

Hard Parses/Sec

Executes/Sec

Cursor Cache Count/Sec

Cursor Cache Hits/Sec

Cons. Gets/Sec

Buffer is pinned/Sec

Buffer is not pinned/Sec

User Calls/Sec

Recursive Calls/Sec

Logons/Sec

Table 4–4 Oracle Recommended Collection Metrics

Chart Metric
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Instance Statistics Per Sec. 
(cont.)

Disk Sorts/Sec

Memory Sorts/Sec

Sort Rows/Sec

Enqeue Waits/Sec

Block Gets/Sec

Block Changes/Sec

Cons. Changes/Sec

Rollbacks/Sec

Commits/Sec

Long Table Scans/Sec

Short Table Scans/Sec

Physical Reads/Sec

Physical Writes/Sec

Session Logical Reads/Sec

Transactions/Sec

Instance Statistics Per 
Transaction

Free Buff Inspected/Trans

Free Buff Requested/Trans

Dirty Buff Inspected/Trans

Parses/Trans

Harde Parses/Trans

Executes Trans

Cursor Cache Count/Trans

Cursor Cache Hit/Trans

Cons. Gets/Trans

Buffer is pinned/Trans

User Calls/Trans

Recursive Calls/Trans

Logons/Trans

Disk Sorts/Trans

Memory Sorts/Trans

Table 4–4 Oracle Recommended Collection Metrics

Chart Metric
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Instance Statistics Per 
Transaction (cont.)

Sort Rows/Trans

Enqueue Waits/Trans

Block Gets/Trans

Block Changes/Trans

Cons. Changes/Trans

Rollbacks/Trans

Commits/Trans

Long Table Scans/Trans

Short Table Scans/Trans

Redo Size/Trans

Physical Reads/Trans

Physical Writes/Trans

SessionLogical Reads/Trans

Total Table Scans/Trans

Shared Pool Free Memory Size

Rsvd list Request Misses

Rsvd list Request Failures

Shared Pool Size

Shared Pool Rsvd Size

Session UGA Size

Session UGA Max Memory

Rsvd List Alloc Hit %

Java Pool Size

DB Block Buffers Size

Log Buffer Size

Fixed SGA Size

% Shared Pool Free

Table 4–4 Oracle Recommended Collection Metrics

Chart Metric



Collecting Data for Diagnostic Reporting

Introduction to Oracle Capacity Planner 4-33

Data Dictionary Detail Entries in Cache

Misses/Sec

Valid Entries

Gets/Sec

Scans/Sec

ScanMisses/Sec

ScanCompletes/Sec

Modifications/Sec

Flushes/Sec

DLM_Requests/Sec

DLM_Conflicts/Sec

DLM_Releases/Sec

DBWR Statistics DBWR Make Free Requests

DBWR Free Buffers Found

DBWR LRU Scans

DBWR Summed Scan Depth

DBWR Buffers Scanned

DBWR Checkpoints

Redo Statistics Average Redo Write Size

Redo Entries/Sec

Redo Log Space Req/Sec

Redo Synch Writes/Sec

Redo Blocks Written/Sec

Redo Writes/Sec

Redo Size/Sec

Redo Allocation Retries

Rollback Statistics Rollback Nowait %

Table 4–4 Oracle Recommended Collection Metrics

Chart Metric
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Collecting for Performance Reporting
You can enable the collection of all performance reporting data in Capacity Planner 
through the Performance Reporting Data page. When you select a database as a 
target and you use an Oracle 9i Agent, you can select Performance Reporting in the 
Navigator for that database to display the Performance Reporting Data page. You 
can then choose from one of three options:

■ Enable Collection of All Performance Reporting Data

When you select Enable Collection of All Performance Reporting Data, the 
collection of all critical performance metrics is initiated which allows for the 
generation of comprehensive reports about the performance of the database.

■ Enable Collection of All Performance Reporting Data Excluding SQL

Rollback Segment Header Gets/Sec

Header Waits/Sec

Rollback Nowait %

Active Transactions

Shrinks/Sec

Wraps/Sec

Extends/Sec

Status

Waits Logical Reads ratio

Size

Writes

OptSize

HWMSize

AveShrink

AveActive

Extents

Session Activity Counts Count

Performance Reporting N/A

Table 4–4 Oracle Recommended Collection Metrics

Chart Metric
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When you select Enable Collection of All Performance Reporting Data 
Excluding SQL, all of the same metrics collected in the first option are collected 
with the exception of SQL information. This provides for a significantly shorter 
but still comprehensive report by eliminating the expansive and data intensive 
information found in the SQL cache.

■ Disable Collection of All Performance Reporting Data

When you select Disable Collection of All Performance Reporting Data, you 
disable the collection of all critical performance metrics. You will no longer be 
able to produce comprehensive performance reports with this option selected, 
however, you can continue to collect other historical data to create charts and 
perform trending.

If you selected the Oracle Recommended Collection as the option for collections for 
the database, Performance Reporting is automatically turned on as part of the 
template of metrics activated by the Oracle Recommended Collection.

Analyzing Collected Data
After collected data is loaded into the Oracle Capacity Planner historical database, 
you can perform a variety of analyses on it. To access the analysis features of Oracle 
Capacity Planner, click the Analysis tab (Figure 4–5) at the bottom of the Oracle 
Capacity Planner navigator tree view.  This displays the Oracle Capacity Planner 
analysis view.

Figure 4–5 Clicking the Analysis Tab

Connecting to an Oracle Capacity Planner Historical Database
When you expand the Historical Database folder at the root of the navigator tree in 
analysis view, you are prompted for the logon credentials for an Oracle Capacity 
Planner historical database.  
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After you connect to a historical database, the folder expands to show the targets for 
which data is available in that historical database.

If you store data in multiple historical databases, you must disconnect from one 
historical database before you can connect to a different historical database.  

To disconnect from the current historical database, 

1. Click the Historical Database folder at the root of the navigator tree.

2. Click the Disconnect button in the Capacity Planner toolbar panel.

To connect to a different historical database, expand the Historical Database folder 
again and enter the credentials for the new historical database in the resulting logon 
dialog box.

Organization of Data in the Navigator
When you expand a target in the navigator under the Historical Database folder, 
two forms of data are displayed below the target:

■ Classes of data

The classes displayed for the target are the collection classes for which data is 
available in the Oracle Capacity Planner historical database.  You can select and 
view data from these classes by selecting a class in the navigator, specifying the 
selection criteria, and then clicking Show New Chart.  These operations are the 
first step in creating an analysis.

■ Analyses

Below each target in the navigator is an Analyses folder, which contains 
predefined and user-defined analyses.  Predefined analyses are provided for 
some targets. You can create user-defined analyses by selecting a class of data, 
displaying an analysis of the data, and then saving the analysis.  You can also 
create a user-defined analysis by using an existing analysis as a template, 
making modifications to the analysis, and then saving the analysis under a new 
name.
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Browsing the Collected Data
To browse the collected data for a particular target:

1. In analysis view, expand the Historical Database folder.

You are prompted for the credentials for the historical database that contains 
the collected data that you want to analyze.

2. Enter your logon credentials and connect to the historical database.

3. On the navigator panel, expand the folder for the target whose collected data 
you want to analyze.  

The navigator displays the:

■ Names of the classes for which collected data exists in the historical 
database for the target

■ An Analyses folder, which contains predefined and user-defined analyses 
you created for the target

■ For database targets, a User-Defined Classes folder for any data collected 
from user-defined classes you created in collection view.

Viewing an Analysis for a Class of Data
To view an analysis chart for a selected class of data:

1. On the navigator panel, click the name of a class whose collected data you want 
to analyze.

Capacity Planner displays the property page for the class (Figure 4–6).

2. To specify the selection criteria for the class of data you want to analyze, see 
"Specifying Selection Criteria for a Class of Data" on page 4-38 for instructions.

3. Click Show New Chart.

Capacity Planner displays the Analysis window, which contains two or more 
pages.  The Chart page displays the chart.  The remaining pages are Details 
pages.  A separate Details page exists for each class from which one or more 
data items are included in the analysis.  

For information about the Analysis window, choose Window from the Analysis 
window Help menu.  For information about modifying the analysis or 
changing the way the data is displayed, see "Working with Analyses"  on 
page 4-42.
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Saving a Class Analysis as a User-Defined Analysis
After you view an analysis for a class of data, you can save it as a user-defined 
analysis to view later.

To save the analysis:

1. While viewing the analysis chart, click Save Chart on the analysis window 
toolbar.

2. Click Yes in the message box.

Performance Manager places the new user-defined analysis in the Analyses 
folder of the navigator panel.

Figure 4–6 Oracle Capacity Planner Analysis View

Specifying Selection Criteria for a Class of Data
When you select a class in the navigator panel in analysis view, Capacity Planner 
displays a property sheet that contains options available for selecting data from the 
Oracle Capacity Planner historical database for that class.

Before you display a chart of the collected data you must:
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1. Select the time aggregation level from the Time Aggregation drop-down list.

For example, select Hours if you want to analyze hourly data, Days if you want 
to analyze daily data, and so on.

2. In the Data Sources section, select one or more data sources whose data items 
you want to analyze.  

3. In the Data Items section, select one or more data items you want to analyze.  

A check mark appears next to each data item that is selected for analysis.

After you specify the selection criteria, there are two ways to display the data in an 
analysis chart:

■  To add the selected data to a new analysis chart, click Show New Chart, 
which displays the new chart. 

■ To add the selected data to an analysis chart that is already displayed in the 
Analysis window, click Add to Chart, then in the Add Data to Analysis 
dialog box, select the name of the previously-displayed analysis chart. Note 
that only charts that are currently opened are displayed in the Add Data to 
Analysis dialog box.

Viewing and Modifying User-Defined and Predefined Analyses
You can view and modify both user-defined and predefined analyses.  However, 
once modifications are made to a predefined analysis, the only way to save those 
changes is to save the analysis to a new name.  This creates a new user-defined 
analysis and preserves the original predefined analysis.

To view an existing analysis, which makes it available for modification, follow these 
steps:

1. Expand the Analysis folder for the target, which displays the existing 
predefined and user-defined analyses for the target.

A bar chart icon identifies a predefined analysis. Not all targets provide 
predefined analyses.

A bar chart and person icon identifies a user-defined analysis. You create a 
user-defined analysis by displaying an analysis for a class of data or displaying 
a predefined analysis, and then saving the analysis.

Note: Not all targets provide predefined analyses.
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2. Select a predefined analysis or user-defined analysis in the navigator panel. 

The Analysis Summary property page for the selected analysis is displayed in 
the detail panel.  This property page displays the names of the targets and 
classes whose data is used in the analysis.

3. To view the data sources and data items in the analysis, click the plus sign (+) 
next to the target icons in the Service/Source column.

4. To view the chart for the analysis, click Show.  

Note that if you are opening a predefined analysis, Capacity Planner displays 
the Select Data Sources for Analysis dialog box.  Predefined analyses are 
provided for some targets. Predefined analyses require you to specify the 
available data sources for your installation.  Select the data sources you want to 
include in the predefined analysis and click OK.

After you have opened an analysis, you can modify the contents and how they are 
presented.  See "Working with Analyses" on page 4-42 for more information.

You can also create a copy of an analysis, rename an analysis, or delete an analysis, 
as explained in the next three sections.

Creating a Copy of an Analysis
You can create an analysis that is an exact copy of an existing analysis, but the copy 
has a different name.  To do this:

1. In analysis view, locate and expand the target that contains the analysis you 
want to copy.

2. Expand the Analyses folder.

3. Select the analysis you want to copy.

4. On the Analysis menu, choose Create Like.

Note: You can limit the list of displayed analyses to only 
user-defined analyses by removing the check mark from the View 
Predefined Analyses option on the Analysis menu.  When you 
choose the View Predefined Analyses option on the Analysis 
menu again, the check mark preceding the menu option is replaced, 
and predefined analyses are displayed again.
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5. In the Create Analysis Like dialog box, enter a unique name for the new 
analysis that you are creating and click OK.

Capacity Planner creates the new copy of the analysis in the Analyses folder for 
the target.

Renaming a User-Defined Analysis
 

To rename a user-defined chart:

1. In analysis view, locate and expand the target that contains the analysis you 
want to rename.

2. Expand the Analyses folder.

3. Select the user-defined analysis you want to rename.

A bar-chart-and-person icon identifies user-defined analyses.

4. On the Analysis menu, choose Rename.

5. In the Rename Analysis dialog box, enter a unique name for the analysis you 
are renaming and click OK.

Deleting a User-Defined Analysis

To delete a user-defined analysis:

1. In analysis view, locate and expand the target that contains the analysis you 
want to delete.

Note: You cannot rename a predefined analysis.  This restriction 
ensures that the original predefined analysis charts are not 
overwritten.

However, after you make changes to a predefined analysis, you can 
save the modified version of the predefined analysis as a 
user-defined chart with a new name.  For more information, see 
"Saving the Results of a Predefined Analysis" on page 4-50.

Note: You cannot delete a predefined analysis.
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2. Expand the Analyses folder.  

A bar-chart-and-person icon identifies the user-defined analyses in the folder.

3. Select the user-defined analysis that you want to delete.

4. On the Analysis menu, choose Delete.

5. In the message dialog box that prompts you to confirm the deletion, click OK.

Working with Analyses
After you have opened an analysis chart, either by selecting and showing an 
existing analysis or by browsing collected data to create a new analysis, the data 
included in that analysis is shown in the Oracle Capacity Planner Analysis window.

The Analysis window contains two or more pages.  The first page is called the Chart 
page and it displays the analysis chart.  The remaining page or pages are Details 
pages.  A separate Details page exists for each class from which one or more data 
items are included in the analysis.  Each Details page shows the:

■ Data sources for the data items plotted in the chart

■ Time aggregation level of the plotted data items

■ Value of each plotted data item each time the data item was collected during the 
time range for the analysis

The time range for the collected data appears along the bottom of each chart, with 
the beginning of the time range at the left and the end of the time range at the right.

Two types of lines can appear on a chart.  Each solid line plots the values of a 
selected data item during the specified time range.  Each dashed line plots the result 
of a trend analysis to time or trend analysis to value.  See "What Is a Trend 
Analysis?" on page 4-47 for more information about performing a trend analysis.

The rest of this section describes other features of the Analysis window.

Viewing the Value of a Data Point
To view the value for a data point (that is, one plotted point of a data item) on a line 
in an analysis chart, position the cursor over the data point.  If there is a point 
beneath the cursor, Capacity Planner displays the date, time, and value for that data 
point displays in a box above the point (see Figure 4–7).
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Figure 4–7 Viewing the Value of a Data Point

Selecting a Line
When you view an analysis chart, you can perform certain operations after selecting 
a line in the chart.  Most of the available operations are started by clicking a toolbar 
button on the analysis window after a chart line is selected.  

To select a line, click a data point on the line. When a line is selected, the description 
of the line is displayed in the status bar at the bottom of the window, and the 
appropriate toolbar buttons are enabled.

Operations available from the toolbar are also available on a context menu.  To 
display the context menu, click the right mouse button on a data point in a line in 
the analysis chart.

To be sure which line is currently selected (before clicking a toolbar button), read 
the description of the line in the status bar.

Adding a Class of Data to an Analysis
After you open an analysis, you may want to add data from other classes to the 
analysis. You can use this feature to compare two different classes of data.

To add a class of data to an analysis that is currently displayed in the Analysis 
window:

1. Confirm that Capacity Planner is in analysis view.

2. Select from the navigator the class of data that you want to add.

3. Specify the selection criteria (as described in "Specifying Selection Criteria for a 
Class of Data" on page 4-38) for the class.

4. Click Add to Chart.

5. In the Add Data to Analysis dialog box, select the name of the chart to which 
you want to add the data.
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You can add data items from multiple classes to an analysis, and you can select 
different aggregation levels and date ranges for each class.  

However, data items within a single class must share the same aggregation level 
and date range.  If you try to add additional data items from the same class to an 
existing chart, you will receive a prompt, warning that the chart already contains 
data from this class.  If you click OK, Capacity Planner will overwrite the chart with 
the currently selected data, aggregation levels, and date range.

Modifying Selection Criteria from the Analysis Window
From the analysis window, you can modify the selection criteria associated with any 
of the classes of data included in the analysis. Modify the selection criteria using 
one of these methods:

■ Select a line in the analysis chart and click the Select Items toolbar button.

■ Click the right mouse button on a data point in the line and choose Select Items 
from the context menu.

■ Click the Data tab in the analysis window (as opposed to the Chart tab) and 
click the Select Items toolbar button.

These actions display the Select Items dialog box, which contains the property sheet 
for the class of data associated with the selected line.  This property sheet contains 
the selection criteria for that class of data, which you can modify and apply to the 
current analysis. See "Specifying Selection Criteria for a Class of Data" on page 4-38 
for more information.

After you modify selection criteria, you can click either Apply or OK on the 
Analysis Options dialog box.  If you click Apply, the changes made to the selection 
criteria are applied to the analysis and the updated analysis is shown.  The Select 
Items dialog box remains displayed, and you can make other modifications to the 
same selection criteria, if you want.  If you click OK, Capacity Planner applies the 
modifications to the analysis and closes the Select Items dialog box.

Removing a Line from a Chart
You can remove a line from an analysis chart by either of these methods:

■ Select the line by clicking the right mouse button, then choose Remove Line 
from the context menu.

■ Select the line, then click the Remove Line button on the analysis window 
toolbar.
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These actions remove the data for the selected data item from the chart, but not 
from the historical database.

Excluding a Data Point from a Chart
You can exclude a data point (that is, one plotted point of a data item) from a chart. 
To exclude a data point, click the right mouse button on the data point and choose 
Exclude Point from the context menu.

Excluding a data point is useful if you know that the value of a particular data point 
is skewed.  For example, if you know that a particular CPU-intensive program was 
not run at the usual time, you can remove the value for the % Processor Time data 
item for that time from the chart.  The selected data point is removed from the chart, 
but the data for the data point is not removed from the historical database.

After you exclude one or more data points from a line, a red X appears in the status 
bar when you select the line.  

To later redisplay excluded data points for a selected line, click View Exclusions on 
the Analysis window toolbar, or click the right mouse button on the line and select 
View Exclusions  from the context menu.

These actions display the Data Point Exclusions dialog box, which displays the 
current list of excluded points for the selected line.  You can toggle the check mark 
for each data point in the list.  A check mark indicates that the data point is 
excluded from the analysis.  To display an excluded data point in the analysis again, 
clear the check mark.  

When you click OK, Capacity Planner closes the Data Point Exclusions dialog box 
and updates the chart to include the points removed from the list of exclusions.

Showing or Hiding the Chart Legend
You can control whether or not the legend is displayed in an analysis chart by 
toggling the Show/Hide Legend button on the analysis window toolbar.  When the 
legend is not shown, you can identify a line by clicking it, which displays the 
description of the line in the analysis window status bar.

Note: Data point exclusions are not saved with an analysis.
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Zooming and Scrolling to View More or Less Chart Data
Depending on the date range and the number of data items and data sources you 
are analyzing, you may want to zoom in, zoom out, or scroll the contents of the 
chart window.

To view more detail or less detail, click the Zoom In and Zoom Out buttons on the 
Analysis Chart window toolbar. You can also zoom in by pressing the Page Down 
key on your keyboard or the numeric 3 on your keypad, and you can zoom out by 
pressing the Page Up key or the numeric 9 on your keypad.

You can also zoom in on a very specific part of the chart by dragging a rectangle 
around the area you want to magnify (Figure 4–8). Release the mouse button to 
zoom in on the selected area. You can zoom back out by using the Zoom Out button 
Home or End key on your keyboard.

Figure 4–8 Zooming in on a Selected Area of the Chart

Often, the chart data will extend beyond the width of the Analysis Chart window.  
You can view the data that extends beyond the edges of the window by resizing the 
Analysis Chart window or by scrolling to the right or left.

To scroll the Analysis chart window:

1. Press and drag the pointer on the black scroll bar below the chart (Figure 4–9).

2. When the portion of the chart you want to view is displayed in the Analysis 
Chart window, release the mouse button.

Optionally, you can use the arrow keys on your keyboard to scroll left and right. 
Press the left arrow to scroll left and the right arrow to scroll right. If you experience 
a conflict with the Tab function using the left and right arrow keys, you can use the 
up and down arrow keys on your keyboard to scroll. Press the up arrow to scroll 
left (or the numeric 8 on your keypad), or the down arrow key to scroll right (or the 
numeric 2 on your keypad). 
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Figure 4–9 Scroll Bar in the Analysis Chart Window

Auto-Scaling Data
If an analysis contains data from different classes where the scale of the data is 
significantly different, you may want to apply scaling to the data.  Scaling 
normalizes the data so that all lines have a maximum value of no greater than 100.  
Very large data items are scaled down, and very small data items are scaled up.

To apply scaling, click Toggle Auto Scaling on the analysis window toolbar.  When 
scaling is applied to a chart, data lines with very different scales may be visually 
correlated.  When scaling is enabled, Capacity Planner displays the label Scaled 
Data along the Y-axis of the chart. If you select a line from the chart by clicking it, 
the scaling factor for that line is included in the status bar.

What Is a Trend Analysis?
A trend analysis infers or estimates future values by projecting and extending 
known values.  Oracle Capacity Planner can perform the following types of trend 
analyses:

■ Trend analysis to a point in time 

In a trend analysis to a point in time, you provide a goal time for a data item. 
Oracle Capacity Planner uses the specified values in the historical database to 
project the value of the data item at the goal time.

A trend analysis to a point in time is used to answer questions such as, "How 
full will this disk be at the end of the year?"

■ Trend analysis to a value 

In a trend analysis to a value, you provide a goal value for a data item.  Oracle 
Capacity Planner uses the specified values in the historical database to project 
the time at which the data item will reach the goal value.
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A trend analysis to a value is used to answer questions such as, "When will our 
CPU utilization reach 95 percent?"

As the default, the Capacity Planner Trend Analysis wizard uses the critical 
threshold for the metric (if one is defined) when you perform a trend to a value.

Specifying and Performing a Trend Analysis
To specify and perform a trend analysis, follow these steps:

1. In the Analysis window, either:

■ Select a line by clicking a data point in the line, then click the Trend 
Analysis Wizard button on the toolbar.

■ Click the right mouse button on a data point in a line, then select Trend 
Analysis Wizard from the context menu.

Both of these methods display the Trend Analysis Wizard.

2. Capacity Planner displays the Trend Analysis Wizard Welcome panel that 
identifies the selected data on which you can conduct the trend analysis. You 
can click on the option box that prevents the Welcome screen from displaying in 
subsequent uses of the wizard. Click on Next to move to the next wizard panel.

3. In the Date Range panel, select a date range to use as a basis for the trend 
analysis:

■ Click Use only the visible date range (as currently zoomed in the chart) to 
use the range of dates currently visible in the analysis chart window (not 
including any data that extends beyond the edge of the chart window).  

This option is enabled only if you zoomed in to see more detail in the chart. 
For more information, see "Zooming and Scrolling to View More or Less 
Chart Data"  on page 4-46.

■ Click Use the date range selected for the chart to use the date range 
currently used for all the data in the chart (even data that extends beyond 
the edge of the chart window).  

■ Click Select a new chart range to select a different date range . You can 
designate either a recent period of time by choosing Use a recent period of 
time and then selecting the time increment and number of units of time to 
use, or you can specify a new start and end time by choosing Use a new 
start and end time.

■ Click on Next to move to the next wizard panel.
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4. In the Trend Analysis Type panel of the wizard, specify which type of trend 
analysis you want to perform.

■ To perform a trend analysis to a value, click the Estimate when the data 
item will reach the following value: and enter the numeric value for which 
you wish to determine the date and time.

■ To perform a trend analysis to a future date and time, click Estimate what 
the value of the data item will be at the following date: and enter the time 
and date for which you wish to determine a value.

■ Click on Next to move to the next wizard panel.

5. The Summary panel displays the results of the trend analysis. Click on Finish  
to add the trend line to the chart. 

6. Choose Customize Annotation from the View menu to display the Annotate 
Trend dialog box and make changes to the annotation. Optionally, you can right 
mouse button click on the annotation created by the Trend Analysis wizard and 
then choose Customize Annotation from the context menu. 

Use the Annotate Trend dialog box to specify whether Capacity Planner will 
annotate the trend analysis (see Figure 4–10) and the appearance of the trend 
analysis line in the chart window. If you need information about the fields in 
the Annotate Trend dialog box, click Help.

Figure 4–10 Annotation for a Trend Analysis

7. Click OK to close the Annotate Trend dialog box.

Note: To move the annotation box in an analysis chart, click the 
box, hold the mouse button down, then move the mouse to a 
different position on the chart.  Release the mouse button when you 
have reached the position in the chart where you want the 
annotation box displayed.
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Saving Changes to a User-Defined or Predefined Analysis
You can save the changes you make to an analysis.  Oracle Capacity Planner can 
determine if you are saving a user-defined analysis or a predefined analysis.  The 
steps for saving your changes differ, depending on the type of analysis.

Saving the Results of a User-Defined Analysis
To save changes to a user-defined analysis:

1. While viewing the analysis, click Save Chart on the analysis window toolbar.

2. Click Yes in the message box.

Your changes are saved to in the Analysis folder for the selected target using the 
current name of the analysis or data class.  To save the analysis under a different 
name, choose Save As from the Analysis window File menu.

Saving the Results of a Predefined Analysis
If you modify a predefined analysis, you must provide a new name for the analysis 
when you save the results of the analysis.  When you do this, you create a new 
user-defined analysis.  Saving the analysis with a new name ensures that the 
original predefined analysis is not overwritten.

To save the results of a predefined analysis:

1. While viewing the analysis, click Save Chart on the analysis window toolbar.

2. Click Yes in the dialog box that is displayed.

3. In the Save Analysis As dialog box, type a unique name for the user-defined 
analysis that will be created.

4. Click OK in the Save Analysis As dialog box.

Capacity Planner places the new user-defined chart in the Analyses folder of 
the navigator panel.

Printing an Analysis Chart
To print an analysis chart, click the Print Chart button in the Analysis Chart toolbar 
while the chart is displayed.

The size of the chart on the screen determines the size of the chart in the chart 
printout. For example, when you print a chart that is 5 inches high and 7 inches 
wide on your screen, the chart will be 5 inches high and 7 inches wide in the 
printout.
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Generating a Report for an Analysis Chart
To generate an HTML report for an analysis chart:

1. Click the Report Chart button while the chart is displayed.

Capacity Planner displays a dialog box that tells you the name of the HTML file 
used to display the report and where the file will be saved. 

2. Make a note of the file name and location.

3. Click Yes to preview the chart in your Web browser, or click No if you do not 
want to preview the report.

You can view the report later using a Web browser, or—if you have experience with 
Web publishing tools and techniques—you can share the report with your 
co-workers by publishing the HTML file and its associated graphic files on a Web 
server. 

Understanding the Oracle Capacity Planner Historical Database
The logical structure of the Oracle Capacity Planner historical database schema was 
designed to facilitate querying of capacity planning data by tools other than Oracle 
Capacity Planner, such as Microsoft Excel.  This section contains a brief description 
of the design of the Oracle Capacity Planner historical database schema.  It is not 
intended to be a comprehensive description of all tables and columns in the schema.

Understanding the Service Reference Table (vp_service_ref)
The service reference table contains a list of all targets for which data has been 
stored in the Oracle Capacity Planner historical database.  The HOST column 
contains the name of the host where the Agent that loaded data for the specified 
target (the NAME column) is located.  The SVC_ID column is a column used for 
lookup into the class reference table, described in the following paragraph.

Caution: Performing any modification to the Oracle Capacity 
Planner historical database schema (tables, columns, or indexes) or 
to the data itself is not recommended and is not supported.  Such 
modifications may render your Oracle Capacity Planner historical 
database schema unusable as a target to load or retrieve capacity 
planning data.
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Understanding the Class Reference Table (vp_class_ref)
The class reference table contains a list of all collection classes for which data has 
been stored in the Oracle Capacity Planner historical database, for all targets.  To see 
the list of classes for a particular target, a query should look for the SVC_ID column 
equal to a SVC_ID value from the service reference table, described in the previous 
paragraph.  Such a query would produce a list of all classes for which data exists in 
the database for a particular target.

Understanding the Data Tables
Each class of data in the class reference table has six data tables that contain the data 
for that collection class.  Each table contains data for a particular time aggregate, for 
example, hours, days, weeks, months, and years.  The base table contains the raw 
data as it is collected at the collection frequency.  Therefore, the base table does not 
contain any statistical aggregations.  The aggregate tables contain aggregate 
statistics for each data item collected for that class.

Data Table Names
Data tables are named according to the first four columns of the class reference table 
(in reverse order) plus the aggregate.  Example 4–1 shows an entry for a collection 
class in the class reference table.

Example 4–1 Collection Class Entry in the Class Reference Table

CLS_ID      MOD_ID     SVC_ID     IS_UDS      CONTAINER_CLASS_LABEL
---------- ---------- ---------- ---------- -------------------------------
         8          2          2          0 I/O

The collection class in Example 4–1 would have the data tables shown in 
Example 4–2.

Example 4–2 Data Tables for a Collection Class

VP_0_2_2_8_BASE
VP_0_2_2_8_HOUR
VP_0_2_2_8_DAY
VP_0_2_2_8_WEEK
VP_0_2_2_8_MONTH
VP_0_2_2_8_YEAR
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Data Table Contents
The first two columns of each data table are always the Timestamp column and the 
Data Source Name column.  The Data Source Name column is essentially the class 
name, for example, Logical Disk. In aggregate tables (tables other than BASE), the 
third column is an accuracy calculation, which is not supported in this version of 
Oracle Capacity Planner.

All subsequent columns contain the values for the data items collected for that class, 
as they are actually named.  In aggregate tables, these columns are prefixed with a 
two-character abbreviation for the aggregation statistic that the column contains.  
Table 4–5 shows these abbreviations and their meanings.

These statistics are calculated for the set of data in that aggregate from the next 
lowest level.  For example, a row in the DAY aggregate table contains statistics 
calculated for all entries in the HOUR table for that day.

Table 4–5 Prefixes Used for Column Names in Aggregate Tables 

Prefix Meaning

AV Average

SM Sum

MN Minimum

MX Maximum

SD Standard deviation

VR Variance

CT Count
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5
Oracle e-Business Management Tools

The Oracle e-Business Management Tools (hereafter referred to as e-Business Tools) 
are a set of applications that enable centralized management of the complete 
e-Business infrastructure including the client, middle-tier HTTP servers, and 
database. The e-Business Tools provide a seamless monitoring, reporting, and 
diagnostics of the e-Business middle-tier HTTP servers.

The following HTTP server platforms are supported in Enterprise Manager release 
9.0.1:

■ Apache HTTP Server version 1.3.9 and higher

■ Oracle iAS version 1.0

Release 9.0.1 of the e-Business Tools focuses on operational management which 
includes the reporting on, and the monitoring of the HTTP servers. All the 
components are controlled from and fully integrated into the Enterprise Manager 
console.

Monitoring Features of the HTTP Servers
The monitoring features of the HTTP servers include:

■ Discovery

■ Real-time Monitoring

Discovering the HTTP Server
HTTP server targets are recognized on all nodes in the system. The supported 
HTTP server targets are the Apache HTTP server and the Oracle iAS HTTP Listener.
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Real-Time Monitoring of the HTTP Server
The middle-tier HTTP server I/O and HTTP server processes are monitored in real 
time. The e-Business Tools advanced event tests are provided for lights-out event 
monitoring and problem detection of the HTTP server. There are two types of event 
tests associated with the HTTP server:

■ UpDown event test

■ Threshold event tests

The HTTP Server UpDown event test checks whether the Apache HTTP server 
being monitored is running.

The threshold event tests are triggered by user-specified metrics. You can register 
events for the following metrics:

Table 5–1 HTTP Server Threshold Event Tests

Event Test Description

Bytes per Second This event test monitors the number of bytes transferred by the 
HTTP server per second. The rate is calculated depending on 
the frequency of the event. For example, if the event test was 
registered with a frequency of 100 seconds, the event test will 
calculate the rate by dividing the number of bytes served in 
that period by 100.

Requests per Second This event test monitors the number of requests made to the 
HTTP server per second. The rate is calculated depending on 
the frequency of the event. For example, if the event test was 
registered with a frequency of 100 seconds, the event test will 
calculate the rate by dividing the number of requests in that 
period by 100.

Total Servers This event test monitors the number of servers that the HTTP 
server has spawned to handle the incoming requests. The 
HTTP server increases the number of servers when there is a 
greater number of requests to handle and reduces the number 
of servers when there are fewer requests. This action 
maximizes the resource utilization on the system.

Note: On Windows NT, servers represent the number of 
threads while on UNIX systems a server correlates to a process.
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Reporting of HTTP Server Activity
The Apache Server Access Log Traffic report provides an overview of the daily, 
weekly, and monthly statistics of activity on the HTTP server. Data for this report is 
extracted from the Apache server log files and is viewed in HTML format.

The Apache server log files can be configured by the administrator to determine 
their refresh rate. The amount of data displayed in the report is dependent upon the 
amount of data in the log files.

Log Analysis Report Job Task
The Log Analysis Report job task analyzes the access log file for the HTTP server 
target and generates a report. The output is an HTML file that contains various 
statistics. See "Contents of Apache Server Access Log Traffic Report" for details of 
the report.

Contents of Apache Server Access Log Traffic Report
The Apache Server Access Log Traffic report is divided into the following 
sub-reports:

■ Monthly Activity Report

This report gives top level details that allow the administrator to view 
information about the monthly server activity.

■ Activity by Day of Week Report

The data for this report is cumulative and displayed by day of week (for 
example, Sunday, Monday, and so on) and represents the total amount of traffic 

Table 5–2 Monthly Activity Report 

Column Heading Description

Month Month for which the statistics are calculated

Year Year for which the statistics are calculated

Requests Total number of requests received by the server for the 
indicated month

Kbytes Total number of kilobytes served for the indicated month

Pages Total number of pages served for the indicated month
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on that server for each week day. Administrators can use this report to 
determine which day of the week receives the most traffic.

■ Activity by Hour of Day Report

This report displays the cumulative data that shows the amount of traffic on the 
server by hour of the day. Administrators can use this report to see which times 
of the day are their peak periods.

■ Daily Activity Report

This report shows the total amount of traffic on the server for a particular day. 
Information includes:

Table 5–3 Activity by Day of Week Report 

Column Heading Description

Day Day of the week for which the statistics are calculated

Requests Total number of requests received by the server for the day of 
week

Kbytes Total number of kilobytes served for the day of week

Pages Total number of pages served for the day of week

Table 5–4 Activity by Hour of Day Report

Column Heading Description

Hour Starts at midnight (00:00)

Requests Total number of requests received by the server for the hour

Kbytes Total number of kilobytes served for the indicated hour

Pages Total number of pages served for the indicated hour

Table 5–5 Daily Activity Report 

Column Heading Description

Date Date for the displayed statistics (by day of week, date, and 
year)

Requests Total number of requests received by the server for the 
indicated day

Kbytes Total number of kilobytes served for the indicated day
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Charts and Chart Groups
This section describes the HTTP Server charts and chart groups available in Oracle 
Performance Manager. Some of these charts provide the ability to perform 
administrative tasks, for example, server utilization.

The HTTP Server charts are divided into classes. The classes are:

■ Performance Overview

■ I/O 

■ Server Utilization

The following sections describe these classes and their associated charts and chart 
groups.

Performance Overview Class
The Performance Overview class provides chart groups that describe high-level 
activity. The chart groups and their associated charts are:

Pages Total number of pages served for the indicated day

Table 5–6 Performance Overview Class Chart Groups and Charts 

Chart Groups and Charts Description

HTTP Server at a Glance 
Chart Group

This chart group allows a server administrator to see how well 
the HTTP server is performing.

■ Requests per Second This chart shows the rate at which the HTTP server is serving 
requests.

■ Bytes per Second This chart shows the rate at which the HTTP server is serving 
data.

■ Bytes per Request This chart shows the average number of bytes served for a 
request.

■ Server Utilization This chart shows the relationship between busy and total 
available servers

I/O Chart Group This chart group shows an overview of important I/O 
activities.

Table 5–5 Daily Activity Report (Cont.)

Column Heading Description
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I/O Class
The I/O class provides charts that describe I/O activity. 

Server Utilization Class
The Server Utilization class provides charts that describe server activity.

■ Requests per Second This chart shows the rate at which the HTTP server is serving 
requests.

■ Bytes per Second This chart shows the rate at which the HTTP server is serving 
data.

Server Utilization Chart 
Group

This chart group shows an overview of important server 
utilization activities

■ Server Utilization This chart shows the relationship between busy and total 
available servers

Table 5–7 I/O Class Utilization Class Charts 

Chart Description

Total Kilobytes Served This chart shows the total amount of data the HTTP server has 
served since it was started.

Total Requests Served This chart shows the total number of requests the HTTP server 
has served since it was started.

Bytes per Second This chart shows the rate at which the HTTP server is serving 
data.

Requests per Second This chart shows the rate at which the HTTP server is serving 
requests.

Bytes per Request This chart shows the average number of bytes served for a 
request.

Table 5–8 Server Utilization Class Charts 

Chart Description

Busy Servers This chart shows how many servers are busy serving requests.

Idle Servers This chart shows how many servers are not busy serving 
requests.

Table 5–6 Performance Overview Class Chart Groups and Charts (Cont.)

Chart Groups and Charts Description
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Total Servers This chart shows how many servers are running.

Table 5–8 Server Utilization Class Charts (Cont.)

Chart Description
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6
Using Oracle TopSessions

This chapter discusses the following Oracle TopSessions topics:

■ Overview of Oracle TopSessions

■ Before You Use the Oracle TopSessions Chart

■ Displaying the TopSessions Chart

■ Overview of Session Activity

■ Viewing Details About a Given Session

■ Customizing the Session Information You Display

Overview of Oracle TopSessions
You can use Performance Manager to assist you in identifying performance 
bottlenecks within your system and database environment. The TopSessions chart 
displays database sessions that are contributing most heavily to database activity. 
You can display various details for these sessions, including the SQL statements, 
and resource usage.

You can obtain an overview of session activity by displaying the top sessions sorted 
by a statistic of your choosing. For any given session you can then drill down for 
more detail, or if you choose, you can terminate the session using the Kill Session 
option.

The TopSessions chart provides a methodology for identifying and correcting 
certain database performance problems. For example, when sudden file I/O load is 
detected, you can first identify the sessions contributing most to the problem and 
then isolate the executing SQL statements in user applications for those sessions. 
You can then analyze the SQL explain plans for those SQL statements to determine 
how best to resolve the problem.
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Once populated with data, the TopSessions chart includes a multi-column list of 
summary information for each session connected to the database instance or for 
each of the top n sessions as measured by the selected sort statistic.

You can also access the TopSessions chart from the Enterprise Manager console by 
selecting TopSessions from the Diagnostics Pack tool drawer. You can access 
information about individual sessions via drill downs from this chart.

The TopSessions chart displays the sessions sorted by the statistic specified on the 
Options tab of the TopSessions property sheet. By using the Set Options button in 
the toolbar the chart can be customized to show only the items of interest and the 
sort criteria can be changed. You can specify the number of sessions to display on 
the Options tab as well. See "Customizing the Session Information You Display"  on 
page 6-15 for more information about customizing the TopSessions display.

You can re-sort the sessions by clicking on the statistic column you want to use as 
the sort criterion. Clicking on the column header toggles the sort order in 
descending or ascending order. This changes only the display sort order and has no 
effect on the top "n" sorting/reduction done by selecting the sort item in the 
Options page.

The File, View, Collection, Tools and Help menus are the same as those in the chart 
window for Performance Manager. The Drilldown menu is customized to reflect 
some of the tasks specific to TopSessions.

Before You Use the Oracle TopSessions Chart
Before you can use the TopSessions chart on pre-Oracle 9i databases, you must first 
run a SQL script that defines the OEM_MONITOR role which contains all the 
privileges required to use the Diagnostics Pack products.  Granting the 
OEM_MONITOR role is the best way to ensure that a user has the correct privileges 
to use the TopSessions functions. The OEM_MONITOR role has been granted more 
privileges in the 9i version that help to provide better functionality and 
performance.

For 9i databases, the SQL script, catsnmp.sql, is run by default as part of the 9i 
database creation process. For all versions of the database prior to 9i, you must 
manually run a SQL script to define the OEM_MONITOR role and create the 
necessary views.

For versions 8.1.5, 8.1.6, and 8.1.7 of the database, you must run the script 
catsnmp_8i.sql. For versions 8.0.5 and 8.0.6 of the database, you must run the script 
catsnmp_80.sql. For version 7.3.4 of the database, you must run script 
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catsnmp_734.sql. The selected script must be executed by a user with SYS 
privileges.

The sql files are located in the Oracle home of the Oracle Enterprise Manager 
installation, $ORACLE_HOME/SYSMAN/ADMIN. You must run the appropriate 
version of the SQL script manually on all pre-9i databases.

The OEM_MONITOR role must be granted to any user wishing to use the Oracle 
Diagnostics Pack. Performance Manager does not require any of these new views in 
order to run, but if you attach to a database that does not have the views, or your 
process does not have the required privileges, or the OEM_MONITOR role  does 
not exist, then an informational message displays.

Displaying the TopSessions Chart
You can display the TopSessions chart from the Oracle Enterprise Manager console, 
from the Start menu, or from within Performance Manager. 

Displaying the TopSessions Chart from the Console
You can display the TopSessions chart from the Oracle Enterprise Manager console 
in any of the following ways:

■ On the Oracle Enterprise Manager console, point to the Diagnostics Pack 
drawer, then click TopSessions.

■ On the Tools menu of the Oracle Enterprise Manager console, point to 
Diagnostics Pack, then click TopSessions.

■ Click the right mouse button on the target node for which you want to display 
the TopSessions chart and then choose TopSessions from the Related Tools 
menu item on the context menu.

Starting TopSessions from the Start Menu
On the Start menu, follow the path: Start=>Programs=>
ORACLE - $Oracle _Home=>Diagnostics Pack=>TopSessions.

Note: ORACLE_HOME represents the home directory in which 
the Diagnostics Pack is installed.
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When you launch TopSessions from the Start menu, a database logon dialog box 
appears. By default, you are connected to the database via Direct Connect, allowing 
the application to run in Standalone mode. You can change the connection details 
from the logon dialog to connect to an OMS if you choose. 

Displaying TopSessions in Performance Manager
You can display the TopSessions chart from within Performance Manager by 
following these steps:

1. Point to the database for which you want to display TopSessions in the  
Performance Manager navigator and then choose TopSessions from the list of 
available charts.

The Data Tab appears in the right-side pane.

2. Choose the data sources from the list that appears in the top panel of the Data 
Tab.

3. Select the collection types you want to display from the list at the bottom panel 
of the Data Tab.

4. To filter the sessions you want to display, click on the Session Filtering Tab. 
Filtering allows you to reduce the number of sessions returned by specifying 
criteria that a session must meet in order to be considered part of the sample 
set. For more information about the Session Filtering function, see "Session 
Filtering Options Page" on page 6-17.

5. To limit the number of data sources and to set the sort order for the chart, click 
on the Options Tab.

6. To display the TopSessions chart, click on the Show Chart button at the bottom 
of the panel.

7. To record the chart activity, click on the Record Chart button at the bottom of 
the panel to bring up the Recording Parameters dialog box.

By default, the top n sessions in the main display are sorted by the session logical 
reads statistic. If you want to change the sort statistic and/or the statistic filter, 
choose Options on the Session menu. This displays the Options property sheet, on 
which you can customize the session information displayed in the main display. See 
"Customizing the Session Information You Display" on page 6-15 for more 
information about using the Options property sheet.

Figure 6–1  shows the Oracle TopSessions chart.
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Figure 6–1 Oracle TopSessions Chart

As Figure 6–1  shows, the Oracle TopSessions chart includes the following 
components:

■ Menu bar

■ Toolbar

The following sections describe each of these components.

Oracle TopSessions Menu Bar
The menu bar of the Oracle TopSessions chart includes the following pull-down 
menus:

■ File

■ View

■ Collection

■ Drilldown

■ Help
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File Menu
The File menu on the Charts display window has the following options:

■ Print Screen

Prints the displayed TopSessions chart.

■ Report Chart

Generates a report for the TopSessions chart. When you click the Report Chart 
button, Performance Manager creates a TopSessions chart report in HTML 
format and saves it for you. You can also preview the report by displaying it in 
your Web browser.

■ Close

Closes the displayed TopSessions chart.

View Menu
The View menu on the Charts display window has the following options:

■ Table

Changes the current display to a table chart. Table charts present text 
information, or a large number of instances, in a format that is easy to review.

■ Horizontal Orientation

Changes the chart orientation to horizontal.

■ Vertical Orientation

Changes the chart orientation to vertical.

Collection Menu
The Collection menu on the Charts display window has the following options:

■ Pause Chart/Resume Chart

Allows you to stop or resume collections for the chart displayed in the chart 
window.

■ Refresh Rate

This option lets you set the amount of elapsed time between data samples. The 
maximum interval is one day and the minimum is one second.

Choose one or all of the following:
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■ Hours - maximum is 23 hours

■ Minutes - maximum is 59 minutes

■ Seconds - maximum is 59 seconds

■ Options

Displays the Options property sheet, from which you can specify the sorting 
criterion, the refresh mechanism, and the number of entries for statistics 
displayed in the Oracle TopSessions main window. 

Drilldown Menu
The Drilldown menu shows the same items available from the Performance 
Manager chart window as well as available drilldowns for the selected sessions. The 
drilldowns available depend on the tools available on your system.  If you choose 
Session Details from the Drilldown menu when no session is selected in the 
TopSessions chart, Performance Manager displays the Select Data Source dialog box 
where you can select from a list of data sources. After you choose the data sources, 
the Session Details window appears.

The Drilldown menu in the TopSessions chart also includes items specific to 
TopSessions. You can end a user session that you select on the TopSessions chart by 
choosing Kill Session from the Drilldown menu. When you kill a session, the 
session is removed from the chart. If a Session Detail window is open when you kill 
its session, the Session Detail window stops refreshing and reports an error.

The Drilldown menu on the TopSessions chart has the following options:

■ Historical Data

Displays the Oracle Capacity Planner Database Logon dialog box. Supply the 
user name, password, and target information as needed. Once you have logged 
into Capacity Planner, you can display historical data for this chart or start 
collecting historical data.

■ Session Details

Displays the Session Details window for the session selected from the Oracle 
TopSessions chart. This menu item is disabled when no session in the Oracle 
TopSessions main display has been selected.

Note: If the Tuning Pack is installed, Current SQL and Explain 
Plan appear on the Drilldown menu.
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■ Current SQL

■ Open Cursors for this Session

■ Timed Statistics

■ List of Drill-Down Charts

List of chart statistics for which you can view additional information (charts).

■ Kill Session

You can kill a session from the Top Sessions chart. This tool requires the 
Intelligent Agent release 8.0.6 or higher.

■ Turn SQL Trace On

■ Turn SQL Trace Off

■ Tune SQL Statement

Highlight an item in a Top Sessions chart and choose the Tune SQL statement 
menu option. If the Tuning Pack is installed, this action activates the SQL 
Analyze application.

Help Menu
The Help menu items allow you to obtain help on Oracle TopSessions chart items or 
property sheets. 

Toolbar
The toolbar of the Oracle TopSessions chart contains icons representing certain 
Oracle TopSessions menu items, including the following: 

Print Screen
Prints the displayed chart.

Report Chart
Generates a report for the displayed chart. When you click the Report Chart button, 
a chart report in HTML format is automatically created and saved for you. 
Performance Manager allows you to preview the report by displaying it on your 
screen.
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Chart Type
Changes the current display to the chart type you select from the drop-down list. 
You can select a bar chart, pie chart, strip chart, or table chart. Bar charts show 
discrete measurements at the current time. Pie charts show the relationship or 
proportions of parts to a whole. Strip charts show trends or changes in data over a 
period of time. When you first display a Strip chart, you will notice the addition 
over time of tics at the bottom of the chart. Each point represents a polling event. 
Table charts present text information, or a large number of instances, in a format 
that is easy to review.

Horizontal Orientation
Changes the chart orientation to horizontal.

Vertical Orientation
Changes the chart orientation to vertical.

Refresh Rate
Allows you to set the time between collections. The time can be set in hours, 
minutes, and seconds.

Pause Chart
Allows you to stop the collection for a chart displayed in the chart window.

Resume Chart
Allows you restart the collection of a chart displayed in the chart window.

Options
Allows you to choose the data sources, data, sort criteria, and number of rows to 
display for the collection.

Historical Data
Displays the Oracle Capacity Planner Database Logon dialog box. Supply the user 
name, password, and service information as needed. Once you have logged into 
Capacity Planner, you can display historical data for this chart or start collecting 
historical data.
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Start Recording
Starts recording the current TopSessions Chart.

Stop Recording
Stops recording the current TopSessions Chart.

Help on Chart
Displays help about the TopSessions chart.

Overview of Session Activity
Once populated with data, the Oracle TopSessions chart includes a multi-column 
list of summary information for each session connected to the database instance, or 
for each of the top n sessions, as measured by the selected sort statistic listed in 
Table 6–1.

Table 6–1 TopSessions Sort Statistics

Sort Statistic Description

Recursive CPU Amount of CPU used for parsing row cache statements such as 
lookups in the data dictionary, executing triggers, and 
PL/SQL.

Parse CPU Amount of CPU time spent parsing SQL statements. The Parse 
CPU filter represents the percentage of CPU time spent parsing 
SQL statements. Parse time CPU can be a strong indication that 
an application has not been well tuned. High parse time CPU 
usually indicates that the application may be spending too 
much time opening and closing cursors or is not using bind 
variables.

Total CPU Time Total elapsed time (in seconds) spent parsing, executing, and 
fetching during a session.

Execute Time Total elapsed time (in seconds) for all calls (user and recursive) 
associated with a distinct session.

Rollback Count Total number of times users manually issue the ROLLBACK 
statement or an error occurs during a user’s transactions 
during the sample period.
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Commit Count Total number of user commits performed during the sample 
period. When a user commits a transaction, the redo generated 
that reflects the changes made to database blocks must be 
written to disk. Commits often represent the closest thing to a 
user transaction rate.

SPID Server Process Identifier is a unique value given to each 
database server process. You must specify an exact id number 
for the filter to work.

Logical Reads (%) Percentage of total buffer gets that were attributed to this 
session during the sample period. Default is 10%.

Physical Reads (%) Percentage of database blocks read from disk. Also known as 
"disk reads." Default is 10%.

Logon Time Time of logon by this session (filter includes sessions that 
started before a user-defined date and time). To set the date 
and time, double click on a piece of the timestamp and use the 
up/down arrows to increase or decrease the value. The default 
timestamp is the current date and time.

UGA Memory Total amount of memory used by the User Global Areas for a 
session.

Parse Elapsed Time Total elapsed time (in seconds) for all parses associated with a 
distinct session.

Action The name of the action being performed by the application 
module that first executed this statement. This name can be 
optionally set by using DMBS_APPLICATION_INFO.SET_
ACTION.

Module The name of the application module that first executed this 
statement. This name can be optionally set by using DMBS_
APPLICATION_INFO.SET_MODULE.

Program The name of the client program. (Useful when the program 
name is known and is distinct from other programs.)

Terminal The operating system terminal name (useful for character 
mode applications).

Machine The operating system machine name.

Table 6–1 TopSessions Sort Statistics

Sort Statistic Description
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OS Username The name of the operating system client user. (Useful in a two 
tier architecture when the database client process does not live 
on a middle tier machine but initiated by the user on his 
desktop, or initiated on a UNIX machine. For desktop initiated 
processes, the Windows registry key USERNAME must be set 
to the username.)

Session Name Either the Oracle username of the current session or if the 
session is owned by an Oracle background process, the name 
of the background process.

Total Parses Total number of parse calls (hard and soft). A parse occurs 
when a SQL statement is mapped to a cursor during a session.

Hard Parses Hard parses happen when the server parses a query and 
cannot find an exact match for the query in the library cache. 
Hard parses can be avoided by sharing SQL statements 
efficiently. The use of bind variables instead of literals in 
queries is one method to increase sharing.

Sort Rows Total number of rows sorted.

Memory Sorts Number of sorts with no disk writes. Sorts in memory are sorts 
that could be performed completely within the sort buffer in 
memory without using the temporary tablespace segments.

Disk Sorts Sorts on disk are sorts too large to be performed entirely in the 
sort area, requiring I/O to temporary segments on disk.

Constant Changes The number of times a database block has applied rollback 
entries to perform a consistent read on the block.

Block Changes The number of times changes were made to blocks in the SGA 
as part of an update or delete. These are changes that are 
generating redo log entries and hence will be permanent 
changes to the database if the transaction is committed.

Phys Reads This data item represents the number of data blocks read from 
disk during this sample period. When a user performs a SQL 
query, Oracle will try to retrieve the data from the database 
buffer cache (memory) first, then go to disk if it is not in 
memory already. Reading data blocks from disk is much more 
expensive than reading the data blocks from memory. The goal 
with Oracle should always be to maximize memory utilization.

Constant Gets Total number of requests for information on constants in the 
data dictionary cache.

Table 6–1 TopSessions Sort Statistics

Sort Statistic Description
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Using the Right Mouse Button on the Main Display
In the Oracle TopSessions chart, you can click on a username with the right mouse 
button and then select one of the menu items that appears in the context menu. The 
list contains the Print Screen, Report Chart, and Help on Chart menu items, and 
then lists the View, Collection, and Drilldown menus from which you can then 
select related items from the flyout menus.

Sorting the Order of Entries in the Chart
By default, the value of the sort statistic determines the order of session entries in 
the Oracle TopSessions chart. However, you can use any field in the list to sort the 
order of displayed session entries by clicking on any column header in the list.

Using the Chart Status Button
Use the Chart Status button in the upper right corner of the TopSessions chart to 
access many of the same options available from the Drilldown menu. You can 
display Advice about the current chart, view the Session Details page,  kill the 
current session, and turn SQL Trace on or off.  The contents of the menu that 
displays when you press the Chart Status button is subject to the context of the 
chart.

Viewing Details About a Given Session
To obtain more information about a given session, you can drill down by right 
mouse clicking on a session in the Oracle TopSessions chart. Click on the Drilldown 

Block Gets Total number of requests for information on blocks in the data 
dictionary cache in CURRENT mode. When Oracle processes a 
user request for data it checks to see if the database blocks 
containing the requested data are in the memory (the database 
buffer cache) first. If so, Oracle checks to see if the data in those 
blocks is "up to date". If they are, Oracle will fulfill the request 
using the data blocks in memory. If they aren’t in memory, 
Oracle will retrieve them from disk. This is less efficient, but 
necessary. If Oracle was able to retrieve the blocks from 
memory without having to apply rollback data for consistency, 
each block retrieved will log a db block get.

Table 6–1 TopSessions Sort Statistics

Sort Statistic Description
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menu item and choose Session Details. Optionally, you can select a session and then 
choose Session Details from the Drilldown menu on the menu bar.

A Session Details window for that session appears as seen in Figure .

Figure 6–2 TopSessions Details window

Session Details Page
The Session Details page presents a tabular view of a sessions details and includes 
the following sections:

■ Session Identification Information

■ Current State

■ Session CPU Activity

■ Session Memory Use

■ Session I/O Activity

■ Current SQL

■ Top Wait Events
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Session Details Statistics Page
The Statistics page of the Session Details window provides a large number of 
performance statistics for the selected session. The particular statistics this page 
displays can vary, depending on the Oracle server instance.

Figure 6–3 Session Statistics Page

For information about the statistics that can be displayed for a session, see the 
Oracle Server Reference. For information on how to make use of these statistics, see 
Oracle Server Tuning.

Customizing the Session Information You Display
To customize how session information is displayed in the Oracle TopSessions chart, 
choose Options from the Collection menu or click on the Options button on the 
toolbar. The Options property sheet that appears includes the following pages:

■ Data

■ Session Filtering

■ Options
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To select one of these pages, click on the appropriate tab title near the top of the 
Options property sheet.

Data Options Page
When TopSessions is selected from the Oracle Performance Manager navigator tree, 
the Data Tab appears in the right-hand pane. The Data Tab presents information 
about the selected TopSessions collection such as the Data Sources and the 
collection types of the selected data. You can personalize the Data Tab view by 
selecting or deselecting the collected data items.

Figure 6–4 TopSessions Data Options Page

Data Sources
The "All data sources" option is selected by default.

Select Collected Data
You can specify which data items should appear in the chart by selecting or 
deselecting the items in this list. By default, a check mark appears in the "Collected 
Data" row, all data items will automatically appear in the chart.
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Session Filtering Options Page
By default, a TopSessions collection will show any session that is currently active or 
any session that has executed a SQL statement since the last sample. These sessions 
are selected based on a default set of pre-defined filters. If you prefer, you can also 
customize the TopSessions collection by defining your own set of TopSessions 
filters. The TopSessions Filtering tab allows you to specify your own set of filters.

Figure 6–5 TopSessions Session Filtering Page

To enable the filtering options, check the box labeled: Show only the statements 
that meet all of the following conditions. Select a filtering condition and value, 
then click the More button to add additional filters. You can eliminate filters by 
pressing the Fewer button.

Creating a Customized TopSessions Collection
Before you create your own set of TopSessions filters, it is important to note the 
following filtering restrictions:

■ You can only include one value per filter.

■ Adding additional filters may negate previously defined filters.
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For a complete list of filtering conditions and their descriptions, see Table 6–1, 
"TopSessions Sort Statistics"  on page 6-10.

Options Page
The Options tab provides two display options. These options should be set prior to 
showing the TopSessions chart. You can also change the options after starting the 
chart to reduce the number of sessions to a smaller sample set based upon some 
abnormality you see in the default chart.

Figure 6–6 TopSessions Options Page

■ Limit to data sources:

No limit--The TopSessions chart will display all of the statements that meet the 
filtering criteria(n).

Limit to--By default the TopSessions chart will only display the top 25 
statements that meet the filtering criteria(n). You can, however, view more or 
fewer statements by adjusting this number.

■ Sort the data by:
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This option allows you to specify a sorting parameter. When the chart is 
displayed, the data items will be organized by the sorting parameter you have 
specified. The chart is sorted by disk reads by default.
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7
Using Oracle Trace Data Viewer

Oracle Trace Data Viewer (hereafter referred to as Data Viewer) is an Oracle 
Enterprise Manager application that allows you to view formatted data collected by 
the Oracle Trace command line interface.  For more information about using the 
command line interface to collect data, see the Oracle9i Database Performance Guide and 
Reference.

This chapter includes the following:

■ Overview

■ Usage Scenarios for Data Viewer

■ Starting Data Viewer

■ Using Data Viewer

■ Using the Data View Wizard

■ Data Viewer Problems

■ Isolating an Oracle Trace Problem

Overview
An Oracle Trace server collection typically contains a large volume of valuable 
information that can be used for troubleshooting and investigating SQL or wait 
activity and resource utilization. Data Viewer handles the complex task of  
extracting data and aggregating key server performance metrics on a large Oracle 
Trace collection. Once you select an Oracle Trace collection, you can have Data 
Viewer compute SQL or Wait statistics or both.

Once you select an Oracle Trace collection, Data Viewer runs through all of the 
Oracle Trace formatter tables, extracting, processing, and aggregating key 
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performance metrics. This processed data is presented in a comprehensive set of 
Oracle Trace predefined data views.

A data view is the definition of a query into the formatted data collected by Oracle 
Trace. A data view consists of items or statistics to be returned and, optionally, a 
sort order and limit of rows to be returned.

With the data views provided by Data Viewer, you can:

■ Examine important statistical data, for example, elapsed times

■ Drill down as needed to get additional details about the data

If you want to define your own data views, you can use the Oracle Trace Data View 
Wizard.

Usage Scenarios for Data Viewer
Using Data Viewer you can:

■ Look at Oracle Server SQL statistics

Data Viewer provides predefined data views that can accelerate the process of 
identifying poorly performing SQL statements. Oracle Server SQL data views 
are grouped by categories. Some specific data views include:

– Elapsed Time statistics

Average Elapsed Time (sorts SQL by greatest average elapsed time per 
execution of queries within the collection)

– Sort statistics

Sorts in memory and sorts on disk and number of rows sorted 

– I/O statistics

Disk Reads/Logical Reads Ratio (sorts SQL by worst disk to logical I/O 
data buffer cache hit rate)

■ View Logical and Physical Transaction level statistics

■ View Wait statistics

Starting Data Viewer
You can access Data Viewer in the following ways:

■ From the Oracle Enterprise Manager program group
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■ From the Start menu

The following sections explain how to use these methods.

Starting Data Viewer from Oracle Enterprise Manager
To start Data Viewer from Oracle Enterprise Manager, either click on Trace Data 
Viewer from the Diagnostics Pack drawer or select Tools=>Diagnostics Pack=>Trace 
Data Viewer. The Oracle Trace Data Viewer Login box appears. Provide login 
information to connect to a schema containing formatted collections. Data Viewer 
displays all collections formatted to the schema (see Figure 7–1).

Figure 7–1 Data Viewer Collection Screen

Decide which formatted collection you want to investigate and double-click on the 
collection name. The Work in Progress dialog box appears.

Starting Data Viewer from the Start Menu
To start Data Viewer from the Start menu, select Start=>Programs=>ORACLE_
HOME=>Diagnostics Pack=>Trace Data Viewer.

Note: Oracle Trace data must be formatted before you can use 
Data Viewer. 

Note: ORACLE_HOME represents the oracle_home in which the 
Diagnostics Pack is installed.
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The Oracle Trace Data Viewer Login box appears. Provide login information to 
connect to a schema containing formatted collections. Data Viewer displays all 
collections formatted to the schema (see Figure 7–1).

Decide which formatted collection you want to investigate and double-click on the 
collection name. The Work in Progress dialog box appears.

Using Data Viewer
The first time a collection is accessed by Data Viewer, the Compute Statistics dialog 
box appears. At this time, Data Viewer can compute SQL and Wait statistics.

Computing Statistics – Preparing Data for Fast Access and Analysis
The first time you run Data Viewer on a formatted collection containing Oracle 
Server data, Data Viewer asks whether you want to calculate SQL statistics, Wait 
statistics, or both (see Figure 7–2).

Figure 7–2 Compute Statistics

This step prepares the data for fast access and simplified problem analysis. Oracle 
Corporation strongly recommends that you allow this processing to occur.
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Displaying Data Views
Data Viewer displays the predefined data views for a collection, as shown in 
Figure 7–3.

Figure 7–3 List of Predefined Data Views

Note: For large collections, the Computing Statistics step is time 
consuming. Oracle Corporation recommends that you perform this 
step at off-peak times.



Using Data Viewer

7-6 Getting Started with the Oracle Diagnostics Pack

Depending on the events collected, the predefined data view list will vary. For 
example, the Oracle Server collection will contain predefined data views 
appropriate for data collected in an Oracle Server collection.

If the Oracle Trace ALL class was used for the collection, Wait events will also 
display in the navigator tree. Unless you need to examine wait events, Oracle 
Corporation suggests that you collect data for the DEFAULT or EXPERT class to 
minimize the amount of data collected.

Note: Predefined data views reflect statistics computed for all 
occurrences of a distinct query within the collection (see Table 7–1.)

Table 7–1 Predefined Data Views Provided By Oracle Trace 

View Name Sort By Data Displayed Description

Logical Reads Total number of 
logical reads 
performed for each 
distinct query. 

Total number of blocks 
read during parses, 
executions and fetches. 

Logical reads for parses, 
executions and fetches of 
the query. 

Logical data block reads include data block reads 
from both memory and disk.

Input/output is one of the most expensive operations 
in a database system. I/O intensive statements can 
monopolize memory and disk usage causing other 
database applications to compete for these resources.

Disk Reads Queries that incur the 
greatest number of 
disk reads. 

Disk reads for parses, 
executions, and fetches. 

Disk reads also known as physical I/O are database 
blocks read from disk. The disk read statistic is 
incremented once per block read regardless of 
whether the read request was for a multiblock read or 
a single block read. Most physical reads load data, 
index, and rollback blocks from the disk into the 
buffer cache.

A physical read count can indicate a high miss rate 
within the data buffer cache.

Logical 
Reads/Rows 
Fetched Ratio

Number of logical 
reads divided by the 
number of rows 
fetched for all 
executions of the 
current query. 

Total logical I/O. 

Total number of rows 
fetched. 

The more blocks accessed relative to the number of 
rows actually returned the more expensive each row 
is to return.

Can be a rough indication of relative expense of a 
query.

Disk 
Reads/Rows 
Fetched Ratio

Number of disk reads 
divided by the 
number of rows 
fetched for all 
executions of the 
current query.

Total disk I/O.

Total number of rows 
fetched.

The greater the number of blocks read from disk for 
each row returned the more expensive each row is to 
return.

Can be a rough indication of relative expense of a 
query.
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Disk 
Reads/Executio
n Ratio

Total number of disk 
reads per distinct 
query divided by the 
number of executions 
of that query.

Total disk I/O.

Logical I/O for the query 
as well as the number of 
executions of the query.

Indicates which statements incur the greatest number 
of disk reads per execution.

Disk 
Reads/Logical 
Reads Ratio

Greatest miss rate 
ratio of disk to logical 
reads.

Individual logical reads.

Disk reads for the query as 
well as the miss rate.

The miss rate indicates the percentage of times the 
Oracle Server needed to retrieve a database block on 
disk as opposed to locating it in the data buffer cache 
in memory.

The miss rate for the data block buffer cache is 
derived by dividing the physical reads by the number 
of accesses made to the block buffer to retrieve data in 
consistent mode plus the number of blocks accessed 
through single block gets.

Memory access is much faster than disk access; the 
greater the hit ratio, the better the performance.

Re-Parse 
Frequency

Queries with the 
greatest reparse 
frequency.

Number of cache misses.

Total number of parses.

Total elapsed time parsing.

Total CPU clock ticks 
spent parsing.

The Oracle Server determines whether there is an 
existing shared SQL area containing the parsed 
representation of the statement in the library cache. If 
so, the user process uses this parsed representation 
and executes the statement immediately.

If missed in the library cache, the statement needs to 
be re-checked for syntax, valid objects, and security. 
Also a new execution plan will need to be determined 
by the optimizer.

Note that the parse count statistic is incremented for 
every parse request whether or not the SQL statement 
is already in the shared SQL area.

Parse/Execution 
Ratio

Number of parses 
divided by the 
number executions 
per statement.

Individual number of 
parses.

Number of executions.

The count of parses to executions should be as close to 
one as possible. If there are a high number of parses 
per execution then the statement has been needlessly 
reparsed. This could indicate the lack of use of bind 
variables in SQL statements or poor cursor reuse.

Reparsing a query means that the SQL statement has 
to be re-checked for syntax, valid objects and security. 
Also a new execution plan will need to be determined 
by the optimizer.

Average 
Elapsed Time

Greatest average time 
spent parsing, 
executing and 
fetching on behalf of 
the query.

Individual averages for 
parse, execution and fetch.

The average elapsed time for all parses, executions 
and fetches-per-execution are computed, then 
summed for each distinct SQL statement in the 
collection.

Table 7–1 Predefined Data Views Provided By Oracle Trace (Cont.)

View Name Sort By Data Displayed Description
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Total Elapsed 
Time

Greatest total elapsed 
time spent parsing, 
executing and 
fetching on behalf of 
the query.

Individual elapsed times 
for parses, executions and 
fetches.

The total elapsed time for all parses, executions and 
fetches are computed, then summed for each distinct 
SQL statement in the collection.

Parse Elapsed 
Time

Total elapsed time for 
all parses associated 
with a distinct SQL 
statement.

SQL cache misses.

Elapsed times for 
execution and fetching.

Total elapsed time.

During parsing the Oracle Server determines whether 
there is an existing shared SQL area containing the 
parsed representation of the statement in the library 
cache. If so, the user process uses this parsed 
representation and executes the statement 
immediately.

If missed in the library cache, the statement needs to 
be rechecked for syntax, valid objects and security. 
Also a new execution plan will need to be determined 
by the optimizer.

Execute Elapsed 
Time

Greatest total elapsed 
time for all 
executions associated 
with a distinct SQL 
statement.

Total elapsed time.

Individual elapsed times 
for parsing and fetching.

The total elapsed time of all execute events for all 
occurrences of the query within an Oracle Trace 
collection.

Fetch Elapsed 
Time

Greatest total elapsed 
time for all fetches 
associated with a 
distinct SQL 
statement.

Number of rows fetched.

Number of fetches.

Number of executions.

Total elapsed time.

Individual elapsed times 
for parsing and executing.

The total elapsed time spent fetching data on behalf of 
all occurrences of the current query within the Oracle 
Trace collection.

CPU Statistics Total CPU clock ticks 
spent parsing, 
executing and 
fetching on behalf of 
the SQL statement.

CPU clock ticks for parses, 
executions and fetches.

Number of SQL cache 
misses and sorts in 
memory.

When SQL statements and other types of calls are 
made to an Oracle Server, a certain amount of CPU 
time is necessary to process the call. Average calls 
require a small amount of CPU time. However, a SQL 
statement involving a large amount of data, a 
runaway query, in memory sorts or excessive 
reparsing can potentially consume a large amount of 
CPU time.

Note that CPU time displayed is in terms of the 
number of CPU clock ticks on the operating system 
housing the database.

Number of 
Rows Returned

Greatest total number 
of rows returned  
during fetch for the 
SQL statement.

Number of rows returned 
during the fetch operation 
as well as the execution 
rows.

Targets queries that manipulate the greatest number 
of rows during fetching. May mean that high gains 
can be made by tuning row intensive queries.

Table 7–1 Predefined Data Views Provided By Oracle Trace (Cont.)

View Name Sort By Data Displayed Description
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Accessing the Definition of a Data View
To access the definition for each data view, click on the data view name listed in the 
Data View Name column, for example, Disk Reads/Logical Reads Ratio. The 
description of the statistical data returned from the data view is on the General 
property page located on the right pane of the screen as shown in Figure 7–4. More 
details are shown in the Items and Options pages.

■ General

Displays the name, short description, and full description of the data view. For 
the Oracle Server predefined data views, the name reflects the name of the 
event. The full description is usually used to indicate what type of information 

Rows 
Fetched/Fetch 
Count Ratio

Number of rows 
fetched divided by 
the number of 
fetches.

Individual number of rows 
fetched.

Number of fetches.

This ratio shows how many rows were fetched at a 
time. It may indicate the level to which array fetch 
capabilities have been utilized. A ratio close to one 
may indicate an opportunity to optimize code by 
using array fetches.

Sorts on Disk Queries that did the 
greatest number of 
sorts on disk.

Sort statistics for SQL 
statements.

Number of in memory 
sorts. 

Total number of rows 
sorted. 

Sorts on disk are sorts that could not be performed in 
memory, therefore they are more expensive since 
memory access is much faster than disk access.

Sorts in 
Memory

Queries that did the 
greatest number of 
sorts in memory.

Sort statistics for SQL 
statements.

Number of disk sorts.

Total number of rows 
sorted.

Sorts in memory are sorts that could be performed 
completely within the sort buffer in memory without 
using the temporary tablespace segments.

Rows Sorted Queries that sorted 
the greatest number 
of rows.

Number of in memory 
sorts.

Number of sorts on disk.

Returns sort statistics for SQL statements ordered by 
queries that sorted the greatest number of rows.

Waits by Total 
Wait Time

Highest total wait 
time per distinct type 
of wait.

Average wait time, total 
wait time and number of 
waits per wait type.

Waits are sorted by wait description or type that had 
the greatest cumulative wait time for all occurrences 
of the wait type within the collection.

Waits by 
Average Wait 
Time

Highest average wait 
time per wait type.

Average wait time, total 
wait time and number of 
waits per wait type.

Waits are sorted by wait type that had the greatest 
average wait time for all occurrences of the wait type 
within the collection.

Waits by Event 
Frequency

Frequency of waits 
per wait type. 

Number of waits per wait 
type, average wait time, 
and total wait time. 

Waits are sorted by wait events or wait descriptions 
that appear most frequently within the collection.

Table 7–1 Predefined Data Views Provided By Oracle Trace (Cont.)

View Name Sort By Data Displayed Description
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is displayed in a data view and when it would be appropriate to use the data 
view.

■ Options

Shows which statistics will be used to determine sort order, if any. Also 
displays the number of rows that will be selected by the data view. Limiting the 
number of rows to be retrieved and displayed can accelerate the display of the 
data.

■ Items

Lists the statistics that will be displayed by the currently selected data view, as 
well as all possible statistics for the data view.

Figure 7–4 Predefined Data View - Disk Reads/Logical Reads Ratio

Viewing Data in a Data View
To examine the data defined in each data view, do one of the following:

■ Double-click on the View Name, for example, Disk Reads/Logical Reads Ratio.

■ With the data view selected, click the Open Data View button.
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■ Choose Data View=>Open from the Collection window.

Data Viewer then displays the data (see Figure 7–5) identified by criteria defined in 
the selected data view. In this example, the data view shows summary information 
for each SQL statement executed, sorted by the Disk to Logical Reads Ratio (for 
example, column name marked with asterisk (*)).

Figure 7–5 Details of "Disk Reads/Logical Reads Ratio" Data View

The major portions of the screen are:

Data value columns
The columns are displayed in the sort order determined by the value in the column 
marked with asterisk (*).

SQL Statement
The SQL statement property page displays the SQL statement text for the query 
associated with the currently selected row of returned statistics. Note that statement 
text changes as you highlight various rows.

Use the right mouse button to display the popup menu that can be used to select 
and copy text.
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Details
The Details property page lists all statistics associated with the highlighted row in 
the data view. The statistics shown are for all executions of the current query within 
the Oracle Trace collection.

Use the right mouse button to display the popup menu that can be used to select 
and copy text.

Status Bar
Shows the number of rows returned and the number of the currently selected row. 
The status is displayed in the lower right corner of the window.

Creating Custom Data Views
You can also create a new data view or create a data view like an existing data view. 
Create a data view when a predefined data view does not contain the information 
you want to examine. "Using the Data View Wizard" on page 7-18 describes the 
process of creating a data view.

Modifying or Extending Data Views
You can modify a data view to either add or remove statistics from the view. 

For example, to add the "Execute rows" statistics to the data view, do the following:

1. Select a data view, for example, "Disk Reads/Logical Reads Ratio," then in the 
Data View window, choose Data View=>Modify.

2. In the Edit Data View dialog box, select the Items tab, and move the "Execute 
rows" statistics from the Items list to the Display These Items list. 

3. Click OK. 

The new information will be added to the view immediately. You can then save this 
data view to use at another time by choosing File=>Save As. The original view still 
exists. The modified view appears at the bottom of the navigator tree under the 
Custom folder.

Note that from the Data View window you can:

Note: Detail statistics for SQL data views are similar to statistics 
presented by the TKPROF utility.
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■ Click on the current sort column to reverse the sort order. Click on a new 
column to change the sort criteria. The sort column is indicated by an asterisk 
(*) appended to the front of the header title.

Changing the sort order causes the database to be queried again for the top 
rows using the new sort criteria.

■ Revise the options, for example, the maximum number for rows retrieved. Click 
the Options tab to make these changes. (This tab becomes available after you 
select Data View=>Modify.)

■ Modify the name, description, and full description of the data view by clicking 
the General tab. (This tab becomes available after you select Data 
View=>Modify.)

Drill-Down of Data Views
For certain events, you can drill down to related events to refine your view of the 
data. The drill-down option is available if the event that is currently being shown 
consists of other related events. For example, when examining the SQL Statistics 
data views, you can drill down to the Parse, Execute, and Fetch statistics for the 
currently selected query.

Select a row that you wish to analyze further (see Figure 7–5) and choose Data 
View=>Drill down. This allows you to join this row to other events and items of 
interest.

Figure 7–6 shows the resulting drill-down window.

Note: When viewing SQL Statistics, you are viewing statistics for 
ALL executions of each distinct query within the collection. Drill 
down to view statistics for each parse, execution, and fetch for the 
selected SQL statement.
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Figure 7–6 Intermediate Drill-Down to Selected Data View

The major portions of the window are:

■ List of predefined data views

Predefined data views are supplied for drilling down to the individual parses, 
executions, and fetches associated with a selected SQL statement.

■ Description

Displays a short description of the currently selected drill-down data view.

■ Full Description

Displays a more in-depth description of the data returned by the currently 
selected drill-down data view, as well as a list of the statistics returned by this 
data view and the statistic that is used to sort it.

Select and double-click a drill-down data view to see individual parse, execute, and 
fetch statistics for each execution of the SQL statement within the collection. You 
will see the parse, execution, and fetch statistics within their own scrolling regions, 
as shown in Figure 7–7.
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Figure 7–7 Resulting Drill-Down Data View

Major portions of the screen are:

■ Top part of window

Lists the detailed information returned by the data view. Each event will have 
columns containing statistics of items returned by the data view.

■ SQL Statement

The SQL statement property page displays the SQL statement text for the query 
associated with the currently selected row of returned statistics.

■ Details

The Details property page shows the statistics for all executions of the current 
query within the Oracle Trace collection.
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Selecting a Drill-Down Data View
Predefined data views are supplied for drilling down to the individual parses, 
executions, and fetches associated with a selected SQL statement. Table 7–2 lists the 
drill-down data views available in Data Viewer.

Table 7–2 Drill-Down Data Views 

Drill-Down Name Sort By Data Displayed Description

Basic Statistics for 
Parse/Execute/Fetch

Greatest elapsed 
time.

For each distinct event: CPU time.

Elapsed time.

Disk I/O.

Logical I/O.

Number of rows processed.

Parse, Execution, and Fetch 
statistics like statistics output from 
TKPROF.

CPU Statistics for 
Parse/Execute/Fetch

Greatest elapsed CPU 
time.

CPU total.

Pagefaults.

CPU and pagefault statistics for 
Parses, Executions, and Fetches of 
the current query.

CPU total is the number of clock 
ticks in both user and system 
mode. The clock tick granularity is 
specific to the operating system on 
which the database resides.

I/O Statistics for 
Parse/Execute/Fetch

Greatest number of 
disk I/Os.

Logical and Disk I/O statistics.

Pagefault I/O (number of hard 
pagefaults).

Input I/O (number of times the file 
system performed input).

Output I/O (number of times the file 
system performed output).

I/O statistics for parses, 
executions, and fetches.

Parse Statistics Greatest elapsed 
time.

Current user identifier.

Schema identifiers.

Parse information, such as whether 
or not the current statement was 
missed in library cache, Oracle 
optimizer mode, current user 
identifier, and schema identifier.

Row Statistics for 
Execute/Fetch

Greatest number of 
rows returned.

Number of rows returned.

Number of rows sorted.

Number of rows returned during a full 
table scan.

Execution and fetch row statistics.
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Modifying Drill-Down Data Views
Drill-down data views can be modified and saved much like top level data views. 
You can modify a drill-down data view to either add or remove statistics from the 
view. 

Because slightly different statistics are associated with the parse, execution, or fetch 
events, you must modify each event separately. For example, to add the "Rows" 
(row count) statistic to the execution and fetch output in the drill-down data view, 
do the following:

1. Select any row in "Execution I/O Statistics" and choose Data View=>Modify.

2. In the Edit Data View dialog box, select the Items tab, and move the Rows 
statistics from the Items list to the Display These Items list.

3. Click OK.

4. Select any row in the "Fetch I/O Statistics" and add the "Rows" statistics to that 
event.

The new information is added to the view immediately. You can then save this data 
view to use at another time.

Sort Statistics for 
Parse/Execute/Fetch

Greatest elapsed 
time.

Sorts on disk.

Sorts in memory.

Number of rows sorted.

Number of rows returned from a full 
table scan.

Parse, execution, and fetch sort 
statistics.

Wait Parameters Wait_Time. Description.

Wait_Time.

P1.

P2.

P3.

Investigating Waits may help to  
identify where contention resides 
and what is causing the contention.

P1, P2, and P3 parameters are 
values that provide more 
information about a specific wait 
event. The parameters are foreign 
keys to views that are wait event 
dependent. For example, for latch 
waits, P2 is the latch number which 
is a foreign key to v$latch.

The meaning of each parameter is 
specific to each wait type.

Table 7–2 Drill-Down Data Views (Cont.)

Drill-Down Name Sort By Data Displayed Description
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Saving As Data Views and Files
From the Data View window, you can save the current data view settings by 
selecting File=>Save As=>Data View. This is useful if you want to reuse this data 
view frequently. You must provide a name, description, and full description to save 
the view. Modified views are listed in the Custom folder in the navigator tree.

Also, you can save the selected rows of a data view to a file by selecting File=>Save 
As=>File. You can save the data in either of the following formats:

■ SQL text (text only) for rows that have SQL text. You can use this file for import 
into SQL Analyze.

■ CSV (comma-separated value format). You can use this format for import into 
other programs that accept CSV format.

Printing Data Views
From the File menu, there are three printing options available: Print, Print Setup, 
and Set Printer Font.

The Print option prints the currently active portion of a data view. If the currently 
active region is a data area, you can print either the entire region (including rows 
that are not visible on the screen) or selected rows. If the currently active region is 
the "SQL Statement/Details" area, both the SQL Statement and the Details will be 
printed.

The Print Setup option displays the standard Print Setup dialog box.

The Set Printer Font option displays the standard Font dialog box with the font 
selection for the currently selected printer.

Using the Data View Wizard
You can create your own customized data view by using the Oracle Trace Data View 
wizard (hereafter referred to as the Data View wizard).

To invoke the wizard, choose Data View=>Create or Data View=>Create Like. The 
wizard’s Welcome page appears (see Figure 7–8).

Use the Data View wizard to examine data that you cannot find in a predefined 
view. However, this data will not be optimized and may take longer to process.
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Figure 7–8 Data View Wizard Welcome Page

You can choose to bypass this Welcome page the next time you use the Data View 
wizard.

Click Next to start the definition of the data view. 

Choosing an Event
The Event page is the first page used in the definition of the data view that you are 
creating. The Event page is as shown in Figure 7–9.
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Figure 7–9 Selecting the Event

From the Event page, choose the event on which to base the data view. The list of 
event names comes from the Oracle Trace formatted data tables. Event names are 
limited to and truncated at 16 characters.

If you are looking at an Oracle Server collection and you let Data Viewer compute 
statistics, the SQL Text Segment event allows you to examine statistics from Parse, 
Execute, and Fetch events.

After you select the event, continue to the Items page by clicking Next.

Choosing Items Associated with the Selected Event
On the Items page, select the items that you want to display in the data view (see 
Figure 7–10).
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Figure 7–10 Selecting and Ordering Items Associated with the Event

 

Items available are based on the event chosen.

■ Choose items to display by selecting them in the Items list and use >> to move 
the items to the Display These Items list. Use << to remove an item from the 
Display These Items list. Items prefixed with an asterisk (*) are statistics 
computed by Data Viewer.

■ Order these items by highlighting an item in the Display These Items list and 
using the up and down arrows to move the item in the list. The first item in the 
list is the first item displayed in the data view. Each item will be in a column in 
the data view.

When the item is selected, the Description field displays the description.

You must choose at least one item to generate a data view.

The next step in defining the data view is to define the sort criteria. Click Next to 
access the Sort By page.
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Choosing the Sort Criteria
The Sort By page (see Figure 7–11) allows you to choose the item or statistic on 
which the sorting will take place. Sort criteria is optional.

Figure 7–11 Selecting Sort Criteria

The data can be displayed in either ascending or descending order. Descending 
order is the default.

The next step in defining the data view is to optionally limit the number of rows to 
display in the data view. Click Next to access the Number of Rows page.

Defining the Number of Rows to Display
The last step in defining the data view is to decide how many rows are to be 
displayed in the data view (see Figure 7–12). You can either limit the number of 
rows to display or decide to display all the rows.

Limiting the number of rows returned can improve performance. If you are 
interested in viewing the highest value of some statistic, limit the number of rows. 
You can change the number for rows from the data view later on.
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Figure 7–12 Limiting Number of Rows

This is the last step in defining the data view. Click Next to view the Summary 
page.

Reviewing the Summary Page
The Summary page gives you the opportunity to review the choices that you made 
while defining the data view (see Figure 7–13).
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Figure 7–13 Summary Page

You can either accept all of the choices by clicking Finish or go back to change one 
or more definitions by clicking Back.

Data Viewer Problems
The following section deals with problems specific to Data Viewer.

Could Not View Oracle Trace Formatted Data
To view Oracle Trace formatted data using the Data Viewer, a user account needs 
the following system privileges:

CREATE SESSION
CREATE SEQUENCE
CREATE TABLE
CREATE PROCEDURE
CREATE ANY INDEX
EXECUTE ANY PROCEDURE
DELETE ANY TABLE
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DROP ANY INDEX
DROP ANY SEQUENCE
UNLIMITED TABLESPACE

Need to Restore Formatted Data
Data Viewer adds statistical information to your formatted data. To restore your 
formatted data to the exact state it was in prior to running Data Viewer, run the 
ORACLE_HOME\Sysman\Admin\TdvDrop.sql script. Reasons for restoring data 
include:

■ You encountered an insufficient privilege error prior to or during computing 
statistics.

■ You received a database error creating a tablespace extent.

ORA-01658: unable to create INITIAL extent for segment in tablespace
MY_TABLESPACE

■ You encountered an unexpected error that appears to be non-recoverable.

Additional Formatted Data Is Missing from Data Viewer
The first time Data Viewer views a collection, you can compute SQL statistics for all 
queries currently in the collection. Data Viewer does not detect new data added to a 
collection by a partial format while Data Viewer is viewing that collection. If you 
choose to partially format your collected data, you can force Data Viewer to 
recompute statistics using both existing and newly collected data by choosing 
Options=>Recompute Statistics.

Poor Performance
If multiple collections exist in one set of user tables, computing statistics and 
subsequent selects may take longer than necessary. Placing a large collection in a 
new database user account will improve performance.

Table or View Does Not Exist (or No Data in Collection)
When a record is not written to the EPC_FACILITY_REGISTRATION table, the user 
may see an error like the following:

XP-21016: A database error has occurred:
SELECT DISTINCT FACILITY_NUMBER, FACILITY_VERSION, VENDOR 
FROM EPC_FACILITY_REGISTRATION WHERE COLLECTION_ID - :1



Isolating an Oracle Trace Problem

7-26 Getting Started with the Oracle Diagnostics Pack

ORA-00942: table or view does not exist

Removing the ’Filtering by User ’ option on collections targeting Oracle Server 
release 8.0.4 databases will correct this problem for future collections.

Manually adding an EPC_FACILITY_REGISTRATION record for the collection 
allows Trace Data Viewer to see that collection’s formatted data. For example, insert 
EPC_FACILITY_REGISTRATION record with the following values:

Collection_ID:    123       [Look in formatted data’s EPC_COLLECTION table
                             for the collection_id column value that matches
                             your collection_name]
Vendor:           192216243 [Hard code this value]
Facility_number:  5         [Hard code this value]
Facility_version: ’8.0’     [or ’7.3’ for a collection against a 7.3 database
                             or ’8.1’ for a collection against an 8.1 database]

Isolating an Oracle Trace Problem
Oracle Server releases 7.3.4 and 8.0.4 and later automatically create the formatter 
tables. Prior to Oracle Server releases 7.3.4 and 8.0.4, you must run the otrcfmtc.sql 
script from Oracle Server Manager or Oracle SQL*Plus Worksheet as the user who 
will be formatting the data. To ensure version compatibility, use the otrcfmtc.sql 
script located in the ORACLE_HOME of the destination server.

The otrcfmtc.sql script is located in the $ORACLE_HOME/otracenn/admin 
directory (where nn represents the version of Oracle Trace).

Formatting error might be due to one of the following causes:

1. The user did not run the script to create the formatter tables (valid for releases 
of Oracle Server prior to 7.3.4 and 8.0.4).

2. The formatter tables were not created by the same user ID that was used when 
the collection was created (valid for releases of Oracle Server prior to 7.3.4 and 
8.0.4).

Look for EPC_COLLECTION.

To check for formatter tables using SQL Worksheet:

connect <username>/<password>@<service name>
describe epc_collection
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To create formatter tables, execute the otrcfmtc.sql script from the ORACLE_HOME 
of the Oracle Server that you connected to. You only need to run this script on 
Oracle Server releases prior to 7.3.4 and 8.0.4.

@ORACLE_HOME/otrace/admin/otrcfmtc.sql

Isolating a Problem in Oracle Trace Collection Services
Here are a few suggestions to help you isolate problems in the Oracle Trace 
Collection Services.

Oracle Trace Command-Line Interface
To test the CLI:

1. CLI needs to run from a privileged account, for example, the Oracle operating 
system user account.

2. The Oracle Home and SID environmental variables must be set properly.

To check settings on UNIX:

printenv ORACLE_HOME
printenv ORACLE_SID

To set settings on UNIX:

setenv ORACLE_HOME <path>
setenv ORACLE_SID <sid>

There should be one CLI per ORACLE_HOME. For example, if you have 
two Oracle Server release 7.3.3 instances sharing the same ORACLE_
HOME, there should be only one CLI.

3. Verify that the CLI release matches the database server release.

The Oracle Trace Collection Services files may be overwritten on NT by other 
product installations. If this occurs, your Oracle Trace Collection Services files 
will no longer match the version required by your Oracle Server database and 
you may receive a memory mapping error. 

On the server node, type the following command on the operating system 
command line:

$ORACLE_HOME/bin/otrccol version
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4. Verify if the collection name has not already been used before you start the 
collection. Look in the .cdf and .dat directories $ORACLE_
HOME\otracenn\admin on NT ($ORACLE_HOME/otrace/admin on UNIX).

5. If you want to generate database activity for this collection, connect to the 
database.

■ For Oracle Server release 7.3.x, connect to the service before you create your 
collection.

■ For Oracle Server release 8.0, you can connect to the database anytime and 
the processes will be registered.

A .dat file and a .cdf file will be created in one of the following directories: 
$ORACLE_HOME/otrace/admin/cdf or the directory specified by the 
ORACLE_TRACE_COLLECTION_PATH parameter in your init<sid>.ora 
file.

a. Verify that the collection was started.

otrccol check <collection_name>

The collection should show as active.

Oracle7 Stored Procedures
If the attempt to collect Oracle Trace data for an Oracle7 database results in the 
message "Error starting/stopping Oracle7 database collection," this may be due to 
missing database stored procedures that Oracle Trace uses to start and stop Oracle7 
collections.

■ Check for stored procedures (for Oracle Server releases 7.3.x)

To check for stored procedures using the Oracle Enterprise Manager console, 
use the Navigator and the following path:

Networks=>Databases=><your database>=>Schema Objects=>Packages=>SYS

Look for stored procedures starting with DBMS_ORACLE_TRACE_xxx.

To check for stored procedures using Oracle Server Manager or Oracle 
SQL*Plus Worksheet:

select object_name from dba_objects where object_name like ’%TRACE%’ 
and object_type = ’PACKAGE’; 
OBJECT_NAME
DBMS_ORACLE_TRACE_AGENT
DBMS_ORACLE_TRACE_USER
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2 rows selected.

Prior to Oracle Server release 8.0.3, Oracle Trace required that stored procedures be 
installed on the database. These SQL scripts may be automatically run during 
database installation depending on the platform-specific installation procedures. If 
they are not executed during database installation, you must run these scripts 
manually. You can add these stored procedures to the database by running the 
otrcsvr.sql script from $ORACLE_HOME\otracenn\admin on NT ($ORACLE_
HOME/otrace/admin on UNIX) from a privileged database account (SYS or 
INTERNAL). To run the script, set the default to the path were the script is located. 
This script runs other scripts that do not have the path specified. These other scripts 
fail if you are not in the directory where these scripts will run.

EPC_ERROR.LOG File
The EPC_ERROR.LOG file provides information about the collection processing, 
specifically the Oracle Trace Collection Services errors.

The EPC_ERROR.LOG file is created in the current default directory. 

For general information about causes and actions for most Oracle Trace messages, 
see the Oracle Enterprise Manager Messages Manual

Information Needed When Reporting a Problem
If you have tried all the previously described suggestions and Oracle Trace is still 
not working, please call your local Oracle World Wide Support Center. When 
reporting a problem, have the following information available:

■ Version of Oracle Trace

■ Operating system and version you are using for the server and the version of 
the Oracle Server

■ Operating system you are using for the client and the version of the client

■ Verify whether you have multiple ORACLE_HOME installations. If so, what 
Oracle components and versions are in each ORACLE_HOME installation?

■ Steps to follow to reproduce the problem

■ Log files (EPC_ERROR.LOG)

■ Steps you have followed to attempt to solve the problem
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A
Using Advanced Event Tests Effectively

Oracle Advanced Event Tests are integrated into the Oracle Enterprise Manager 
Console’s Event Management System. They are installed as part of the Diagnostics 
pack and provide DBAs and database users with additional resources to monitor 
event conditions in their network environment.

This appendix demonstrates how the Oracle Event Management System and 
Advanced Event Tests can help DBAs simplify their day to day administrative 
tasks, enabling them to perform tasks that can provide even greater benefit to the 
company.

In our examples, the DBA uses events in three different scenarios to proactively 
monitor potential problems. Proactive management allows the DBA to take action 
to resolve the issue before the problem occurs, minimize unscheduled downtime, 
and prevent slow response time. 

Each of the scenarios provides a description of the problem, a step-by-step 
preventative action plan, and a resolution summary. The following management 
tasks are addressed in the scenarios:

■ Operational Management

– The DBA wants to automate his routine monitoring tasks so he can spend 
his time addressing performance tuning and participating in system design.

■ Space Management

– The DBA wants to ensure a night time batch load does not fail due to 
insufficient tablespace free space.

■ Performance Tuning

– The DBA wants to ensure there is no performance degradation once a new 
SQL intensive application is brought online.
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Operational Management

Problem
The DBA realizes that most of his time is spent performing routine, time-consuming 
tasks which focus on the operational aspect of keeping various databases up and 
running. To reduce the labor of system management across numerous managed 
databases, he uses the Oracle Event Management System. The Event System will 
allow him to proactively monitor the systems for which he is responsible.

He decides to divide his tasks into three different groups (depending on the 
frequency at which these tasks should be performed):

■ Items that should be monitored on a continuous basis

■ Items that should be monitored on a daily basis

■ Items that should be monitored on a weekly basis

Action
1. Create an event which will monitor the items that should be monitored 

continuously by following these steps:

a. Enter the name of the new event, Continuous, in the General tab of the 
Create Event page. Choose Database as the Target Type. Add one or more 
targets where the monitoring should take place for the event.

b. Select the following event tests from the Available Tests column in the Tests 
tab of the Create Event page:

Fault:

Alert-- new errors in Alert file

Database UpDown-- database is down

Probe -- database connection cannot be made

Note: For step-by-step instructions on using the Oracle Enterprise 
Manager Console and Event Management System, please see the 
Oracle Enterprise Manager Administrator’s Guide. This guide also 
provides information on setting up job system and event 
requirements.
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User Blocks -- database user is blocking others

Performance - Instance Activity:

Buffer Cache Hit %-- buffer cache hit ratio is low

Free Buffer Waits -- free buffer waits is increasing

In Memory Sort % -- in memory sort ratio is low

Redo Log Allocation Hit % -- redo log allocation hit ratio is low

Rollback Contention -- rollback segment contention is high

Space:

Archive Full -- archive device is full

Archive Full (%) -- archive device is full shown as a percentage

c. In the Parameters tab of the Create Event page, accept the Critical and 
Warning threshold settings.

2. Create an event which will monitor the items that should be monitored on a 
daily basis by following these steps:

a. Enter the name of the new event, Daily, in the General tab of the Create 
Event page. Choose Database as the Target Type. Add one or more targets 
where the monitoring should take place for the event.

b. Select the following event tests from the Available Tests column in the Tests 
tab of the Create Event page:

Space:

Chunk Small-- contiguous space is insufficient

Dump Full -- dump destination device is full

Dump Full (%)-- dump destination device is full shown as a percentage

Fast Segment Growth-- segment growth rate is high

Maximum Extents -- segment’s maxextent limit approached

Tablespace Full -- tablespace is full

c. In the Parameters tab of the Create Event page, accept all default settings.

d. In the Schedule tab of the Create Event page, select the On Interval option 
and set the interval to be 24 hours. 
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3. Create an event which will monitor the items that should be monitored on a 
weekly basis by following these steps:

a. Enter the name of the new event, Weekly, in the General tab of the Create 
Event page. Choose Database as the Target Type. Add one or more targets 
where the monitoring should take place for the event.

b. Select the following event tests from the Available Tests column in the Tests 
tab of the Create Event page.

Resource:

Datafile Limit -- maximum datafile approached

Space:

Alert File Large -- alert file is large

Index Rebuild-- index which may benefit from a rebuild

c. In the Parameters tab of the Create Event page, accept all default settings.

d. In the Schedule tab of the Create Event page, select the On Day of Week 
option and set the date and time.

Resolution
The appropriate resolution depends on the specific event condition.  Each event 
description provides a possible user action to correct your condition.

In addition, the DBA can use other Oracle Enterprise Manager tools to further 
pinpoint database inefficiencies and tune performance. Please refer to the Oracle 
Enterprise Manager documentation library for more information on the individual 
tools.
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Space Management

Problem
The DBA has been warned that a new table will be created in the APP_DATA 
tablespace and during the night a batch load will take place. The DBA decides to 
monitor the free space in this tablespace. Should free space become a problem, he 
wants to be notified of the condition, but also wants a datafile automatically added 
to avoid having the batch load fail.

Action
1. Create an event that will monitor the total used space in the APP_DATA 

tablespace. The event will generate a warning or critical alert if the tablespace 
becomes too full. In addition, create a fixit job (AppDataAddFile) and associate 
it with the event. Then, if the tablespace becomes too full, the job will run and 
automatically correct the problem. The steps to create the event are:

a. Enter the name of the new event, AppDataFull, in the General tab of the 
Create Event page. Choose Database as the Target Type. Add one or more 
targets where the monitoring should take place for the event.

b. Select the following event test from the Available Tests column in the Tests 
tab of the Create Event page:

Table 7–3 Summary of Event Tests Used in Operational Management

Fault
Performance - Instance 
Activity Space Resource

Alert

Database UpDown

Probe

User Blocks

Buffer Cache Hit %

Free Buffer Waits

In Memory Sort %

Redo Log Allocation Hit % 

Rollback Contention

Alert File Large

Archive Full

Archive Full (%)

Chunk Small

Dump Full

Dump Full (%)

Fast Segment Growth

Index Rebuild

Maximum Extents

Tablespace Full

Datafile Limit
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Space:

Tablespace Full -- tablespace is full

2. In the Parameters tab of the Create Event page, accept the default Warning and 
Critical threshold settings. Also, specify the following filter for the Tablespace 
Name Filter: =’APP_DATA’

3. Create a fixit job (a job used to correct problems detected by an event) by 
accessing the Fixit Jobs tab on the Create Event page. Check the ’If ANY test 
triggers, run a fixit job’ option then click the Create button. This activates the 
Oracle Enterprise Manager Console Job System. Follow these steps to create the 
fixit job:

a. Enter the name of the new job, AppDataAddFile, in the General tab of the 
Create Job page. Choose Database as the Target Type. Select the database 
target where the event will be monitored.

b. Select Run SQL*Plus Script from the Available Tasks list in the Tasks tab of 
the Create Job page.

c. Enter the following Script Text in the Parameters tab of the Create Job page:

ALTER TABLESPACE APP_DATA
ADD DATAFILE
’c:\orant\database\app02.ora’ SIZE 5M;

4. Submit the fixit job. (You must resubmit the job for each datafile or the job will 
fail.)

Resolution
In this example using the Oracle Event Management System, the DBA was able to 
proactively monitor for the potential problem and automatically prevent any 
impact to end users. No further action would be required. 

Performance Tuning

Problem
The DBA knows a new SQL intensive application is being brought on-line. He 
worries that his shared pool might be sized too small to handle the new application. 
If the shared pool is too small, users will consume additional resources in order to 
complete a database operation. For library cache access, the overhead is primarily 



Performance Tuning

Using Advanced Event Tests Effectively A-7

the additional CPU resources required to reparse the SQL statement. For dictionary 
cache access, the overhead is primarily the additional I/O since the dictionary cache 
references that have been displaced from the cache will need to be refetched from 
disk. 

To prevent any performance degradation that would be noticed by users, he decides 
to proactively monitor the performance of the shared pool.

Action
Create an event through the Oracle Enterprise Manager Event Management System 
that will monitor the performance of the shared pool. Since the shared pool contains 
the library cache and the data dictionary cache, the efficiency of both of these caches 
should be monitored to determine whether or not the shared pool requires tuning. 
If either of these caches are performing poorly, the DBA wants to be notified. The 
steps to create the event set are:

1. Enter the name of the new event, SharedPool, in the General tab of the Create 
Event page. Choose Database as the Target Type. Add one or more targets 
where the monitoring should take place for the event.

2. Select the following event tests from the Available Tests column in the Tests tab 
of the Create Event page:

Performance - Instance Activity:

Library Cache Hit % -- monitors library cache efficiency as measured by the 
miss ratio. It records the percentage of times the fully parsed or compiled 
representation of PL/SQL blocks and SQL statements are not already in 
memory.

Data Dictionary Hit % -- monitors dictionary cache efficiency as measured by 
the miss ratio. It records the percentage of times the dictionary data was not 
already in memory.

3. Accept the default number of occurrences and threshold settings in the 
Parameters tab of the Create Event page for each of the selected events.

Resolution
If the library cache miss ratio or the data dictionary miss ratio is high then the DBA 
has several options:

■ Use Oracle Expert to tune the shared pool by creating a focused tuning session 
for the database. The tuning scope of the tuning session should focus on SGA 



Performance Tuning

A-8 Getting Started with the Oracle Diagnostics Pack

instance tuning. If the Library Cache Event test was triggered, the DBA may 
also want to include the SQL reuse tuning focus. Once Oracle Expert has 
automatically collected and analyzed the appropriate data, a set of 
recommendations for achieving the best performance is provided.

■ Consider increasing the SHARED_POOL_SIZE to:

– Decrease the frequency in which SQL requests are being flushed from the 
shared pool in order to make room for new request

– Decrease the frequency in which dictionary data is being flushed from the 
shared pool in order to make room for new data

■ To take advantage of the additional memory available for shared SQL areas, the 
number of cursors permitted for a session may need to be increased. This limit 
can be increased by increasing the value of the initialization parameter OPEN_
CURSORS.

■ If the library cache was found to be inefficient, examine SQL statements which 
can be modified to optimize shared SQL pool memory utilization and avoid 
unnecessary statement reparsing. This type of problem is commonly caused 
when similar SQL statements are written which differ in space, case or some 
combination of the two. Consider using bind variables rather than explicitly 
specified constants in your statements whenever possible.



Index-1

Index
A
Add New Service button, 4-3
Add New Target button, 3-4
Add New Target command, 3-10
adding

a data item to a user-defined class, 4-22
advanced events

setting up, 2-1
advice

diagnostic, 3-18
Agent

accessing through intermediate host, 3-3, 4-3
Agent data gathering service’s integration 

with, 3-2, 4-1
checking the log file, 4-25
checking the status of, 4-25
Oracle Data Gatherer’s integration with, 3-2, 4-1
setting the location of, 3-3, 4-3
troubleshooting, 4-25

Agent data gathering service
See Agent

analysis
adding data from other classes to, 4-43
copying, 4-40
creating from a data class, 4-38
generating a report for an, 4-51
identifying user-defined and predefined, 4-39
modifying the selection criteria for an 

existing, 4-44
printing, 4-50
saving predefined, 4-50
saving results of, 4-50
saving user-defined, 4-50

viewing and modifying an existing, 4-39
See also charts

Analysis window
overview of, 4-42
using the scroll bar, 4-46
zooming in, 4-46
zooming out, 4-46

analyzing
collected historical data, 4-35

annotation box
moving in an analysis chart, 4-49

auto-scaling
chart data, 4-47

Average Elapsed Time data view, 7-7

B
bar charts, 3-13
Basic Statistics for Parse/Execute/Fetch drill-down 

data view, 7-16

C
Capacity Planner

See Oracle Capacity Planner
Chart, 3-16
Chart Format button, 3-13
chart group

definition, 3-11
Chart Status button, 3-16, 3-30, 3-35

using, 3-17
charts

auto-scaling the data included in, 4-47
chart-specific commands, 3-16
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constraints, 3-14
displaying or hiding the chart legend, 4-45
drilling down, 3-16
excluding data points from, 4-45
filtering chart data, 3-15
formats of, 3-13
generating reports for, 3-23
getting help on, 3-22
hiding the chart legend, 4-45
orientations, 3-21
printing, 3-23
removing lines from, 4-44
saving your changes, 3-21
scaling the data in, 4-47
selecting a line in, 4-43
setting chart options, 3-14
sorting data in table, 3-21
viewing, 3-10
viewing the values of data points in, 4-42
See also analysis

class
contents of data tables in the historical 

database, 4-53
definition, 4-15
modifying selection criteria for including in an 

analysis, 4-44
names of data tables in the historical 

database, 4-52
specifying for historical data collection, 4-15
specifying selection criteria for including in an 

analysis, 4-38
understanding the data tables in the historical 

database, 4-52
class reference table

understanding, 4-52
collected data

analyzing, 4-35
browsing, 4-37
definition, 3-12

collection frequency
specifying for a target, 4-9

collection problems
troubleshooting, 4-25

connecting
manually to a target, 3-9

to a discovered target, 3-9
to a target, 3-10
to an historical database, 4-35

constraints
selecting chart, 3-14

copying
a user-defined class, 4-24
an analysis, 4-40
user-defined charts, 3-27

CPU Statistics data view, 7-8
CPU Statistics for Parse/Execute/Fetch drill-down 

data view, 7-16
creating

a copy of an analysis, 4-40
a user-defined class, 4-20
an analysis from a data class, 4-38
classes like existing user-defined classes, 4-24
like user-defined charts, 3-27
user-defined charts, 3-25

critical threshold, 3-30

D
data

analyzing collected, 4-35
browsing collected, 4-37
determining what is being collected, 4-17
organization of collected, 4-36
selecting collected, 3-12

data class
definition, 4-16
in Capacity Planner analysis view, 4-36
modifying selection criteria, 4-44
saving as an analysis, 4-38
specifying for historical data collection, 4-15
specifying selection criteria for, 4-38
viewing an analysis for, 4-37

data collection
See historical data collection

data item
adding to a user-defined class, 4-22
definition, 4-17
modifying in a user-defined class, 4-22
removing from a user-defined class, 4-22
selecting for collection, 4-17
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stopping collection for a, 4-18
Data Items page in user-defined charts, 3-26
data point

displaying a currently excluded point in a 
chart, 4-45

excluding from a chart, 4-45
viewing the value of a, 4-42

data samples
specifying the length of time between, 4-10
specifying the number to collect for a time 

interval, 4-10
data source

definition, 3-12, 4-17
designating for a user-defined class, 4-21
examples of, 4-17
selecting, 3-12
selecting for collection, 4-17
stopping collection for a, 4-18

Data View wizard
choosing an event, 7-19
choosing items, 7-20
choosing sort criteria, 7-22
creating data views using, 7-18
defining number of rows, 7-22

Data Viewer, 7-1
computing statistics, 7-4
starting, 7-2
usage scenarios, 7-2

data views
creating, 7-12
definition of, 7-2
definitions, 7-9
displaying, 7-5
drill down to related events, 7-13
drill-down

selecting, 7-16
modifying, 7-12

descriptions, 7-13
options, 7-13
sort order, 7-13

options, 7-10
saving, 7-18
See also drill-down data views, 7-1
SQL statement, 7-11
statistics, 7-10, 7-12

viewing data, 7-10
data views in Oracle Trace

Average Elapsed Time, 7-7
CPU Statistics, 7-8
Disk Reads, 7-6
Disk Reads/Execution Ratio, 7-7
Disk Reads/Logical Reads Ratio, 7-7
Disk Reads/Rows Fetched Ratio, 7-6
Execute Elapsed Time, 7-8
Fetch Elapsed Time, 7-8
Logical Reads, 7-6
Logical Reads/Rows Fetched Ratio, 7-6
Number of Rows Processed, 7-8
Parse Elapsed Time, 7-8
Parse/Execution Ratio, 7-7
Re-Parse Frequency, 7-7
Rows Fetched/Fetch Count Ratio, 7-9
Rows Sorted, 7-9
Sorts in Memory, 7-9
Sorts on Disk, 7-9
Total Elapsed Time, 7-8
Waits by Average Wait Time, 7-9
Waits by Event Frequency, 7-9
Waits by Total Wait Time, 7-9

deleting
a data item from a user-defined class, 4-22
lines from a chart, 4-44
recordings, 3-25
user-defined analysis, 4-41
user-defined classes, 4-25

designating a data source for a user-defined 
class, 4-21

disconnecting
from historical database, 4-36

Disk Reads data view, 7-6
Disk Reads/Execution Ratio data view, 7-7
Disk Reads/Logical Reads Ratio data view, 7-7
Disk Reads/Rows Fetched Ratio data view, 7-6
displaying

a chart legend, 4-45
existing user-defined analyses, 4-39
predefined analyses, 4-40

Documentation Accessibility, xix
drill-down

of data views, 7-13
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drill-down charts, 3-16
drilling down to historical data, 3-19

drill-down data views
descriptions, 7-14
modifying, 7-17
selecting, 7-16
SQL statement, 7-15
statistics, 7-15

drill-down data views in Oracle Trace
Basic Statistics for Parse/Execute/Fetch, 7-16
CPU Statistics for Parse/Execute/Fetch, 7-16
I/O Statistics for Parse/Execute/Fetch, 7-16
Parse Statistics, 7-16
Row Statistics for Execute/Fetch, 7-16

E
Enterprise mode

running Performance Manager in, 3-6
EPC_ERROR.LOG file, 7-29
event permissions, 3-33
events

in Performance Manager, 3-29
multiple targets, 3-32
registering in Performance Manager, 3-33

excluding a data point from a chart, 4-45
Execute Elapsed Time data view, 7-8

F
Fetch Elapsed Time data view, 7-8
filtering chart data, 3-15

G
green dot on class icon in navigator panel

meaning of, 4-18

H
help

accessing for Oracle Capacity Planner, 4-5
for charts, 3-22
Help menu in Oracle TopSessions, 6-8

hiding

a chart legend, 4-45
the list of predefined analyses, 4-40

hierarchical charts, 3-13
historical data collection

aggregation of data in, 4-12
setting up a, 4-6
specifying a target for, 4-7
specifying the age of the data saved for 

analysis, 4-14
specifying the classes of data to collect, 4-15
stopping for a class of data, 4-18

historical database
connecting to, 4-35
contents of data tables for classes in, 4-53
disconnecting from, 4-36
names of data tables for a class, 4-52
specifying the location of a, 4-11
understanding the class reference table, 4-52
understanding the data tables for a class in, 4-52
understanding the logical structure of, 4-51
understanding the service reference table, 4-51
unsupported modifications to, 4-51

horizontal orientation
of a chart, 3-21

I
Intelligent Agent

See Agent
I/O Statistics for Parse/Execute/Fetch drill-down 

data view, 7-16

K
Kill menu item

in Performance Manager, 3-16

L
line charts, 3-13
load frequency

specifying for a target, 4-11
load problems

troubleshooting, 4-25
loader passes
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selecting the length of time between, 4-11
selecting the number for a time interval, 4-11

log file for Agent, 4-25
Logical Reads data view, 7-6
Logical Reads/Rows Fetched Ratio data view, 7-6

M
main window

of Oracle Performance Manager, 3-7
menu bar

of Oracle TopSessions, 6-5
menus

Help menu
of Oracle TopSessions, 6-8

Microsoft SQL Server, 1-9
modifying

a data item in a user-defined class, 4-22
existing analysis, 4-39
selection criteria for a class of data in an analysis 

chart, 4-44
user-defined classes, 4-23

modifying user-defined charts, 3-26
monitoring SQL Server, 1-9
moving

annotation box in an analysis chart, 4-49

N
Number of Rows Processed data view, 7-8

O
occurrences, 3-32
OEM

See Oracle Enterprise Manager (OEM)
Options dialog box, 6-15
Oracle Capacity Planner

drilling down to, 3-19
functions of, 4-1
how it collects and stores data, 4-2
setting up, 2-2
starting, 4-4
two-step process for using, 4-6
usage scenarios for, 4-4

Oracle Data Gatherer
See Agent

Oracle Performance Manager
functions of, 3-1
setting up, 2-2
starting, 3-5
usage scenarios for, 3-4

Oracle TopSessions
displaying, 6-3

Oracle Trace
data views

Average Elapsed Time, 7-7
CPU Statistics, 7-8
Disk Reads, 7-6
Disk Reads/Execution Ratio, 7-7
Disk Reads/Logical Reads Ratio, 7-7
Disk Reads/Rows Fetched Ratio, 7-6
Execute Elapsed Time, 7-8
Fetch Elapsed Time, 7-8
Logical Reads, 7-6
Logical Reads/Rows Fetched Ratio, 7-6
Number of Rows Processed, 7-8
Parse Elapsed Time, 7-8
Parse/Execution Ratio, 7-7
Re-Parse Frequency, 7-7
Rows Fetched/Fetch Count Ratio, 7-9
Rows Sorted, 7-9
Sorts in Memory, 7-9
Sorts on Disk, 7-9
Total Elapsed Time, 7-8
Waits by Average Wait Time, 7-9
Waits by Event Frequency, 7-9
Waits by Total Wait Time, 7-9

drill-down data views
Basic Statistics for 

Parse/Execute/Fetch, 7-16
CPU Statistics for Parse/Execute/Fetch, 7-16
I/O Statistics for Parse/Execute/Fetch, 7-16
Parse Statistics, 7-16
Row Statistics for Execute/Fetch, 7-16

Oracle Trace Data Viewer
See Data Viewer, 7-1

overview charts
viewing, 3-11
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P
Parse Elapsed Time data view, 7-8
Parse Statistics drill-down data view, 7-16
Parse/Execution Ratio data view, 7-7
Performance Manager

See Oracle Performance Manager
performance statistics

projecting, 4-47
pie chart, 3-13
predefined analyses

definition, 4-36
displaying or hiding the list of, 4-40
identifying icon, 4-39

printing
a chart, 3-23
an analysis, 4-50

problems
troubleshooting, 4-25

property sheets
Options property sheet, 6-15

purging
determining how much historical data to keep 

before, 4-14

R
recording chart data, 3-23
recordings

removing, 3-25
starting, 3-24
stopping, 3-24

Recordings folder, 3-8
removing

a data item from a user-defined class, 4-22
a line from a chart, 4-44

renaming
a data item in a user-defined class, 4-22
a user-defined analysis, 4-41
a user-defined class, 4-23

Re-Parse Frequency data view, 7-7
report

generating for an analysis report, 4-51
reports

generating for charts, 3-23

right mouse button
using in Oracle TopSessions, 6-13

Row Statistics for Execute/Fetch drill-down data 
views, 7-16

Rows Fetched/Fetch Count Ratio data view, 7-9
Rows Sorted data view, 7-9

S
saving

analysis results, 4-50
class data as a user-defined analysis, 4-38
Performance Manager charts, 3-21

scrolling
in the Analysis window, 4-46

selection criteria
modifying for class data in an analysis, 4-44

service reference table
understanding, 4-51

Session Details display
Statistics page, 6-15

sessions
viewing details about, 6-13

Set Connection Details menu item, 3-4, 4-3
Set Options button, 3-16
setting up

Advanced Events, 2-1
Capacity Planner, 2-2
Performance Manager, 2-2
Trace, 2-6

shortcut keys, 3-28
Show Overview Charts

menu option, 3-11
toolbar button, 3-11

sorting
data in a table chart, 3-21

sorting TopSessions entries, 6-13
Sorts in Memory data view, 7-9
Sorts on Disk data view, 7-9
SQL script

evaluating in a user-defined chart, 3-26
SQL statements

in data views, 7-11
of drill-down data views, 7-15

SQL support, 1-9
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Standalone mode
running Performance Manager in, 3-7
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Oracle Capacity Planner, 4-4
Oracle Performance Manager, 3-5

starting Data Viewer, 7-2
from Oracle Enterprise Manager Program 

Group, 7-3
from within Oracle Trace, 7-3

statistics
computing using Data Viewer, 7-4
of data views, 7-10, 7-12
of drill-down data views, 7-15
selecting the statistics to display for a 

session, 6-15
stopping

collection of data for a data source or data 
item, 4-18

strip charts, 3-13

T
table charts, 3-13

sorting data in, 3-21
target

connecting manually, 3-9
connecting to discovered, 3-9
selecting for historical data collection, 4-7
specifying the classes of data to collect 

from, 4-15
specifying the collection frequency for, 4-9
specifying the load frequency for, 4-11

threshold associations
editing, 3-19, 3-37

threshold state indicators, 3-4
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critical, 3-17
editing, 3-31
order of precedence, 3-31
refreshing, 3-37
resetting, 3-19, 3-36
setting, 3-31
triggered events, 3-32
types, 3-30
viewing, 3-34

warning, 3-17
TopSessions

accessing from Console, 6-2
accessing from console, 6-3
customizing display, 6-15
Data Options page, 6-16
filtering, 6-4
filtering criteria, 6-10
menus, 6-5
Options page, 6-18
overview, 6-1
session details page, 6-14
Session Filtering Page, 6-17
sort statistics, 6-10
sorting entries, 6-13
statistics page, 6-15
toolbar, 6-8
viewing session details, 6-13

Total Elapsed Time data view, 7-8
Trace

setting up, 2-6
trend analysis

definition, 4-47
specifying and performing, 4-48
to a point in time, 4-47
to a value, 4-47

troubleshooting
collection and load problems, 4-25

U
usage scenarios

for Data Viewer, 7-2
for Oracle Capacity Planner, 4-4
for Oracle Performance Manager, 3-4

user-defined analysis
creating, 4-38
definition, 4-36
deleting, 4-41
identifying icon, 4-39
renaming, 4-41

user-defined charts, 3-25
copying, 3-27
creating like, 3-27
Data Items page, 3-26
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defining a new chart, 3-26
modifying, 3-26
restriction when drilling down, 3-20

user-defined class
adding a data item to, 4-22
copying, 4-24
creating, 4-20
creating another class like, 4-24
deleting, 4-25
designating a data source for, 4-21
modifying, 4-23
modifying a data item in, 4-22
removing a data item from, 4-22
specifying the SQL statement to create, 4-20
starting collection for, 4-21
stopping collection for, 4-25

using Oracle Capacity Planner help, 4-5

V
vertical orientation

of a chart, 3-21
viewing

an analysis of a data class, 4-37
an existing analysis, 4-39
chart data by zooming and scrolling, 4-46
overview charts, 3-11
Performance Manager charts, 3-10
the selection criteria for a class of data in an 

analysis, 4-44

W
Waits by Average Wait Time data view, 7-9
Waits by Event Frequency data view, 7-9
Waits by Total Wait Time data view, 7-9
warning threshold, 3-30
wizard

See Collection Wizard
See Data View wizard, 7-18

Z
zoom buttons

on Analysis window toolbar, 4-46
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